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About this manual 
 

This manual describes the System 300S SPEED7 CPU 315-4PN33 from 
VIPA. Here you may find every information for commissioning and 
operation. 
 
Chapter 1: Principles 
This Basics contain hints for the usage and information about the project 
engineering of a SPEED7 system from VIPA.  
General information about the System 300S like dimensions and 
environment conditions will also be found. 
 
Chapter 2: Assembly and installation guidelines 
In this chapter you will find all information, required for the installation and 
the cabling of a process control with the components of the System 300S 
with a CPU 315-4PN33. 
 
Chapter 3: Hardware description 
Here the hardware components of the CPU 315-4PN33 are described. 
The technical data are at the end of the chapter. 
 
Chapter 4: Deployment CPU 315-4PN33 
This chapter describes the employment of a CPU 315-4PN33 with SPEED7 
technology in the System 300S. The description refers directly to the CPU 
and to the employment in connection with peripheral modules that are 
mounted on a profile rail together with the CPU at the standard bus. 
 
Chapter 5: Deployment PtP communication 
Content of this chapter is the employment of the RS485 slot for serial PtP 
communication. Here you’ll find all information about the protocols, the 
activation and project engineering of the interface which are necessary for 
the serial communication using the RS485 interface. 
 
Chapter 6: Deployment Ethernet communication 
In this chapter the deployment of the PROFINET IO controller as Ethernet 
CP for productive connections is described.  
Please regard the chapter "Fast introduction" where you will find every 
information compressed required for the project engineering of the 
PROFINET IO controller as Ethernet CP. After the fast introduction, the 
mentioned steps are described in detail. 

Outline 
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Chapter 7: Deployment Ethernet Communication - PROFINET 
Here the deployment of the PROFINET IO controller with PROFIBUS is 
described. 
Please regard the chapter "Fast introduction" where you will find every 
information compressed required for the project engineering of the 
PROFINET IO controller for PROFINET. After the fast introduction, the 
mentioned steps are described in detail. 
 
Chapter 8: Configuration with TIA Portal 
In this chapter the project engineering of the VIPA CPU in the Siemens TIA 
Portal is shown. The chapter only describes the basic usage of the 
Siemens TIA Portal together with a VIPA CPU . 
More detailed information about the Siemens TIA Portal is to be found in 
the according online manual respectively documentation. 
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This manual describes the System 300S SPEED7 CPU 315-4PN33 from 
VIPA. It contains a description of the construction, project implementation 
and usage. 
This manual is part of the documentation package with order number  
HB140E_CPU and relevant for:  
 

Product Order number as of state: 
  CPU-HW CPU-FW PN-IO controller-FW 
CPU 315SN/PN ECO VIPA 315-4PN33 01 V3596 V107 

 
The manual is targeted at users who have a background in automation 
technology. 
 

The manual consists of chapters. Every chapter provides a self-contained 
description of a specific topic. 
 

The following guides are available in the manual: 
• an overall table of contents at the beginning of the manual 
• an overview of the topics for every chapter 
 

The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 

Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 

 

Objective and 
contents 

Target audience 

Structure of the 
manual 

Guide to the 
document 

Availability 

Icons 
Headings 
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Safety information 
 

The SPEED7 CPU is constructed and produced for: 
• all VIPA System 300S components 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Hardware modifications to the process control system should only be 

carried out when the system has been disconnected from power! 
 
• Installation and hardware modifications only by properly trained 

personnel. 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 
 
 
 
 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1  Basics 
 

These basics contain hints for the usage and information about the project 
engineering of a SPEED7 system from VIPA.  
General information about the System 300S like dimensions and 
environment conditions will also be found. 
 

 

Topic     Page 
Chapter 1 Basics .............................................................................. 1-1 

Safety Information for Users................................................................. 1-2 
Operating structure of a CPU ............................................................... 1-3 
CPU 315-4PN33................................................................................... 1-6 

 
 
 
 
 

Overview 
 

Content 
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Safety Information for Users 
 

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges. 
 

 
 
The Symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable. 
Modules that have been damaged by electrostatic discharges can fail after 
a temperature change, mechanical shock or changes in the electrical load. 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Modules must be shipped in the original packing material. 
 

 
When you are conducting measurements on electrostatic sensitive modules 
you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 

Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 

Handling of 
electrostatic 
sensitive modules 

Shipping of 
electrostatic 
sensitive modules 

Measurements and 
alterations on 
electrostatic 
sensitive modules 

 



Manual VIPA System 300S SPEED7 Chapter 1   Basics 

HB140E - CPU - RE_315-4PN12 - Rev. 13/17  1-3 

Operating structure of a CPU 
 

The CPU contains a standard processor with internal program memory. In 
combination with the integrated SPEED7 technology the unit provides a 
powerful solution for process automation applications within the System 
300S family.  
A CPU supports the following modes of operation:  
 
• cyclic operation 
• timer processing 
• alarm controlled operation 
• priority based processing 
 

Cyclic processing represents the major portion of all the processes that are 
executed in the CPU. Identical sequences of operations are repeated in a 
never-ending cycle. 
 

Where a process requires control signals at constant intervals you can 
initiate certain operations based upon a timer, e.g. not critical monitoring 
functions at one-second intervals. 
 

If a process signal requires a quick response you would allocate this signal 
to an alarm controlled procedure. An alarm can activate a procedure in 
your program. 
 

The above processes are handled by the CPU in accordance with their 
priority. Since a timer or an alarm event requires a quick reaction, the CPU 
will interrupt the cyclic processing when these high-priority events occur to 
react to the event. Cyclic processing will resume, once the reaction has 
been processed. This means that cyclic processing has the lowest priority. 
 

General 

Cyclic processing 

Timer processing 

Alarm controlled 
processing 

Priority based 
processing 
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The program that is present in every CPU is divided as follows: 
• System routine 
• User application 
 

The system routine organizes all those functions and procedures of the 
CPU that are not related to a specific control application. 
 

This consists of all the functions that are required for the processing of a 
specific control application. The operating modules provide the interfaces to 
the system routines. 
 

The following series of operands is available for programming the CPU: 
• Process image and periphery 
• Bit memory 
• Timers and counters 
• Data blocks 
 

The user application can quickly access the process image of the inputs 
and outputs PAA/PAE. You may manipulate the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double words 
 
You may also gain direct access to peripheral modules via the bus from 
user application. The following types of data are available: 
• Bytes 
• Words 
• Blocks 

Applications  

System routine 

User application 

Operands  

Process image 
and periphery 
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The bit memory is an area of memory that is accessible by means of 
certain operations. Bit memory is intended to store frequently used working 
data. 
You may access the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double words 
 

In your program you may load cells of the timer with a value between 10ms 
and 9990s. As soon as the user application executes a start-operation, the 
value of this timer is decremented by the interval that you have specified 
until it reaches zero. 
You may load counter cells with an initial value (max. 999) and increment 
or decrement these when required. 
 

A data block contains constants or variables in the form of bytes, words or 
double words. You may always access the current data block by means of 
operands.  
You may access the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double words 
  
 
 

Bit Memory  

Timers and 
counters 

Data Blocks 
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CPU 315-4PN33 
 

The CPU 315-4PN33 bases upon the SPEED7 technology. This supports 
the CPU at programming and communication by means of co-processors 
that causes a power improvement for highest needs.  
The CPU is programmed in STEP 7 from Siemens. For this you may use  
the SIMATIC manager or TIA Portal from Siemens. 
Here the instruction set of the S7-400 from Siemens is used. 
Modules and CPUs of the System 300S from VIPA and Siemens may be 
used at the bus as a mixed configuration. 
The user application is stored in the battery buffered RAM or on an 
additionally pluggable MMC storage module. 
The CPU is configured as CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 
V2.6) from Siemens.  
There is the possibility in the Siemens SIMATIC manager to create a 
project for the PROFIBUS part of the CPU 315-2EH13-0AB0. However this 
is rejected by the VIPA CPU during the project transfer.  
 
 
 

PC

CPU

MMC

MMC

RN
ST
MR

Tip
3Sec.

MPI Adapter

wld file

System data

PG/OP

Power ON

TP

firmware

RAM

Ethernet

MPI

Proj./Firmw.

RS232

RAM Flash
Firmw.Proj.

Web-Browser

Programing tool

RJ45

Web

TP

RAM Flash
Firmw.Proj.

Web

PN-IO

NCS

overall reset

 
 
Note! 
Please always use the CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6) 
from Siemens of the hardware catalog to project this CPU from VIPA. For 
the project engineering, a thorough knowledge of the Siemens SIMATIC 
Manager and the hardware configurator from Siemens is required! 

Overview 

Access  
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The CPU has an integrated memory. Information about the capacity  
(min. capacity ... max capacity) of the memory may be found at the front of 
the CPU. 
The memory is divided into the following 3 parts:  
• Load memory 512 kbyte 
• Code memory (50% of the work memory) 
• Data memory (50% of the work memory) 
The work memory has 256 kbyte. You have not the possibility to extend the 
work memory by means of a MCC memory extension card. 
 
The CPU has an integrated PROFINET IO controller, which is to be 
configured by the PROFINET sub module in the Siemens hardware 
configurator. 
 
The CPU has an Ethernet interface for PG/OP communication. Via the 
"PLC" functions you may directly access the Ethernet PG/OP channel and 
program res. remote control your CPU. A max. of 4 PG/OP connections is 
available.  
You may also access the CPU with a visualization software via these 
connections. 
 
• Wiring by means of spring pressure connections (CageClamps) at the 

front connector 
• Core cross-section 0.08...2.5mm2 
• Total isolation of the wiring at module change 
• Potential separation of all modules to the backplane bus 
• ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)    
• Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G) 
 
• Operating temperature: 0 ... +60°C 
• Storage temperature: -25 ... +70°C 
• Relative humidity: 5 ... 95% without condensation 
• Ventilation by means of a fan is not required 
 
• Dimensions of the basic enclosure:  

2tier width: (WxHxD) in mm: 80x125x120  
 
The CPU comes with an integrated power supply. The power supply is to 
be supplied with DC 24V. By means of the supply voltage, the internal 
electronic is supplied as well as the connected modules via backplane bus. 
The power supply is protected against inverse polarity and overcurrent. 
 

Memory 
management 

Integrated 
PROFINET IO 
controller 

Integrated 
Ethernet PG/OP 
channel 

Operation Security 

Environmental 
conditions 

Dimensions/ 
Weight 

Integrated  
power supply 
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Chapter 2  Assembly and installation guidelines 
 

In this chapter you will find every information, required for the installation 
and the cabling of a process control with the components of the System 
300S with a CPU 315-4PN33. 
 

 

Topic     Page 
Chapter 2 Assembly and installation guidelines............................ 2-1 

Installation dimensions ......................................................................... 2-2 
Assembly standard bus ........................................................................ 2-3 
Cabling................................................................................................. 2-5 
Installation guidelines ........................................................................... 2-6 

 

 

 

Overview 

Content 
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Installation dimensions 
 

2tier width (WxHxD) in mm: 80 x 125 x 120 
 
 

 6
5m

m
 4

0m
m

 1
22

m
m

  
 

12
5 

m
m

125mm

120mm

175mm  

Dimensions  
Basic enclosure 

Dimensions 

Installation 
dimensions 
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Assembly standard bus 
 

The single modules are directly installed on a profile rail and connected via 
the backplane bus connector. Before installing the modules you have to 
clip the backplane bus connector to the module from the backside. 
The backplane bus connector is delivered together with the peripheral 
modules. 
 

 Order number A B C 
VIPA 390-1AB60 160 140 10 
VIPA 390-1AE80 482 466 8.3 
VIPA 390-1AF30 530 500 15 
VIPA 390-1AJ30 830 800 15 

VIPA 390-9BC00* 2000 Drillings only left 15 
* Unit pack: 10 pieces 

Measures in mm 
 

A

B

10

7

57.2

32.5

M6

15

122

C  
 

For the communication between the modules the System 300S uses a 
backplane bus connector. Backplane bus connectors are included in the 
delivering of the peripheral modules and are clipped at the module from the 
backside before installing it to the profile rail. 

                            
 

General 

Profile rail 

Bus connector 
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SLOT1
DCDC

SLOT2

horizontal assembly

lying assembly

vertical
assembly

 

Please regard the allowed environment temperatures: 

• horizontal assembly: from 0 to 60°C 
• vertical assembly: from 0 to 40°C 
• lying assembly: from 0 to 40°C 

 

Approach 
• Bolt the profile rail with the background (screw size: M6), 

so that you still have minimum 65mm space above and 
40mm below the profile rail. 

• If the background is a grounded metal or device plate, 
please look for a low-impedance connection between 
profile rail and background. 

• Connect the profile rail with the protected earth conductor. 
For this purpose there is a bolt with M6-thread. 

• The minimum cross-section of the cable to the protected 
earth conductor has to be 10mm2. 

 

• Stick the power supply to the profile rail and pull it to the 
left side to the grounding bolt of the profile rail. 

• Fix the power supply by screwing. 
• Take a backplane bus connector and click it at the CPU 

from the backside like shown in the picture. 
• Stick the CPU to the profile rail right from the power supply 

and pull it to the power supply. 

 

• Click the CPU downwards and bolt it like shown. 
• Repeat this procedure with the peripheral modules, by 

clicking a backplane bus connector, stick the module right 
from the modules you've already fixed, click it downwards 
and connect it with the backplane bus connector of the last 
module and bolt it. 

 
Danger! 
• The power supplies must be released before installation and repair 

tasks, i.e. before handling with the power supply or with the cabling you 
must disconnect current/voltage (pull plug, at fixed connection switch off 
the concerning fuse)! 

• Installation and modifications only by properly trained personnel! 
 

Assembly 
possibilities 
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Cabling 
 

Danger! 
• The power supplies must be released before installation and repair 

tasks, i.e. before handling with the power supply or with the cabling you 
must disconnect current/voltage (pull plug, at fixed connection switch off 
the concerning fuse)! 

• Installation and modifications only by properly trained personnel! 
 

For the cabling of power supply of a CPU, a green plug with CageClamp 
technology is deployed.  
The connection clamp is realized as plug that may be clipped off carefully if 
it is still cabled. 
 
Here wires with a cross-section of 0.08mm2 to 2.5mm2 may be connected. 
You can use flexible wires without end case as well as stiff wires. 
 

1
2
3 

[1]  Test point for 2mm test tip 
[2]  Locking (orange) for screwdriver 
[3]  Round opening for wires 

1

2

3

 

 
The picture on the left side shows the cabling step by step from top view. 
 
• For cabling you push the locking vertical to the inside with a suiting 

screwdriver and hold the screwdriver in this position. 
• Insert the de-isolated wire into the round opening. You may use wires 

with a cross-section from 0.08mm2 to 2.5mm2. 
• By removing the screwdriver the wire is connected safely with the plug 

connector via a spring. 
 

 
 

 

CageClamp 
technology (green) 
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Installation guidelines 
 

The installation guidelines contain information about the interference free 
deployment of System 300S systems. There is the description of the ways, 
interference may occur in your control, how you can make sure the 
electromagnetic digestibility (EMC), and how you manage the isolation. 
 

Electromagnetic digestibility (EMC) means the ability of an electrical 
device, to function error free in an electromagnetic environment without 
being interferenced res. without interferencing the environment. 
All System 300S components are developed for the deployment in hard 
industrial environments and fulfill high demands on the EMC. Nevertheless 
you should project an EMC planning before installing the components and 
take conceivable interference causes into account. 
 

Electromagnetic interferences may interfere your control via different ways: 
• Fields 
• I/O signal conductors 
• Bus system 
• Current supply 
• Protected earth conductor 
 
Depending on the spreading medium (lead bound or lead free) and the 
distance to the interference cause, interferences to your control occur by 
means of different coupling mechanisms. 
One differs: 
• galvanic coupling 
• capacitive coupling 
• inductive coupling 
• radiant coupling 

 
 

General 

What means 
EMC? 

Possible 
interference 
causes 
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In the most times it is enough to take care of some elementary rules to 
guarantee the EMC. Please regard the following basic rules when installing 
your PLC. 
• Take care of a correct area-wide grounding of the inactive metal parts 

when installing your components. 
- Install a central connection between the ground and the protected 

earth conductor system. 
- Connect all inactive metal extensive and impedance-low. 
- Please try not to use aluminum parts. Aluminum is easily oxidizing 

and is therefore less suitable for grounding. 
• When cabling, take care of the correct line routing. 

- Organize your cabling in line groups (high voltage, current supply, 
signal and data lines). 

- Always lay your high voltage lines and signal res. data lines in 
separate channels or bundles. 

- Route the signal and data lines as near as possible beside ground 
areas (e.g. suspension bars, metal rails, tin cabinet). 

• Proof the correct fixing of the lead isolation. 
- Data lines must be laid isolated. 
- Analog lines must be laid isolated. When transmitting signals with 

small amplitudes the one sided laying of the isolation may be 
favorable. 

- Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with 
cable clamps. 

- Make sure that the isolation/protected earth conductor rail is 
connected impedance-low with the cabinet. 

- Use metallic or metalized plug cases for isolated data lines. 
• In special use cases you should appoint special EMC actions. 

- Wire all inductivities with erase links. 
- Please consider luminescent lamps can influence signal lines. 

• Create a homogeneous reference potential and ground all electrical 
operating supplies when possible. 
- Please take care for the targeted employment of the grounding 

actions. The grounding of the PLC is a protection and functionality 
activity. 

- Connect installation parts and cabinets with the System 300S in star 
topology with the isolation/protected earth conductor system. So you 
avoid ground loops. 

- If potential differences between installation parts and cabinets occur, 
lay sufficiently dimensioned potential compensation lines. 

Basic rules for 
EMC 
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Electrical, magnetically and electromagnetic interference fields are 
weakened by means of an isolation, one talks of absorption. 
Via the isolation rail, that is connected conductive with the rack, 
interference currents are shunt via cable isolation to the ground. Hereby 
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may 
appear as interference cause. 
 
When isolating cables you have to regard the following: 
• If possible, use only cables with isolation tangle. 
• The hiding power of the isolation should be higher than 80%. 
• Normally you should always lay the isolation of cables on both sides. 

Only by means of the both-sided connection of the isolation you achieve 
high quality interference suppression in the higher frequency area. 
Only as exception you may also lay the isolation one-sided. Then you 
only achieve the absorption of the lower frequencies. A one-sided 
isolation connection may be convenient, if: 
- the conduction of a potential compensating line is not possible 
- analog signals (some mV res. µA) are transferred 
- foil isolations (static isolations) are used. 

• With data lines always use metallic or metalized plugs for serial 
couplings. Fix the isolation of the data line at the plug rack. Do not lay 
the isolation on the PIN 1 of the plug bar! 

• At stationary operation it is convenient to strip the insulated cable 
interruption free and lay it on the isolation/protected earth conductor line. 

• To fix the isolation tangles use cable clamps out of metal. The clamps 
must clasp the isolation extensively and have well contact. 

• Lay the isolation on an isolation rail directly after the entry of the cable in 
the cabinet. Lead the isolation further on to the System 300S module 
and don't lay it on there again! 

 

Please regard at installation! 
At potential differences between the grounding points, there may be a 
compensation current via the isolation connected at both sides. 
Remedy: Potential compensation line 
 
 
 

Isolation of 
conductors 
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Chapter 3  Hardware description 
 

Here the hardware components of the CPU 315-4PN33 are described. 
The technical data are at the end of the chapter. 
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Chapter 3 Hardware description...................................................... 3-1 

Properties............................................................................................. 3-2 
Structure .............................................................................................. 3-3 
Technical Data ..................................................................................... 3-8 
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Properties 
 

• SPEED7 technology integrated 
• 256kByte work memory integrated (128kbyte code, 128kbyte data) 
• 512kByte load memory  
• PROFINET IO controller with integrated Ethernet CP 
• PROFINET in accordance with conformance class A 
• RS485 interface configurable for PtP communication 
• Ethernet PG/OP interface  
• MPI interface 
• MCC slot for external memory cards (lockable) 
• Status LEDs for operating state and diagnosis 
• Real-time clock battery buffered 
• I/O address range digital/analog 2048byte 
• 512 timer 
• 512 counter 
• 8192 flag byte 
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S
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Type Order number Description 
315SN/PN 
ECO 

VIPA 315-4PN33 MPI interface, card slot, real time clock, Ethernet interface for 
PG/OP, PROFINET IO controller 

 

 

CPU 315SN/PN 
315-4PN33 

Ordering data 
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Structure 
 

 
 

[1] Storage media slot (lockable) 
[2] LEDs of the CPU part 
[3] LEDs of the  

PROFINET IO controllers 
[4] Operating mode switch CPU 
  
The following components 
are under the front flap 
  
[5] Twisted pair interface 

for Ethernet PG/OP channel 
[6] Slot for DC 24V power supply 
[7] MPI interface 
[8] PtP interface 
[9] Twisted pair interface for 

PROFINET IO controller 
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The CPU has an integrated power supply. The power supply has to be 
provided with DC 24V. For this serves the double DC 24V slot, that is 
underneath the flap. 
Via the power supply not only the internal electronic is provided with 
voltage, but by means of the backplane bus also the connected modules. 
The power supply is protected against polarity inversion and overcurrent. 
The internal electronic is galvanically connected with the supply voltage. 
 

 

9pin SubD jack: 
The MPI interface serves for the connection between programming unit and 
CPU. By means of this the project engineering and programming happens. 
In addition MPI serves for communication between several CPUs or 
between HMIs and CPU. 
Standard setting is MPI Address 2. 
 

 

8pin RJ45 jack: 
The RJ45 jack serves the interface to the Ethernet PG/OP channel. This 
interface allows you to program res. remote control your CPU, to access 
the internal website or to connect a visualization. Configurable connections 
are not possible.  
For online access to the CPU via Ethernet PG/OP channel valid IP address 
parameters have to be assigned to this. More may be found at chapter 
"Deployment CPU ..." at "Initialization Ethernet PG/OP channel". 
 

 

The CPU has an RS485 interface for serial point-to-point connection. 
 

Using the PtP functionality the RS485 interface is allowed to connect via 
serial point-to-point connection to different source res. target systems. Here 
the following protocols are supported: ASCII, STX/ETX, 3964R, USS and 
Modbus-Master (ASCII, RTU) . 
The activation of the PtP functionality happens by embedding the 
SPEEDBUS.GSD from VIPA in the hardware catalog. After the installation 
the CPU may be configured in a PROFIBUS master system and here the 
interface may be switched to PtP communication. 
 

Power supply 
X1 

MPI interface 
X2 

Ethernet PG/OP 
channel 
X5 

PtP interface  
X3 

PtP functionality 
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8pin RJ45 jack: 
The PROFINET IO controller serves the following possibilities for 
connections: 
• PROFINET IO controller to connect PROFINET IO devices 
• Ethernet PG/OP channel 
• Ethernet Siemens S7 connections 
• Ethernet open communication 
 

 

The CPU has an integrated memory. Information about the capacity of the 
memory may be found at the front of the CPU. 
The memory is divided into the following 3 parts:  
• Load memory 512kbyte 
• Code memory (50% of the work memory) 
• Data memory (50% of the work memory) 
• Work memory 256kbyte 
 

 

As external storage medium for applications and firmware you may use a 
MMC storage module (Multimedia card).  
The MCC can additionally be used as an external storage medium. 
Both VIPA storage media are pre-formatted with the PC format FAT16 and 
can be accessed via a card reader. An access to the storage media always 
happens after an overall reset and PowerON. 
After PowerON respectively an overall reset the CPU checks, if there is a 
storage medium with data valid for the CPU. 
Push the memory card into the slot until it snaps in leaded by a spring 
mechanism. This ensures contacting. By sliding down the sliding 
mechanism, a just  installed memory card can be protected against drop 
out. 

MCC MCC
 

To remove, slide the sliding mechanism up again and push the storage 
media against the spring pressure until it is unlocked with a click. 
 

Note! 
Caution, if the media was already unlocked by the spring mechanism, with 
shifting the sliding mechanism, a just installed memory card can jump out of 
the slot! 
 

 

PROFINET IO 
controller 
X8 

Memory 
management 

Storage  
media slot 
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The CPU has got LEDs on its front side. In the following the usage and the 
according colors of the LEDs is described. 
 
As soon as the CPU is supplied with 5V, the green PW-LED (Power) is on. 
 

RN 
(RUN) 
green 

ST 
(STOP) 
yellow 

SF 
(SYSFAIL) 

red 

FC 
(FRCE) 
yellow 

MC 
(MCC)
yellow 

Meaning 

Boot-up after PowerON 

● ☼* ● ● ● * Blinking with 10Hz: Firmware is loaded. 

● ● ● ● ● Initialization: Phase 1 

● ● ● ● ○ Initialization: Phase 2 

● ● ● ○ ○ Initialization: Phase 3 

○ ● ● ○ ○ Initialization: Phase 4 

Operation 

○ ● x x x CPU is in STOP state. 

☼ ○ x x x CPU is in start-up state, the RUN LED blinks during 
operating OB100 at least for 3s. 

● ○ ○ x x CPU is in state RUN without error. 

x x ● x x There is a system fault. More information may be found in 
the diagnostics buffer of the CPU. 

x x x ● x Variables are forced. 

x x x x ● Access to the memory card. 

Overall reset 

○ ☼ x x x Overall reset is requested. 

○ ☼* x x x * Blinking with 5Hz: Overall reset is executed. 

Factory reset 

● ● ○ ○ ○ Factory reset is executed. 

○ ● ● ● ● Factory reset finished without error. 

Firmware update 

○ ● ☼ ☼ ● The alternate blinking indicates that there is new firmware 
on the memory card. 

○ ○ ☼ ☼ ● The alternate blinking indicates that a firmware update is 
executed. 

○ ● ● ● ● Firmware update finished without error. 

○ ☼* ☼* ☼* ☼* * Blinking with 10Hz: Error during Firmware  update. 

on: ●         off: ○         blinking (2Hz): ☼         not relevant: x 
 
The green L/A-LED (Link/Activity) indicates the physical connection of the 
Ethernet PG/OP channel to Ethernet. Irregular flashing of the L/A-LED 
indicates communication of the Ethernet PG/OP channel via Ethernet. 
If the green S-LED (Speed) is on, the Ethernet PG/OP has a 
communication speed of 100MBit/s otherwise 10MBit/s. 
 

LEDs 

LEDs CPU 

LEDs Ethernet 
PG/OP channel  
L/A, S 
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MT 
yellow 

BF 
red 

Meaning 

x ● 
- Bus error, no connection to subnet/switch 
- wrong transfer speed 
- full-duplex transfer is not activated 

x ☼ 
- Failure of a connected IO device 
- at least 1 IO device may not be accessed 
- faulty configuration 

● x Maintenance event is pending. 

☼* ☼* * The alternate blinking with 4Hz indicates that a firmware update of the PROFINET IO 
controller is executed. 

● ● Firmware update of the PROFINET IO controller finished without error. 

☼ x As long as the PROFINET IO controller is not yet configured, for identification you may 
cause the LED to blink by means of the "Network search of your configuration tool.  

on: ●         off: ○         blinking (2Hz): ☼         not relevant: x 
 
The green L/A-LED (Link/Activity) indicates the physical connection of the 
PROFINET IO controller to Ethernet. Irregular flashing of the L/A-LED 
indicates communication of the PROFINET IO controller via Ethernet. 
If the green S-LED (Speed) is on, the PROFINET IO controller has a 
communication speed of 100MBit/s otherwise with 10MBit/s. 
 

 

 
 
 

RUN

STOP

MRES 

With the operating mode switch you may switch the CPU between STOP 
and RUN.  
During the transition from STOP to RUN the operating mode START-UP is 
driven by the CPU. 
Placing the switch to MRES (Memory Reset), you request an overall reset 
with following load from MMC, if a project there exists. 
 

 

LEDs PROFINET 
IO controller X8 

LEDs  
L/A, S 

Operating mode 
switch 
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Technical Data 
 

Order no. 315-4PN33 
Type CPU 315SN/PN ECO 
SPEED-Bus - 
Technical data power supply  
Power supply (rated value) DC 24 V 
Power supply (permitted range) DC 20.4...28.8 V 
Reverse polarity protection  
Current consumption (no-load operation) 200 mA 
Current consumption (rated value) 0.7 A 
Inrush current 11 A 
I²t 0.4 A²s 
Max. current drain at backplane bus 2 A 
Power loss 5.5 W 
Load and working memory  
Load memory, integrated 512 KB 
Load memory, maximum 512 KB 
Work memory, integrated 256 KB 
Work memory, maximal 256 KB 
Memory divided in 50% program / 50% data  
Memory card slot MMC-Card with max. 1 GB 
Hardware configuration  
Racks, max. 4  
Modules per rack, max. 8 in multiple-, 32 in a single-

rack configuration 
Number of integrated DP master 0  
Number of DP master via CP 4  
Operable function modules 8  
Operable communication modules PtP 8  
Operable communication modules LAN 8  
Status information, alarms, diagnostics  
Status display yes 
Interrupts no 
Process alarm no 
Diagnostic interrupt no 
Command processing times  
Bit instructions, min. 0.01 µs 
Word instruction, min. 0.01 µs 
Double integer arithmetic, min. 0.01 µs 
Floating-point arithmetic, min. 0.06 µs 
Timers/Counters and their retentive 
characteristics 

 

Number of S7 counters 512  
Number of S7 times 512  
Data range and retentive characteristic  
Number of flags 8192 Byte 
Number of data blocks 4095  
Max. data blocks size 64 KB 
Max. local data size per execution level 1024 Byte 
Blocks  
Number of OBs 20  
Number of FBs 2048  
Number of FCs 2048  
Maximum nesting depth per priority class 8  
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Order no. 315-4PN33 
Maximum nesting depth additional within an error 
OB 

4  

Time  
Real-time clock buffered  
Clock buffered period (min.) 6 W 
Accuracy (max. deviation per day) 10 s 
Number of operating hours counter 8  
Clock synchronization  
Synchronization via MPI Master/Slave 
Synchronization via Ethernet (NTP) Slave 
Address areas (I/O)  
Input I/O address area 2048 Byte 
Output I/O address area 2048 Byte 
Input process image maximal 2048 Byte 
Output process image maximal 2048 Byte 
Digital inputs 16384  
Digital outputs 16384  
Digital inputs central 1024  
Digital outputs central 1024  
Integrated digital inputs - 
Integrated digital outputs - 
Analog inputs 1024  
Analog outputs 1024  
Analog inputs, central 256  
Analog outputs, central 256  
Integrated analog inputs - 
Integrated analog outputs - 
Communication functions  
PG/OP channel  
Global data communication  
Number of GD circuits, max. 8  
Size of GD packets, max. 22 Byte 
S7 basic communication  
S7 basic communication, user data per job 76 Byte 
S7 communication  
S7 communication as server  
S7 communication as client - 
S7 communication, user data per job 160 Byte 
Number of connections, max. 32  
Functionality Sub-D interfaces  
Type X2 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI  
MP²I (MPI/RS232) - 
DP master - 
DP slave - 
Point-to-point interface - 
  
Type X3 
Type of interface RS485 
Connector Sub-D, 9-pin, female 
Electrically isolated  
MPI - 
MP²I (MPI/RS232) - 
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Order no. 315-4PN33 
DP master - 
DP slave - 
Point-to-point interface  
CAN - 
Functionality MPI  
Number of connections, max. 32  
PG/OP channel  
Routing  
Global data communication  
S7 basic communication  
S7 communication  
S7 communication as server  
S7 communication as client - 
Transmission speed, min. 19.2 kbit/s 
Transmission speed, max. 12 Mbit/s 
Functionality PROFIBUS master  
PG/OP channel - 
Routing - 
S7 basic communication - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Equidistance support - 
Isochronous mode - 
SYNC/FREEZE - 
Activation/deactivation of DP slaves - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. - 
Transmission speed, max. - 
Number of DP slaves, max. - 
Address range inputs, max. - 
Address range outputs, max. - 
User data inputs per slave, max. - 
User data outputs per slave, max. - 
Functionality PROFIBUS slave  
PG/OP channel - 
Routing - 
S7 communication - 
S7 communication as server - 
S7 communication as client - 
Direct data exchange (slave-to-slave 
communication) 

- 

DPV1 - 
Transmission speed, min. - 
Transmission speed, max. - 
Automatic detection of transmission speed - 
Transfer memory inputs, max. - 
Transfer memory outputs, max. - 
Address areas, max. - 
User data per address area, max. - 
Functionality PROFINET I/O controller  
Realtime Class - 
Conformance Class PROFINET IO 
Number of  PN IO devices 32  
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Order no. 315-4PN33 
IRT support - 
Prioritized start-up - 
Number of PN IO lines 1  
Address range inputs, max. 2 KB 
Address range outputs, max. 2 KB 
Transmiting clock 1 ms 
Update time 1 ms .. 512 ms 
Point-to-point communication  
PtP communication  
Interface isolated  
RS232 interface - 
RS422 interface - 
RS485 interface  
Connector Sub-D, 9-pin, female 
Transmission speed, min. 150 bit/s 
Transmission speed, max. 115.5 kbit/s 
Cable length, max. 500 m 
Point-to-point protocol  
ASCII protocol  
STX/ETX protocol  
3964(R) protocol  
RK512 protocol - 
USS master protocol  
Modbus master protocol  
Modbus slave protocol - 
Special protocols - 
Functionality RJ45 interfaces  
Type X5 
Type of interface Ethernet 10/100 MBit 
Connector RJ45 
Electrically isolated  
PG/OP channel  
Productive connections - 
  
Type X8 
Type of interface Ethernet 10/100 MBit 
Connector RJ45 
Electrically isolated  
PG/OP channel  
Productive connections  
Ethernet communication CP  
Number of productive connections, max. 8  
Number of productive connections by Siemens 
NetPro, max. 

8  

S7 connections USEND, URCV, BSEND, 
BRCV, GET, PUT, 
Connection of active and 
passive data handling 

User data per S7 connection, max. 32 KB 
TCP-connections FETCH PASSIV, WRITE 

PASSIV, Connection of 
passive data handling 

User data per TCP connection, max. 64 KB 
ISO-connections - 
User data per ISO connection, max. - 
ISO on TCP connections (RFC 1006) FETCH PASSIV, WRITE 

PASSIV, Connection of 
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Order no. 315-4PN33 
passive data handling 

User data per ISO on TCP connection, max. 32 KB 
UDP-connections - 
User data per UDP connection, max. - 
UDP-multicast-connections - 
UDP-broadcast-connections - 
Ethernet open communication  
Number of connections, max. 8  
User data per ISO on TCP connection, max. 8 KB 
User data per native TCP connection, max. 8 KB 
User data per ad hoc TCP connection, max. 1460 Byte 
User data per UDP connection, max. 1472 Byte 
Housing  
Material PPE 
Mounting Rail System 300 
Mechanical data  
Dimensions (WxHxD) 80 x 125 x 120 mm 
Weight 430 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -25 °C to 70 °C 
Certifications  
UL508 certification in preparation 
 
 
 



Manual VIPA System 300S SPEED7 Chapter 4   Deployment CPU 315-4PN33 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  4-1 

Chapter 4  Deployment CPU 315-4PN33 
 

This chapter describes the deployment of a CPU 315-4PN33 with SPEED7 
technology in the System 300S. The description refers directly to the CPU 
and to the deployment in connection with peripheral modules, mounted on 
a profile rail together with the CPU at the standard bus. 
 

 

Topic     Page 
Chapter 4 Deployment CPU 315-4PN33 .......................................... 4-1 

Assembly.............................................................................................. 4-2 
Start-up behavior.................................................................................. 4-2 
Addressing ........................................................................................... 4-3 
Hardware configuration - CPU.............................................................. 4-5 
Hardware configuration - I/O modules .................................................. 4-6 
Hardware configuration - Ethernet PG/OP channel .............................. 4-7 
Setting standard CPU parameters........................................................ 4-9 
Setting VIPA specific CPU parameters............................................... 4-14 
Project transfer................................................................................... 4-17 
Access to the internal Web page ........................................................ 4-21 
Operating modes................................................................................ 4-23 
Overall reset....................................................................................... 4-26 
Firmware update ................................................................................ 4-28 
Factory reset ...................................................................................... 4-31 
Slot for storage media ........................................................................ 4-32 
Extended know-how protection........................................................... 4-33 
MMC-Cmd - Auto commands ............................................................. 4-35 
VIPA specific diagnostic entries.......................................................... 4-37 
Using test functions for control and monitoring of variables ................ 4-42 

 

Overview 

Content 



Chapter 4   Deployment CPU 315-4PN33 Manual VIPA System 300S SPEED7 

4-2  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

Assembly 
 

Note! 
Information about assembly and cabling may be found at chapter 
"Assembly and installation guidelines". 
 

Start-up behavior 
 

After the power supply has been switched on, the CPU changes to the 
operating mode the operating mode lever shows. 
 
When the CPU is delivered it has been reset.  
After a STOP→RUN transition the CPU switches to RUN without program. 
 
The CPU switches to RUN with the program stored in the battery buffered 
RAM. 
 

The accumulator/battery is automatically loaded via the integrated power 
supply and guarantees a buffer for max. 30 days. If this time is exceeded, 
the battery may be totally discharged. This means that the battery buffered 
RAM is deleted. 
In this state, the CPU executes an overall reset. If a MMC is plugged, 
program code and data blocks are transferred from the MMC into the work 
memory of the CPU. 
If no MMC is plugged, the CPU transfers permanent stored "protected" 
blocks into the work memory if available. 
Information about storing protected blocks in the CPU is to find in this 
chapter at "Extended Know-how protection".  
Depending on the position of the operating mode switch, the CPU switches 
to RUN res. remains in STOP. 
This event is stored in the diagnostic buffer as: "Start overall reset 
automatically (unbuffered PowerON)". 
 

Attention! 
After a power reset and with an empty battery the CPU starts with a BAT 
error and executes an overall reset.  
The BAT error can be deleted again, if once during power cycle the time 
between switching on and off the power supply is at least 30sec. and the 
battery is fully loaded. 
Otherwise with a short power cycle the BAT error still exists and an overall 
reset is executed. 
 

     

Turn on power 
supply 

Default boot 
procedure, as 
delivered 

Boot procedure with 
valid configuration 
in the CPU 

Boot procedure 
with empty battery 
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Addressing 
 

To provide specific addressing of the installed peripheral modules, certain 
addresses must be allocated in the CPU. 
At the start-up of the CPU, this assigns automatically peripheral addresses 
for digital in-/output modules starting with 0 and ascending depending on the 
slot location.  
If no hardware project engineering is available, the CPU stores at the 
addressing analog modules to even addresses starting with 256. 
 

The CPU 315-4PN33 provides an I/O area (address 0 ... 2047) and a 
process image of the in- and outputs (each address 0 ... 255). 
The process image stores the signal states of the lower address (0 ... 255) 
additionally in a separate memory area. 
The process image this divided into two parts: 
• process image to the inputs (PII) 
• process image to the outputs (PIQ) 
 

I/O area
0
.
.
.
.

255.
.
.
.

2047

Process image
0
.
.
.

255

0
.
.
.

255

Inputs
PII

Outputs
PIQ

 
 

The process image is updated automatically when a cycle has been 
completed. 
 

Maximally 8 modules per row may be configured by the CPU 315-4PN33.  
For the project engineering of more than 8 modules you may use line 
interface connections. For this you set in the hardware configurator the 
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. 
Now you may extend your system with up to 3 profile rails by starting each 
with an IM 361 from Siemens at slot 3. Considering the max total current 
with the CPU 315-4PN33 from VIPA up to 32 modules may be arranged in 
a row. Here the installation of the line connections IM 360/361 from 
Siemens is not required.   
 

You may access the modules with read res. write accesses to the 
peripheral bytes or the process image. 
To define addresses a hardware configuration may be used. For this, click 
on the properties of the according module and set the wanted address. 

Overview 

Addressing 
Backplane bus 
I/O devices 

Max. number of 
pluggable 
modules 

Define addresses 
by hardware 
configuration 
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If you do not like to use a hardware configuration, an automatic addressing 
comes into force. 
At the automatic address allocation DIOs occupy depending on the slot 
location always 4byte and AIOs, FMs, CPs always 16byte at the bus. 
Depending on the slot location the start address from where on the 
according module is stored in the address range is calculated with the 
following formulas: 
 
DIOs: Start address = 4⋅(slot -1)  
AIOs, FMs, CPs: Start address = 16⋅(slot -1)+256 
 

4 5 6 7

1, 2, ...

12
304

8
288

4
272

0
256

Slot number

CPU

Start
address 

digital:
analog:  

 
The following sample shows the functionality of the automatic address 
allocation: 
 

0..
8

9....
12

13..
255

256...
320...
335......
2047

0

1.......
12

13...
255

256....
272

287....
2047

PII

CP
U 

31
5

 Input Byte

Address  Periphery area

 Input Byte

 Input Byte

Output Byte

Periphery area  Address

an
al

og
di

gi
ta

l

an
al

og
di

gi
ta

l

PIQ

Slot number:            4             5              6              7              8               

 Input Byte up to max. 255

 Output Byte

 Output Byte

 Output Byte

Output Byte

 Output Byte
...

 Input Byte

 Input Byte

Bus

D
I 1

6x
D

C
24

V

A
I 8

x1
2B

it

D
O

 1
6x

D
C

24
V

D
IO

 1
6x

D
C

24
V

AO
 4

x1
2B

it

up to max. 255

 
 
 
 

Automatic 
addressing 

Example for 
automatic address 
allocation 
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Hardware configuration - CPU 
 

The hardware configuration of the VIPA CPU takes place at the Siemens 
hardware configurator. 
The hardware configurator is a part of the Siemens SIMATIC Manager. It 
serves the project engineering. The modules, which may be configured 
here are listed in the hardware catalog. If necessary you have to update the 
hardware catalog with Options > Update Catalog. 
For project engineering a thorough knowledge of the Siemens SIMATIC 
manager and the Siemens hardware configurator are required! 
 

Note! 
Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic 
operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of 
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. 
This may cause conflicts in applications that presume an unmodified 
ACCU2. 
For more information may be found in the manual "VIPA Operation list 
SPEED7" at "Differences between SPEED7 and 300V programming". 
 

To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

Slot
1
2

X1
X2

X2 P1
3

Module

CPU 315-2 PN
MPI/DP
PN-IO
Port 1

 

• Start the Siemens hardware configurator with a new project. 
• Insert a profile rail from the hardware catalog. 
• Place at slot 2 the following CPU from Siemens:  

CPU 315-2EH13 (6ES7 315-2EH13-0AB0 V2.6). 
• The PROFINET-IO Controller is to be configured via the sub module 

X2 (PN-IO). 
 

 

Requirements 

     

Proceeding 
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Hardware configuration - I/O modules 
 

After the hardware configuration place the System 300 modules in the 
plugged sequence starting with slot 4. 
 

DI DO DIO AI AO

CPU

Module

CPU

DI
DO
DIO
AI
AO

Slot
1
2

X...

3
4
5
6
7
8
9
10
11

Parameter DIO

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........

 
 

For parameterization double-click during the project engineering at the slot 
overview on the module you want to parameterize In the appearing dialog 
window you may set the wanted parameters. 
 
By using the SFCs 55, 56 and 57 you may alter and transfer parameters for 
wanted modules during runtime. 
For this you have to store the module specific parameters in so called 
"record sets". 
More detailed information about the structure of the record sets is to find in 
the according module description. 
 

For the project engineering of more than 8 modules you may use line 
interface connections. For this you set in the hardware configurator the 
module IM 360 from the hardware catalog to slot 3 of your 1. profile rail. 
Now you may extend your system with up to 3 profile rails by starting each 
with an IM 361 from Siemens at slot 3. Considering the max total current 
with the VIPA SPEED7 CPUs up to 32 modules may be arranged in a row. 
Here the installation of the line connections IM 360/361 from Siemens is not 
required.   
 

Hardware 
configuration of 
the modules  

Parameterization  

Parameterization 
during runtime 

Bus extension 
with IM 360 and  
IM 361 
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Hardware configuration - Ethernet PG/OP channel 
 

The CPU 315-4PN33 has an integrated Ethernet PG/OP channel. This 
channel allows you to program and remote control your CPU. 
The PG/OP channel also gives you access to the internal web page that 
contains information about firmware version, connected I/O devices, current 
cycle times etc. 
With the first start-up respectively after an overall reset the Ethernet PG/OP 
channel does not have any IP address. 
For online access to the CPU via Ethernet PG/OP channel valid IP address 
parameters have to be assigned to this by means of the Siemens SIMATIC 
manager. This is called "initialization". 
 

• Install your System 300S with your CPU.  
• Wire the system by connecting cables for voltage supply and signals. 
• Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet 
• Switch on the power supply.   

→ After a short boot time the CP is ready for communication. 
 He possibly has no IP address data and requires an initialization. 

 

The initialization via PLC functions takes place with the following 
proceeding: 
• Determine the current Ethernet (MAC) address of your Ethernet PG/OP 

channel. This always may be found as 1. address under the front flap of 
the CPU on a sticker on the left side. 
 

Ethernet address
1. Ethernet PG/OP channel
2. PROFINET IO controller 

PG/OP channel

X2 X3
MPI   PtP

X1

+
-

DC 24V

X5X8

TP

 

Overview 

Assembly and 
commissioning 

"Initialization" via 
PLC functions 
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You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens SIMATIC 
manager starting with version V 5.3 & SP3 with the following proceeding: 
• Start the Siemens SIMATIC manager and set via Options > Set PG/PC 

interface the access path to "TCP/IP -> Network card .... ". 
• Open with PLC > Edit Ethernet Node the dialog window with the same 

name. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address may be found at the 1. label 
beneath the front flap of the CPU. 

• Choose if necessary the known MAC address of the list of found 
stations.  

• Either type in the IP configuration like IP address, subnet mask and 
gateway.  

• Confirm with [Assign IP configuration]. 
 
Note! 
Direct after the assignment the Ethernet PG/OP channel may be reached 
online by these address data. 
The value remains as long as it is reassigned, it is overwritten by a 
hardware configuration or an factory reset is executed. 
 
• Open the Siemens hardware configurator und configure the Siemens 

CPU 315-2 PN/DP (6ES7 315-2EH13-0AB0 V2.6). 
• Configure the modules at the standard bus. 
• For the Ethernet PG/OP channel you have to configure a Siemens 

CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7 
343-1EX11 0XE0) always below the really plugged modules. 

• Open the property window via double-click on the CP 343-1EX11 and 
enter for the CP at "Properties" the IP address data, which you have 
assigned before.  

• Transfer your project. 
 

 

Standard bus (serial)

CPU DI DO DIO AI AO

Ethernet PG/OP channel

Et
he

rn
et

 P
G

/O
P

Standard bus
Slot

1
2

X...

3
4
5
6
7
8
9

10
11

Module

CPU 

DI
DO
DIO
AI
AO
343-1EX11

 
 

Assign IP address 
parameters 

     

Take IP address 
parameters in 
project 
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Setting standard CPU parameters 
 

Since the CPU is to be configured as Siemens CPU 315-2PN/DP (6ES7 
315-2EH13-0AB0 V2.6) in the Siemens hardware configurator, the 
standard parameters of the VIPA CPU may be set with "Object properties" 
of the CPU 315-2PN/DP during hardware configuration. 
Via a double-click on the CPU 315-2PN/DP the parameter window of the 
CPU may be accessed. 
Using the registers you get access to every standard parameter of the 
CPU. 
 

Slot
1
2

X1
X2

X2 P1
3

Modul

CPU ...
MPI/DP
PN-IO
Port 1

Parameter CPU

Param : .........
Param : .........
Param : .........
Param : .........

Param : .........
Param : .........
Param : .........
Param : .........

 
 

The CPU does not evaluate each parameter, which may be set at the 
hardware configuration. The parameters of the following registers are not 
currently supported: Synchronous cycle interrupt, Communication and 
Web.  
The following parameters are supported by the CPU at this time: 
 
 
 
The short description of the Siemens CPU 315-2EH13 is CPU 315-2PN/DP. 
 
Order number and firmware are identical to the details in the "hardware 
catalog" window. 
 
The Name field provides the short description of the CPU. If you change 
the name the new name appears in the Siemens SIMATIC manager. 
 
Here is the possibility to specify a plant designation for the CPU. This plant 
designation identifies parts of the plant according to their function. This has 
a hierarchical structure and confirms to IEC 1346-1. 
  
The location designation is part of the resource designation. Here the exact 
location of your module within a plant may be specified. 
 
In this field information about the module may be entered. 
 

Parameterization 
via Siemens 
CPU 315-2EH13 

Supported 
parameters 

General 

Short description 

Order No. / 
Firmware 

Name 

Plant designation 

Location 
designation 

Comment 
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If the checkbox for "Startup when expected/actual configuration differ" is 
deselected and at least one module is not located at its configured slot or if 
another type of module is inserted there instead, then the CPU does not 
switch to RUN mode and remains in STOP mode. 
If the checkbox for "Startup when expected/actual configuration differ" is 
selected, then the CPU starts even if there are modules not located in their 
configured slots of if another type of module is inserted there instead, such 
as during an initial system start-up. 
 
This operation specifies the maximum time for the ready message of every 
configured module after PowerON. Here connected PROFIBUS DP slaves 
are also considered until they are parameterized. If the modules do not 
send a ready message to the CPU by the time the monitoring time has 
expired, the actual configuration becomes unequal to the preset 
configuration. 
 
The maximum time for the transfer of parameters to parameterizable 
modules. Here connected PROFINET IO devices also considered until they 
are parameterized. If not every module has been assigned parameters by 
the time this monitoring time has expired; the actual configuration becomes 
unequal to the preset configuration. 
 

 
 
This parameter is not relevant. 
 
 
Here the scan cycle monitoring time in milliseconds may be set. If the scan 
cycle time exceeds the scan cycle monitoring time, the CPU enters the 
STOP mode. Possible reasons for exceeding the time are: 
• Communication processes 
• a series of interrupt events 
• an error in the CPU program 
 
This parameter is not relevant. 

 
Using this parameter you can control the duration of communication 
processes, which always extend the scan cycle time so it does not exceed 
a specified length. 
If the cycle load from communication is set to 50%, the scan cycle time of 
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still 
being influenced by asynchronous events (e.g. hardware interrupts) as well. 

 
Here the size of the process image max. 2048 for the input/output periphery 
may be fixed. 
 

Startup 

Startup when 
expected/actual 
configuration differs 

Monitoring time for 
ready message by 
modules [100ms] 

Monitoring time for 
transfer of 
parameters to 
modules [100ms] 

Cycle/Clock 
memory 
Update OB1 
process image 
cyclically 
 
Scan cycle 
monitoring time 

Minimum scan  
cycle time 

Scan cycle load 
from Communi-
cation 

Size of the process 
image input/output 
area 
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The preset reaction of the CPU may be changed to an I/O access error that 
occurs during the update of the process image by the system. 
The VIPA CPU is preset such that OB 85 is not called if an I/O access error 
occurs and no entry is made in the diagnostic buffer either. 
 
Activate the check box if you want to use clock memory and enter the 
number of the memory byte. 
 

Note! 
The selected memory byte cannot be used for temporary data storage. 
 
 

 
 
Enter the number of retentive memory bytes from memory byte 0 onwards. 
 
 
Enter the number of retentive S7 timers from T0 onwards.  
 
 
Enter the number of retentive S7 counter from C0 onwards. 
 
 
These parameters are not relevant. 
 
 
 
 
Here the priorities are displayed, according to which the hardware interrupt 
OBs are processed (hardware interrupt, time-delay interrupt, async. error 
interrupts).  
  

OB85 call up at I/O 
access error 

Clock memory 

     

Retentive Memory 

Number of Memory 
Bytes from MB0 

Number of S7 
Timers from T0 

Number of S7 
Counters from C0 

Areas 

Interrupts 

Priority 
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Here the priorities may be specified according to which the time-of-day 
interrupt is processed. 
With priority "0" the corresponding OB is deactivated. 
 
Activate the check box of the time-of-day interrupt OBs if these are to be 
automatically started on complete restart. 
 
Select how often the interrupts are to be triggered. Intervals ranging from 
every minute to yearly are available. The intervals apply to the settings 
made for start date and time. 
 
Enter date and time of the first execution of the time-of-day interrupt. 
 
This parameter is not supported. 
 
 
 
 
Here the priorities may be specified according to which the corresponding 
cyclic interrupt is processed. With priority "0" the corresponding interrupt is 
deactivated. 
 
Enter the time intervals in ms, in which the watchdog interrupt OBs should 
be processed. The start time for the clock is when the operating mode 
switch is moved from STOP to RUN. 
 
Enter the delay time in ms for current execution for the watch dog interrupt. 
This should be performed if several watchdog interrupts are enabled. 
Phase offset allows to distribute processing time for watchdog interrupts 
across the cycle. 
 
This parameter is not supported. 
 

Time-of-day 
interrupts 

Priority 

Active 

Execution 

Start date / time 

Process image 
partition 

Cyclic interrupts 

Priority 

Execution 

Phase offset 

Process image 
partition 
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Activate this parameter, if the CPU should report the cause of STOP to PG 
respectively OP on transition to STOP.  
 
Here the number of diagnostics are displayed, which may be stored in the 
diagnostics buffer (circular buffer). 
 
 
Here you specify whether clock should synchronize other clocks or not. 
- as slave: The clock is synchronized by another clock. 
- as master: The clock synchronizes other clocks as master. 
- none: There is no synchronization 
 
Time intervals within which the synchronization is to be carried out. 
 
Lose or gain in the clock time may be compensated within a 24 hour period 
by means of the correction factor in ms. If the clock is 1s slow after 24 
hours, you have to specify a correction factor of "+1000" ms. 
 

 
 
Here 1 of 3 protection levels may be set to protect the CPU from 
unauthorized access. 
Protection level 1 (default setting): 
• No password adjustable, no restrictions 
Protection level 2 with password: 
• Authorized users: read and write access 
• Unauthorized user: read access only 
Protection level 3: 
• Authorized users: read and write access 
• Unauthorized user: no read and write access 

Diagnostics/Clock 

Report cause of 
STOP 

Number of 
messages in the 
diagnostics buffer 

Synchronization 
type 

Time interval 

Correction factor 

Protection 

Level of protection 
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Setting VIPA specific CPU parameters 
 

Except of the VIPA specific CPU parameters the CPU parameterization 
takes place in the parameter dialog of the CPU from Siemens. 
With installing of the SPEEDBUS.GSD the VIPA specific parameters may 
be set during hardware configuration. 
Here the following parameters may be accessed: 
• Number remanence flag, timer, counter 
• Priority OB 28, OB 29 
 

 

Since the VIPA specific CPU parameters may be set, the installation of the 
SPEEDBUS.GSD from VIPA in the hardware catalog is necessary. 
The CPU may be configured in a PROFIBUS master system and the 
appropriate parameters may be set after installation. 
 
The GSD (Geräte-Stamm-Datei) is online available in the following 
language versions. Further language versions are available on inquires. 
Name Language 
SPEEDBUS.GSD german (default) 
SPEEDBUS.GSG german 
SPEEDBUS.GSE english 
  
The GSD files may be found at www.vipa.com at the "Service" part. 
 
The integration of the SPEEDBUS.GSD takes place with the following 
proceeding: 
• Browse to www.vipa.com. 
• Click to Service > Download > GSD- and EDS-Files > PROFIBUS. 
• Download the file Cx000023_Vxxx. 
• Extract the file to your work directory. The SPEEDBUS.GSD is stored in 

the directory VIPA_System_300S.   
• Start the hardware configurator from Siemens. 
• Close every project. 
• Select Options > Install new GSD-file. 
• Navigate to the directory VIPA_System_300S and select 

SPEEDBUS.GSD. 
The SPEED7 CPUs and modules of the System 300S from VIPA may now 
be found in the hardware catalog at PROFIBUS-DP / Additional field 
devices / I/O / VIPA_SPEEDBUS. 
 

Overview 

Requirements 

Installation of the  
SPEEDBUS.GSD 
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The embedding of the CPU 315-4PN33 happens by means of a virtual 
PROFIBUS master system with the following approach: 
 

virtual DP master for CPU

VIPA_SPEEDbus
Order No.
315-4PN33 ...

(100) VIPA
SPEEDbus

CPU:
Addr.:100

Slot.
0

Object properties

Slot
1
2

X...

3

Module

CPU ...

always as last module
342-5DA02 V5.0

...

 

• Perform a hardware configuration for the CPU (see 
"Hardware configuration - CPU"). 

• Configure always as last module a Siemens DP master 
CP 342-5 (342-5DA02 V5.0). Connect and parame-
terize it at operation mode "DP-Master". 

• Connect the slave system "VIPA_SPEEDbus". After 
installing the SPEEDBUS.GSD this may be found in 
the hardware catalog at Profibus-DP / Additional field 
devices / I/O / VIPA / VIPA_SPEEDBUS. 

• For the slave system set the PROFIBUS address 100. 
• Configure at slot 0 the VIPA CPU 315-4PN33 of the 

hardware catalog from VIPA_SPEEDbus. 
• By double clicking the placed CPU 315-4PN33 the 

properties dialog of the CPU may be opened.  
 
As soon as the project is transferred together with the 
PLC user program to the CPU, the parameters will be 
taken after start-up. 
 
 
 
 

 

Note! 
The hardware configuration, which is shown here, is only required, if you 
want to customize the VIPA specific parameters. 
 

 

Proceeding 
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The following parameters may be accessed by means of the properties 
dialog of the VIPA-CPU. 
 

Here the number of flag bytes may be set. With 0 the value Retentive 
memory > Number of memory bytes starting with MB0 set at the 
parameters of the Siemens CPU is used. Otherwise the adjusted value  
(1 ... 8192) is used. 
Default: 0 
 

The priority fixes the order of interrupts of the corresponding interrupt OB. 
Here the following priorities are supported: 
0 (Interrupt-OB is deactivated), 2, 3, 4, 9, 12, 16, 17, 24  
Default: 24 
 
 
 
 

VIPA specific 
parameters 

Number 
remanence flag 

Priority of  
OB28, OB29 
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Project transfer 
 

There are the following possibilities for project transfer into the CPU: 
• Transfer via MPI 
• Transfer via Ethernet 
• Transfer via MMC 
 

 

For transfer via MPI there is the following interface: 
• X2: MPI interface  
 
The structure of a MPI net is electrically identical with the structure of a 
PROFIBUS net. This means the same rules are valid and you use the 
same components for the build-up. The single participants are connected 
with each other via bus interface plugs and PROFIBUS cables.  
Please consider with the CPU 315-4PN33 that the total extension of the 
MPI net does not exceed 50m. Per default the MPI net runs with 
187.5kbaud. VIPA CPUs are delivered with MPI address 2. 
 
The MPI programming cables are available at VIPA in different variants. 
The cables provide a RS232 res. USB plug for the PC and a bus enabled 
RS485 plug for the CPU. 
Due to the RS485 connection you may plug the MPI programming cables 
directly to an already plugged plug on the RS485 jack. Every bus 
participant identifies itself at the bus with an unique address, in the course 
of the address 0 is reserved for programming devices. 
 
A cable has to be terminated with its surge impedance. For this you switch 
on the terminating resistor at the first and the last participant of a network or 
a segment. 
Please make sure that the participants with the activated terminating 
resistors are always power supplied. Otherwise it may cause interferences 
on the bus. 
 

MPI programming cable

STEP7
from Siemens

MPI netTermination Termination

max. 50m

M
P

I

U
S

B-M
PI A

dapter

Pow
er

Active

Error

VIPA 950-0KB31

U
SB

VIP
A

 
 

Overview 

Transfer via MPI 

Net structure 

MPI programming 
cable 

Terminating resistor 
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• Connect your PC to the MPI jack of your CPU via a MPI programming 
cable.  

• Load your project in the SIMATIC Manager from Siemens. 
• Choose in the menu Options > Set PG/PC interface. 
• Select in the according list the "PC Adapter (MPI)"; if appropriate you 

have to add it first, then click on [Properties]. 
• Set in the register MPI the transfer parameters of your MPI net and type 

a valid address. 
• Switch to the register Local connection. 
• Set the COM port of the PCs and the transfer rate 38400Baud for the 

MPI programming cable from VIPA.  
• Via PLC > Load to module you may transfer your project via MPI to the 

CPU and save it on a MMC via PLC > Copy RAM to ROM if one is 
plugged. 

 

 

Approach transfer 
via MPI interface 
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y 

For transfer via Ethernet the CPU has the following 2 interfaces: 
• X5: Ethernet PG/OP channel 
• X8: PROFINET IO controller 
 

So that you may access the Ethernet PG/OP channel you have to assign IP 
address parameters by means of the "initialization"(see "hardware 
configuration - Ethernet PG/OP channel". 
Information about the initialization of the Ethernet PG/OP channel may be 
found  at "Initialization of Ethernet PG/OP channel". 
Information about the initialization of the PROFINET IO controller may be 
found at "Commissioning and Initialization" in chapter "Deployment 
Ethernet com. - PROFINET". 
 

• For the transfer, connect, if not already done, the appropriate Ethernet 
port to your Ethernet. 

• Open your project with the Siemens SIMATIC Manager. 
• Set via Options > Set PG/PC Interface the access path to "TCP/IP -> 

Network card .... ". 
• Click to PLC > Download → the dialog "Select target module" is opened. 

Select your target module and enter the IP address parameters of the 
Ethernet PG/OP channel for connection. Provided that no new hardware 
configuration is transferred to the CPU, the entered Ethernet connection 
is permanently stored in the project as transfer channel. 

• With [OK] the transfer is started. 
 

Note! 
System dependent you get a message that the projected system differs 
from target system. This message may be accepted by [OK]. 
→ your project is transferred and may be executed in the CPU after 
transfer. 
 
 

Transfer via 
Ethernet 

Initialization 

Transfer 
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The MMC (Memory Card) serves as external transfer and storage medium. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project is stored in the root 
directory and has one of the following file names: 
• S7PROG.WLD 
• AUTOLOAD.WLD 
With File > Memory Card File > New in the Siemens SIMATIC Manager a  
new wld file may be created. After the creation copy the blocks from the 
project blocks folder and the System data into the wld file. 
 

The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after an overall reset or PowerON. 
• S7PROG.WLD is read from the MMC after overall reset. 
• AUTOLOAD.WLD is read after PowerON from the MMC. 
The blinking of the MCC-LED of the CPU marks the active transfer. Please 
regard that your user memory serves for enough space, otherwise your 
user program is not completely loaded and the SF LED gets on.   
 

When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD on the MMC.  
The write command is controlled by means of the block area of the 
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write 
process the MCC-LED of the CPU is blinking. When the LED expires the 
write process is finished. 
If this project is to be loaded automatically from the MMC with PowerON, 
you have to rename this on the MMC to AUTOLOAD.WLD. 
 
After a MMC access, an ID is written into the diagnostic buffer of the CPU. 
To monitor the diagnosis entries, you select PLC > Module Information in 
the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you 
reach the diagnosis window.  
When accessing a MMC, the following events may occur: 

Event-ID Meaning 
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC-error with storing 
0xE200 MMC writing finished successful 
0xE210 MMC reading finished (reload after overall reset) 
0xE21F Error during reload, read error, out of memory 

 
 

Transfer via 
MMC 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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Access to the internal Web page 
 

The Ethernet PG/OP channel provides a web page that you may access via 
an Internet browser by its IP address. The web page contains information 
about firmware versions, current cycle times etc. 
The current content of the web page is stored on MMC by means of the 
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd - 
Auto commands". 
 
A PG/OP channel connection should be established between PC with 
Internet browser and CPU 315-4PN33. This may be tested by Ping to the 
IP address of the PG/OP channel. 
 

Web page 

 

The access takes place via the IP address of the Ethernet PG/OP channel. 
The web page only serves for information output. The monitored values are 
not alterable. 

 

 
CPU WITH ETHERNET PG/OP   
Slot 100   
VIPA 315-4PN33 V.... Px000175.pkg, 
SERIALNUMBER 05439 

 Order no., firmware vers., package,  
serial no. 

SUPPORTDATA :  
PRODUCT V3596, HARDWARE V0112, 5757C-V11 , 
HX000071.110 , Bx000227 V6596, Ax000086 
V1200, Ax000127 V1020, fx000007.wld V1180, 
FlashFileSystem : V102 

 Information for support 

Memorysizes (Bytes): LoadMem : 524288, 
WorkMemCode : 262144, WorkMemData : 262144 
 

 Information about memory 
configuration, load memory, work 
memory (code/data) 

OnBoardEthernet : MacAddress : 0020D500051B, 
IP-Address : , SubnetMask : , Gateway : 

 Ethernet PG/OP: Addresses  

Cpu state : Stop  CPU status 
FunctionRS485 X2/COM1: MPI 
FunctionRS485 X3/COM2: PtP 

 Operating mode RS485  
(MPI: MPI operation, PtP: Point-to-
Point operation) 

Cycletime [microseconds] :  
min=0 cur=0 ave=0 max=0 

 CPU cycle time:  
min= minimal 
cur= current 
max= maximal 

ArmLoad [percent] : cur11, max=11  Information for support 
PowerCycleHxRetries : 4, 0, 0, 0, 0   
AutoCompress activated   
   
  Additional CPU components: 

Slot 206  Slot 206 (PROFINET IO controller): 
V1.0.7 Px000180.pkg,  Name, firmware version, package 
SUPPORTDATA :  

Bb000429 V1072, PRODUCT V1072, Hx000075 
V1210, ModuleType ACDB0082 
Address Input 2046 

 Information for support 

   
continued ... 

Access to the 
web page 

Requirements 
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... continue 
   

Standard Bus   Modules at the standard bus 
BaudRate Read Mode1, BaudRate Write Mode1  Information for the support 

   
Line 1: ModuleType 94F9:IM36x  IM interface if exists 
Rack 0 /Slot 4  Rack no. / Slot no. 
ModuleType:9FC3: Digital Input 32 
Baseaddress Input 0 

 Type of module 
Configured base address 
if exists firmware no. and package 

Rack 0 /Slot 5 ...  Rack no. / slot no. 
...   
Line 2: ModuleType A4FE:IM36x  IM interface if exists 
Rack 1 /Slot 4   
ModuleType:9FC3: Digital Input 32 
Baseaddress Input 0 

 Type of module 
Configured base address 
if exists firmware no. and package 

Rack 1 /Slot 5 ...  Rack no. / slot no. 
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Operating modes 
 

The CPU can be in one of 4 operating modes: 
• Operating mode STOP 
• Operating mode START-UP 
• Operating mode RUN 
• Operating mode HOLD 
Certain conditions in the operating modes START-UP and RUN require a 
specific reaction from the system program. In this case the application 
interface is often provided by a call to an organization block that was 
included specifically for this event. 
 

• The application program is not processed. 
• If there has been a processing before, the values of counters, timers, 

flags and the process image are retained during the transition to the 
STOP mode. 

• Outputs are inhibited, i.e. all digital outputs are disabled. 
• RUN-LED  off 
• STOP-LED  on 
 

• During the transition from STOP to RUN a call is issued to the start-up 
organization block OB 100. The processing time for this OB is not 
monitored. The START-UP OB may issue calls to other blocks. 

• All digital outputs are disabled during the START-UP, i.e. outputs are 
inhibited. 

• RUN-LED blinks as soon as the OB 100 is operated and for at least 
   3s, even if the start-up time is shorter or the CPU gets to 
   STOP due to an error. This indicates the start-up. 

• STOP-LED off 
When the CPU has completed the START-UP OB, it assumes the 
operating mode RUN. 
 

• The application program in OB 1 is processed in a cycle. Under the 
control of alarms other program sections can be included in the cycle. 

• All timers and counters being started by the program are active and the 
process image is updated with every cycle. 

• The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs 
are enabled. 

• RUN-LED on 
• STOP-LED off 
 

Overview 

Operating mode 
STOP 

Operating mode 
START-UP 

Operating mode 
RUN 



Chapter 4   Deployment CPU 315-4PN33 Manual VIPA System 300S SPEED7 

4-24  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

The CPU offers up to 3 breakpoints to be defined for program diagnosis. 
Setting and deletion of breakpoints happens in your programming 
environment. As soon as a breakpoint is reached, you may process your 
program step by step. 
 

For the usage of breakpoints, the following preconditions have to be 
fulfilled:  
• Testing in single step mode is possible with STL. If necessary switch the 

view via View > STL to STL. 
• The block must be opened online and must not be protected.  
 

• Activate View > Breakpoint Bar.  
• Set the cursor to the command line where you want to insert a 

breakpoint. 
• Set the breakpoint with Debug > Set Breakpoint. The according 

command line is marked with a circle. 
• To activate the breakpoint click on Debug > Breakpoints Active. The 

circle is changed to a filled circle. 
• Bring your CPU into RUN. When the program reaches the breakpoint, 

your CPU switches to the state HOLD, the breakpoint is marked with an 
arrow and the register contents are monitored. 

• Now you may execute the program code step by step via Debug > 
Execute Next Statement or run the program until the next breakpoint via 
Debug > Resume.  

• Delete (all) breakpoints with the option Debug > Delete All Breakpoints. 
 

• The RUN-LED blinks and the STOP-LED is on. 
• The execution of the code is stopped. No level is further executed. 
• All times are frozen. 
• The real-time clock runs is just running. 
• The outputs were disabled (BASP is activated). 
• Configured CP connections remain exist. 
 

Note! 
The usage of breakpoints is always possible. Switching to the operating 
mode test operation is not necessary.  
With more than 2 breakpoints, a single step execution is not possible.  
 
 

Operating mode 
HOLD 

Precondition 

Approach for 
working with 
breakpoints 

Behavior in 
operating state 
HOLD 
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The CPUs include security mechanisms like a Watchdog (100ms) and a 
parameterizable cycle time surveillance (parameterizable min. 1ms) that 
stop res. execute a RESET at the CPU in case of an error and set it into a 
defined STOP state. 
The VIPA CPUs are developed function secure and have the following 
system properties: 
 

Event concerns Effect 
RUN → STOP general BASP (Befehls-Ausgabe-Sperre, i.e. command 

output lock) is set. 
 central digital outputs The outputs are disabled. 
 central analog outputs The Outputs are disabled. 

- Voltage outputs issue 0V 
- Current outputs 0...20mA issue 0mA 
- Current outputs 4...20mA issue 4mA  
If configured also substitute values may be  
issued. 

 decentral outputs Same behavior as the central digital/analog 
outputs. 

 decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at 
disposal. 

STOP → RUN 
res. PowerON 

general First the PII is deleted, then OB 100 is called. After 
the execution of the OB, the BASP is reset and the 
cycle starts with:   
Delete PIO → Read PII → OB 1. 

 decentral inputs The inputs are once be read by the decentralized 
station and the recent values are put at disposal. 

RUN general The program execution happens cyclically and can 
therefore be foreseen:  
Read PII → OB 1 → Write PIO. 

 
PII = Process image inputs 
PIO = Process image outputs 

 

Function 
security 
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Overall reset 
 

During the overall reset the entire user memory (RAM) is erased. Data 
located in the memory card is not affected. 
If you have assigned IP address data to your PROFINET IO controller, 
these remain until there is a new PowerON. 
 
You have 2 options to initiate an overall reset: 
• initiate the overall reset by means of the function selector switch 
• initiate the overall reset by means of the Siemens SIMATIC Manager 
 

Note! 
You should always issue an overall reset to your CPU before loading an 
application program into your CPU to ensure that all blocks have been 
cleared from the CPU. 
 

Condition 
The operating mode of the CPU is STOP. Place the function selector on the 
CPU in position "STOP" → the STOP-LED is on. 
 
Overall reset 
• Place the function selector in the position MRES and hold it in this 

position for app. 3 seconds. → The STOP-LED changes from blinking to 
permanently on. 

• Place the function selector in the position STOP and switch it to MRES 
and quickly back to STOP within a period of less than 3 seconds.  
→ The STOP-LED blinks (overall reset procedure). 

• The overall reset has been completed when the STOP-LED is on 
permanently. → The STOP-LED is on. 

 
The following figure illustrates the above procedure: 
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Overview 

     

Overall reset by 
means of the 
function selector 
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If there is a project S7PROG.WLD on the MMC, the CPU attempts to 
reload this project from MMC → the MCC LED is on. 
When the reload has been completed the LED expires. The operating 
mode of the CPU will be STOP or RUN, depending on the position of the 
function selector. 
 

Condition 
The operating mode of the CPU must be STOP.  
You may place the CPU in STOP mode by the menu command 
PLC > Operating mode. 
 
Overall reset 
You may request the overall reset by means of the menu command PLC > 
Clean/Reset. 
In the dialog window you may place your CPU in STOP mode and start the 
overall reset if this has not been done as yet. 
The STOP-LED blinks during the overall reset procedure. 
When the STOP-LED is on permanently the overall reset procedure has 
been completed. 
 

If there is a project S7PROG.WLD on the MMC, the CPU attempts to 
reload this project from MMC → the MCC LED is on. 
When the reload has been completed, the LED expires. The operating 
mode of the CPU will be STOP or RUN, depending on the position of the 
function selector. 
 

The following approach deletes the internal RAM of the CPU completely 
and sets it back to the delivery state. 
Please regard that the MPI address is also set back to default 2! 
More information may be found at the part "Factory reset" further below. 
 
 

Automatic reload 

Overall reset by 
means of the 
Siemens SIMATIC 
Manager 

Automatic reload 

Set back to factory 
setting 
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Firmware update 
 

There is the opportunity to execute a firmware update for the CPU and its 
components via MMC. For this an accordingly prepared MMC must be in 
the CPU during the startup. 
So a firmware files can be recognized and assigned with startup, a pkg file 
name is reserved for each updateable component an hardware release, 
which begins with "px" and differs in a number with six digits. 
The pkg file name of every updateable component may be found at a label 
right down the front flap of the module. 
After PowerON and CPU STOP the CPU checks if there is a *.pkg file on 
the MMC. If this firmware version is different to the existing firmware 
version, this is indicated by blinking of the LEDs and the firmware may be 
installed by an update request. 
 

Firmware package
and Version

X2 X3
MPI   PtP

X1

+
-

DC 24V

X5X8

TP

 
 

The latest firmware versions are to be found in the service area at 
www.vipa.com 
 
For example the following files are necessary for the firmware update of the 
CPU 315-4PN33 and its components with hardware release 1: 
• 315-4PN33, Hardware release 1:  Px000175.pkg 
• PROFINET IO controller:   Px000180.pkg 
 
Attention! 
When installing a new firmware you have to be extremely careful. Under 
certain circumstances you may destroy the CPU, for example if the voltage 
supply is interrupted during transfer or if the firmware file is defective. 
In this case, please call the VIPA-Hotline! 
Please regard that the version of the update firmware has to be different 
from the existing firmware otherwise no update is executed. 

Overview 

Latest Firmware at 
www.vipa.com 
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The CPU has an integrated website that monitors information about 
firmware version of the SPEED7 components. The Ethernet PG/OP 
channel provides the access to this web site.  
The CPU has an integrated website that monitors information about 
firmware version of the SPEED7 components. The Ethernet PG/OP 
channel provides the access to this web site. PLC > Assign Ethernet 
Address. 
After that you may access the PG/OP channel with a web browser via the 
IP address of the project engineering. More detailed information is to find in 
the manual at "Access to Ethernet PG/OP channel and website". 
 

• Go to www.vipa.com 
• Click on Service > Download > Firmware. 
• Navigate via System 300S > CPU to your CPU and download the zip file 

to your PC. 
• Extract the zip file and copy the extracted pkg files to your MMC. 
 

Attention! 
With a firmware update an overall reset is automatically executed. If your 
program is only available in the load memory of the CPU it is deleted! Save 
your program before executing a firmware update! After the firmware 
update you should execute a "Set back to factory settings" (see following 
page). 
 

Display the 
Firmware version of 
the SPEED7 system 
via Web Site 

Load firmware and 
transfer it to MMC 

 



Chapter 4   Deployment CPU 315-4PN33 Manual VIPA System 300S SPEED7 

4-30  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

1. Switch the operating mode switch of your CPU in position STOP. 
Turn off the voltage supply. Plug the MMC with the firmware files 
into the CPU. Please take care of the correct plug-in direction of the 
MMC. Turn on the voltage supply. 

2. After a short boot-up time, the alternate blinking of the LEDs SF and 
FC shows that at least a more current firmware file was found on 
the MMC. 

3. You start the transfer of the firmware as soon as you tip the 
operating mode switch downwards to MRES within 10s.  

4. During the update process, the LEDs SF and FC are alternately 
blinking and MCC LED is on. This may last several minutes. 

5. The update is successful finished when the LEDs PW, ST, SF, FC 
and MC are on. If they are blinking fast, an error occurred.  

6. Turn Power OFF and ON. Now it is checked by the CPU, whether 
further current firmware versions are available at the MMC. If so, 
again the LEDs SF and FC flash after a short start-up period. 
Continue with point 3.  
If the LEDs do not flash, the firmware update is ready.  
Now a factory reset should be executed (see next page). After that 
the CPU is ready for duty. 
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Factory reset 
 

With the following proceeding the internal RAM of the CPU is completely 
deleted and the CPU is reset to delivery state. Please note that here also 
the IP address of the Ethernet PG/OP channel is set to 0.0.0.0 and the MPI 
address is reset to the address 2! 
A factory reset may also be executed by the MMC-Cmd FACTORY_ 
RESET. More information may be found at "MMC-Cmd - Auto commands". 
 
1. Switch the CPU to STOP.  
2. Push the operating mode switch down to position MRES for 30s. Here 

the STOP-LED flashes. After a few seconds the stop LED changes to 
static light. Now the STOP LED changes between static light and 
flashing. Starting here count the static light states.  

3. After the 6. static light release the operating mode switch and tip it 
downwards to MRES. Now the RUN LED lights up once. This means 
that the RAM was deleted completely.  

4. For the confirmation of the resetting procedure the LEDs PW, ST, SF, 
FC and MC get ON. If not, the factory reset has failed and only an 
overall reset was executed. In this case you can repeat the procedure. 
A factory reset can only be executed if the stop LED has static light for 
exactly 6 times. 

5. The end of factory reset is shown by static light of the LEDs PW, ST, 
SF, FC and MC. Switch the power supply off and on. 

 
The proceeding is shown in the following Illustration: 
 

RUN

STOP

MRES

PW

RN

ST

SF

FC

MC

PLC

30 Sec.

Tip

CPU in 
STOP

Request factory reset Start factory reset Factory reset
executed

1 3

PW

RN

ST

SF

FC

MC

PLC
PW

RN

ST

SF

FC

MC

PLC

6x RUN

STOP

MRES

RUN

STOP

MRES

Tip

1 Sec.

2 4

PW

RN

ST

SF

FC

MC

PLC
PW

RN

ST

SF

FC

MC

PLC

Power
OFF/ON

Error: Only
overall reset
executed

5

PW

RN

ST

SF

FC

MC

PLC

 
 

Note! 
After the firmware update you always should execute a Factory reset. 

Proceeding 
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Slot for storage media 
 

At the front of the CPU there is a slot for storage media. As external 
storage medium for applications and firmware you may use a multimedia 
card (MMC). 
You can cause the CPU to load a project automatically respectively to 
execute a command file by means of pre-defined file names. 
 

To the following times an access takes place on a storage medium: 
 

• The CPU checks if there is a project S7PROG.WLD. If exists the project 
is automatically loaded. 

• The CPU checks if there is a project PROTECT.WLD with protected 
blocks. If exists the project is automatically loaded. These blocks are 
stored in the CPU until the CPU is reset to factory setting or an empty 
PROTECT.WLD is loaded. 

 
• The CPU checks if there is a project AUTOLOAD.WLD. If exists an 

overall reset is established and the project is automatically loaded. 
• The CPU checks if there is a command file with VIPA_CMD.MMC. If 

exists the command file is loaded and the containing instructions are 
executed. 

• After PowerON and CPU STOP the CPU checks if there is a *.pkg file 
(firmware file). If exists this is indicated by blinking of the LEDs and the 
firmware may be installed by an update request (see "Firmware update). 

 
• If a storage medium is put, which contains a command file 

VIPA_CMD.MMC, the command file is loaded and the containing 
instructions are executed. 

Overview 

Accessing the 
storage medium 

After overall reset 

After PowerON 

Once in STOP 
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Extended know-how protection 
 

Besides the "standard" Know-how protection the SPEED7-CPUs from VIPA 
provide an "extended" know-how protection that serves a secure block 
protection for accesses of 3. persons. 
 
The standard protection from Siemens transfers also protected blocks to 
the PG but their content is not displayed. But with according manipulation 
the Know-how protection is not guaranteed. 
 
The "extended" know-how protection developed by VIPA offers the 
opportunity to store blocks permanently in the CPU.  
At the "extended" protection you transfer the protected blocks into a WLD-
file named protect.wld. By plugging the MMC and following overall reset, 
the blocks in the protect.wld are permanently stored in the CPU.  
You may protect OBs, FBs and FCs. 
When back-reading the protected blocks into the PG, exclusively the block 
header are loaded. The block code that is to be protected remains in the 
CPU and cannot be read. 
 

CPU
Tip

3Sec.

MMC

protect.wld

Blocks

wld file

PC OVERALL_RESET

protected Blocks
are located in the CPU

MMCRN
ST
MR

 

 
Create a new wld-file in your project engineering tool with File > Memory 
Card file > New and rename it to "protect.wld".  
Transfer the according blocks into the file by dragging them with the mouse 
from the project to the file window of protect.wld. 
 

Overview 

Standard protection 

Extended protection 

Protect blocks 
with protect.wld 
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Transfer the file protect.wld to a MMC storage module, plug the MMC into 
the CPU and execute an overall reset with the following approach: 
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The overall reset stores the blocks in protect.wld permanently in the CPU 
protected from accesses of 3. persons. 
 

Protected blocks are overwritten by a new protect.wld. 
Using a PG 3. persons may access protected blocks but only the block 
header is transferred to the PG. The block code that is to be protected 
remains in the CPU and cannot be read. 
 

Protected blocks in the RAM of the CPU may be substituted at any time by 
blocks with the same name. This change remains up to next overall reset. 
Protected blocks may permanently be overwritten only if these are deleted 
at the protect.wld before. 
By transferring an empty protect.wld from the MMC you may delete all 
protected blocks in the CPU.  
  

Due to the fact that reading of a "protected" block from the CPU monitors 
no symbol labels it is convenient to provide the "block covers" for the end 
user.  
For this, create a project out of all protected blocks. Delete all networks in 
the blocks so that these only contain the variable definitions in the 
according symbolism. 
 
 

Transfer 
protect.wld to CPU 
with overall reset 

Protection 
behavior 
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delete protected 
blocks 

Usage of 
protected blocks 
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MMC-Cmd - Auto commands 
 

A command file at a MMC is automatically executed under the following 
conditions: 
• CPU is in STOP and MMC is stuck 
• After each PowerON 
 
The command file is a text file, which consists of a command sequence to 
be stored as vipa_cmd.mmc in the root directory of the MMC. 
The file has to be started by CMD_START as 1. command, followed by the 
desired commands (no other text) and must be finished by CMD_END as 
last command. 
Text after the last command CMD_END e.g. comments is permissible, 
because this is ignored. As soon as the command file is recognized and 
executed each action is stored at the MMC in the log file logfile.txt. In 
addition for each executed command a diagnostics entry may be found in 
the diagnostics buffer.    
 

Please regard the command sequence is to be started with CMD_START 
and ended with CMD_END. 
 

Command Description Diagnostics entry
CMD_START In the first line CMD_START is to be located. 0xE801  
 There is a diagnostic entry if CMD_START is missing   0xE8FE 
WAIT1SECOND Waits ca. 1 second. 0xE803 
WEBPAGE The current web page of the CPU is stored at the MMC 

as "webpage.htm". 
0xE804 

LOAD_PROJECT The function "Overall reset and reload from MMC" is 
executed. The wld file located after the command is 
loaded else "s7prog.wld" is loaded. 

0xE805 

SAVE_PROJECT The recent project (blocks and hardware configuration) 
is stored as "s7prog.wld" at the MMC. 
If the file just exists it is renamed to "s7prog.old". 
If your CPU is password protected so you have to add 
this as parameter. Otherwise there is no project written. 
Example: SAVE_PROJECT password 

0xE806 

FACTORY_RESET Executes "factory reset". 0xE807 
DIAGBUF The current diagnostics buffer of the CPU is stored as 

"diagbuff.txt" at the MMC. 
0xE80B 

SET_NETWORK IP parameters for Ethernet PG/OP channel may be set 
by means of this command. 
The IP parameters are to be given in the order IP 
address, subnet mask and gateway in the format  
x.x.x.x each separated by a comma. 
Enter the IP address if there is no gateway used. 

0xE80E 

CMD_END In the last line CMD_END is to be located. 0xE802 
 

Overview 

Command file 

Commands 
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The structure of a command file is shown in the following. The 
corresponding diagnostics entry is put in parenthesizes. 
 
 
 

CMD_START Marks the start of the command sequence (0xE801) 
LOAD_PROJECT proj.wld Execute an overall reset and load "proj.wld" (0xE805) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WEBPAGE Store web page as "webpage.htm" (0xE804) 
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802) 
... arbitrary  text ... Text after the command CMD_END is not evaluated. 

 
 
 
 

CMD_START Marks the start of the command sequence (0xE801) 
LOAD_PROJECT proj2.wld Execute an overall reset and load "proj2.wld" (0xE805) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WAIT1SECOND Wait ca. 1s (0xE803) 
SET_NETWORK 172.16.129.210,255.255.224.0,172.16.129.210 IP parameter 

(0xE80E) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WEBPAGE Store web page as "webpage.htm" (0xE804) 
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802) 
... arbitrary  text ... Text after the command CMD_END is not evaluated. 

 
 

Note! 
The parameters IP address, subnet mask and gateway may be received 
from the system administrator.  
Enter the IP address if there is no gateway used. 
 
 

Examples 

Example 1 

Example 2 
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VIPA specific diagnostic entries 
 

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC 
Manager. Besides of the standard entries in the diagnostic buffer, the VIPA 
CPUs support some additional specific entries in form of event-IDs. 
The current content of the diagnostics buffer is stored on MMC by means of 
the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd - 
Auto commands". 
 
 
Note! 
Every register of the module information is supported by the VIPA CPUs. 
More information may be found at the online help of the Siemens SIMATIC 
manager. 
 

To monitor the diagnostic entries you choose the option PLC > Module 
Information in the Siemens SIMATIC Manager. Via the register "Diagnostic 
Buffer" you reach the diagnostic window: 
 

Module information

Diagnostic Buffer

Nr.
8
9
10
11
12
13

Time of day
...
...
13:18:11:370
...
...
...

Date
...
...
19.12.2011
...
...
...

Event
...
...
Event-ID: 16# E0CC
...
...
...

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Details:

...

VIPA-ID

... ... ... ...

... ... ... ... ... ...

 
 
The diagnosis is independent from the operating mode of the CPU. You 
may store a max. of 100 diagnostic entries in the CPU. 
The following page shows an overview of the VIPA specific Event-IDs. 
 

Entries in the 
diagnostic buffer 

     

Monitoring the 
diagnostic entries 
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Event-ID Description 
0xE003 Error at access to I/O devices  

Zinfo1: I/O address 
Zinfo2: Slot 

0xE004 Multiple parameterization of a I/O address  
Zinfo1: I/O address 
Zinfo2: Slot 

0xE005 Internal error - Please contact the VIPA-Hotline! 
0xE006 Internal error - Please contact the VIPA-Hotline! 
0xE007 Configured in-/output bytes do not fit into I/O area  
0xE008 Internal error - Please contact the VIPA-Hotline! 
0xE009 Error at access to standard back plane bus 
0xE010 Not defined module group at backplane bus recognized 

Zinfo2: Slot 
Zinfo3: Type ID 

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration 
0xE012 Error at parameterization 
0xE013 Error at shift register access to standard bus digital modules 
0xE014 Error at Check_Sys 
0xE015 Error at access to the master 

Zinfo2: Slot of the master (32=page frame master) 
0xE016 Maximum block size at master transfer exceeded  

Zinfo1: I/O address  
Zinfo2: Slot 

0xE017 Error at access to integrated slave 
0xE018 Error at mapping of the master periphery 
0xE019 Error at standard back plane bus system recognition 
0xE01A Error at recognition of the operating mode (8 / 9 Bit) 
0xE01B Error - maximum number of plug-in modules exceeded 
0xE020 Error - interrupt information is not defined 
0xE030 Error of the standard bus 
0xE033 Internal error - Please contact the VIPA-Hotline! 
0xE0B0 SPEED7 is not stoppable (probably undefined BCD value at timer) 
0xE0C0 Not enough space in work memory for storing code block (block size exceeded) 
0xE0CC Communication error MPI / Serial 

Zinfo1: Code 
1: Wrong Priority 
2: Buffer overflow 
3: Frame format error 
7: Incorrect value 
8: Incorrect RetVal 
9: Incorrect SAP 
10: Incorrect connection type 
11: Incorrect sequence number 
12: Faulty block number in the telegram 
13: Faulty block type in the telegram 
14: Inactive function 
15: Incorrect size in the telegram 
20: Error writing to MMC 
90: Incorrect Buffer size 
98: Unknown error 
99: Internal error 

Overview of the 
Event-IDs 
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Event-ID Description 
0xE0CD Error at DPV1 job management 
0xE0CE Error: Timeout at sending of the i-slave diagnostics 

  
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC error at saving 
0xE200 MMC writing finished (Copy Ram2Rom) 
0xE210 MMC reading finished (reload after overall reset) 
0xE21F MMC reading: error at reload (after overall reset), read error, out of memory 

  
0xE300 Internal flash writing finished (Copy Ram2Rom) 
0xE310 Internal flash writing finished (reload after battery failure) 

  
0xE400 Memory expansion MCC has been plugged  
0xE401 Memory expansion MCC has been removed 

  
0xE801 MMC-Cmd: CMD_START recognized and successfully executed 
0xE802 MMC-Cmd: CMD_END recognized and successfully executed 
0xE803 MMC-Cmd: WAIT1SECOND recognized and successfully executed 
0xE804 MMC-Cmd: WEBPAGE recognized and successfully executed 
0xE805 MMC-Cmd: LOAD_PROJECT recognized and successfully executed 
0xE806 MMC-Cmd: SAVE_ PROJECT recognized and successfully executed 
0xE807 MMC-Cmd: FACTORY_RESET recognized and successfully executed 
0xE80B MMC-Cmd: DIAGBUF recognized and successfully executed 
0xE80E MMC-Cmd: SET_NETWORK recognized and successfully executed 
0xE8FB MMC-Cmd: Error: Initialization error of the Ethernet-PG/OP channel by means of  

 SET_NETWORK. 
0xE8FC MMC-Cmd: Error: Some IP parameters are missing in SET_NETWORK. 
0xE8FE MMC-Cmd: Error: CMD_START is missing 
0xE8FF MMC-Cmd: Error: Error while reading CMD file (MMC error) 

  
0xE901 Check sum error 

  
0xEA00 Internal error - Please contact the VIPA-Hotline! 
0xEA01 Internal error - Please contact the VIPA-Hotline! 
0xEA02 SBUS: Internal error (internal plugged sub module not recognized) 

Zinfo1: Internal slot 
0xEA03 SBUS: Communication error CPU - PROFINET-IO-Controller  

Zinfo1: Slot 
Zinfo2: Status (0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN) 

0xEA04 SBUS: Multiple parameterization of a I/O address 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA05 Internal error - Please contact the VIPA-Hotline! 
0xEA07 Internal error - Please contact the VIPA-Hotline! 
0xEA08 SBUS: Parameterized input data width unequal to plugged input data width 

Zinfo1: Parameterized input data width 
Zinfo2: Slot 
Zinfo3: Input data width of the plugged module 
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Event-ID Description 
0xEA09 SBUS: Parameterized output data width unequal to plugged output data width 

Zinfo1: Parameterized output data width 
Zinfo2: Slot 
Zinfo3: Output data width of the plugged module 

0xEA10 SBUS: Input address outside input area 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA11 SBUS: Output address outside output area 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA12 SBUS: Error at writing record set 
Zinfo1: Slot 
Zinfo2: Record set number 
Zinfo3: Record set length 

0xEA14 SBUS: Multiple parameterization of a I/O address (Diagnostic address) 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA15 Internal error - Please contact the VIPA-Hotline! 
0xEA18 SBUS: Error at mapping of the master I/O devices 

Zinfo2: Master slot 
0xEA19 Internal error - Please contact the VIPA-Hotline! 
0xEA20 Error - RS485 interface is not set to PROFIBUS DP master but there is a 

PROFIBUS DP master configured.  
0xEA21 Error - Project engineering RS485 interface X2/X3: 

PROFIBUS DP master is configured but missing 
Zinfo2: Interface x 

0xEA22 Error - RS485 interface X2 - value is out of range 
Zinfo: Configured value X2 

0xEA23 Error - RS485 interface X3 - value is out of range 
Zinfo: Configured value X3 

0xEA24 Error - Project engineering RS485 interface X2/X3: 
Interface/Protocol is missing, the default settings are used. 
Zinfo2: Configured value X2 
Zinfo3: Configured value X3 

  
0xEA30 Internal error - Please contact the VIPA-Hotline! 
0xEA40 Internal error - Please contact the VIPA-Hotline! 
0xEA41 Internal error - Please contact the VIPA-Hotline! 

  
0xEA50 Error - PROFINET configuration 

Zinfo1: User slot of the PROFINET IO controller 
Zinfo2: IO device number  
Zinfo3: IO device slot 

0xEA51 Error - there is no PROFINET IO controller at the configured slot 
Zinfo1: User slot of the PROFINET IO controller 
Zinfo2: Recognized ID at the configured slot  

0xEA54 Error - PROFINET IO controller reports multiple configuration at one peripheral addr. 
Zinfo1: Peripheral address 
Zinfo2: User slot of the PROFINET IO controller 
Zinfo3: Data width 
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Event-ID Description 
0xEA64 PROFINET configuration error: 

Zinfo1: error word 
Bit  0: too many IO devices 
Bit  1: too many IO devices per ms  
Bit  2: too many input bytes per ms 
Bit  3: too many output bytes per ms 
Bit  4: too many input bytes per device 
Bit  5: too many output bytes per device 
Bit  6: too many productive connections  
Bit  7: too many input bytes in the process image 
Bit  8: too many output bytes in the process image 
Bit  9: Configuration not available 
Bit 10: Configuration not valid 

0xEA65 Communication error CPU - PROFINET-IO-Controller  
Pk : CPU or PROFINET-IO-Controller  
Zinfo1: Service ID, with which the error arose 
Zinfo2: Command, with which the error arose 

0xEA66 Internal error - Please contact the VIPA-Hotline! 
0xEA67 Error - PROFINET-IO-Controller - reading record set  

Pk: Error type 
0: DATA_RECORD_ERROR_LOCAL 
1: DATA_RECORD_ERROR_STACK  
2: DATA_RECORD_ERROR_REMOTE 
OBNr: PROFINET-IO-Controller slot 
DatId: Device no. 
Zinfo1: Record set number 
Zinfo2: Record set handle  
Zinfo3: Internal error code for service purposes 

0xEA68 Error - PROFINET-IO-Controller - writing record set  
Pk: Error type 
0: DATA_RECORD_ERROR_LOCAL 
1: DATA_RECORD_ERROR_STACK  
2: DATA_RECORD_ERROR_REMOTE 
OBNr: PROFINET-IO-Controller slot 
DatId: Device no. 
Zinfo1: Record set number 
Zinfo2: Record set handle  
Zinfo3: Internal error code for service purposes 

  
0xEA97 Storage error SBUS service channel 

Zinfo3 = Slot 
0xEA98 Timeout at waiting for reboot of a SBUS module (Server)  
0xEA99 Error at file reading via SBUS 
0xEE00 Additional information at UNDEF_OPCODE 
0xEEEE CPU was completely overall reset, since after PowerON the start-up could not be 

finished. 
0xEFFF Internal error - Please contact the VIPA-Hotline! 
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Using test functions for control and monitoring of variables 
 

For troubleshooting purposes and to display the status of certain variables 
you can access certain test functions via the menu item Debug of the 
Siemens SIMATIC Manager. 
The status of the operands and the VKE can be displayed by means of the 
test function Debug > Monitor. 
You can modify and/or display the status of variables by means of the test 
function PLC > Monitor/Modify Variables. 
 

This test function displays the current status and the VKE of the different 
operands while the program is being executed.   
It is also possible to enter corrections to the program. 
 

Note! 
When using the test function “Monitor” the PLC must be in RUN mode! 
 

The processing of the states may be interrupted by means of jump 
commands or by timer and process-related alarms. At the breakpoint the 
CPU stops collecting data for the status display and instead of the required 
data it only provides the PG with data containing the value 0. 
For this reason, jumps or time and process alarms can result in the value 
displayed during program execution remaining at 0 for the items below: 
 
• the result of the logical operation VKE 
• Status / AKKU 1 
• AKKU 2 
• Condition byte 
• absolute memory address SAZ. In this case SAZ is followed by a "?". 
 
The interruption of the processing of statuses does not change the 
execution of the program. It only shows that the data displayed is no longer. 

Overview 

Debug > Monitor 
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This test function returns the condition of a selected operand (inputs, 
outputs, flags, data word, counters or timers) at the end of program-
execution.   
This information is obtained from the process image of the selected 
operands. During the "processing check" or in operating mode STOP the 
periphery is read directly from the inputs. Otherwise only the process image 
of the selected operands is displayed. 
 
Control of outputs 
It is possible to check the wiring and proper operation of output-modules.   
You can set outputs to any desired status with or without a control program. 
The process image is not modified but outputs are no longer inhibited. 
 
Control of variables 
The following variables may be modified: 
I, Q, M, T, C and D. 
The process image of binary and digital operands is modified independently 
of the operating mode of the CPU.    
When the operating mode is RUN the program is executed with the 
modified process variable. When the program continues they may, 
however, be modified again without notification. 
Process variables are controlled asynchronously to the execution sequence 
of the program. 
 
 
 

PLC > 
Monitor/Modify 
Variables 
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Chapter 5  Deployment PtP communication 
 

Content of this chapter is the deployment of the RS485 interface for serial 
PtP communication.  
Here you’ll find every information about the protocols, the activation and 
project engineering of the interface, which are necessary for the serial 
communication using the RS485 interface. 
 

 

Topic     Page 
Chapter 5 Deployment PtP communication ................................... 5-1 

Fast introduction................................................................................... 5-2 
Principle of the data transfer ................................................................ 5-3 
Deployment of RS485 interface for PtP................................................ 5-4 
Parameterization .................................................................................. 5-5 
Communication .................................................................................... 5-8 
Protocols and procedures .................................................................. 5-14 
Modbus - Function codes ................................................................... 5-18 
Modbus - Example communication..................................................... 5-22 

 

 

Overview 

Content 
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Fast introduction 
 

 
With this CPU the integrated RS485 interface is fix set to PtP (point-to-
point) communication. 
For operation there is no further configuration in the hardware configurator 
required 
The RS485 interface supports in PtP operation the serial process 
connection to different source res. destination systems.  
 

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus 
are supported. 
 

The parameterization of the serial interface happens during runtime using 
the SFC 216 (SER_CFG). For this you have to store the parameters in a 
DB for all protocols except ASCII.  
 

The SFCs are controlling the communication. Send takes place via  
SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).  
The repeated call of the SFC 217 SER_SND delivers a return value for 
3964R, USS and Modbus via RetVal that contains, among other things, 
recent information about the acknowledgement of the partner station. 
The protocols USS and Modbus allow to evaluate the receipt telegram by 
calling the SFC 218 SER_RCV after SER_SND. 
The SFCs are included in the consignment of the CPU. 
 

The following SFCs are used for the serial communication: 
 

SFC Description 
SFC 216 SER_CFG RS485 parameterize 
SFC 217 SER_SND RS485 send  
SFC 218 SER_RCV RS485 receive 

 
 

General 

Protocols 

Parameterization 

Communication 

Overview SFCs  
for serial 
communication 
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Principle of the data transfer 
 

The data transfer is handled during runtime by using SFCs. The principle of 
data transfer is the same for all protocols and is shortly illustrated in the 
following. 
 

Data, which are written into the according data channel by the PLC, is 
stored in a FIFO send buffer (first in first out) with a size of 2x1024byte 
and then put out via the interface. 
When the interface receives data, this is stored in a FIFO receive buffer 
with a size of 2x1024byte and can there be read by the PLC. 
If the data is transferred via a protocol, the adoption of the data to the 
according protocol happens automatically. 
In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus 
require the acknowledgement of the partner. 
An additional call of the SFC 217 SER_SND causes a return value in 
RetVal that includes among others recent information about the 
acknowledgement of the partner. 
Further on for USS and Modbus after a SER_SND the acknowledgement 
telegram must be evaluated by call of the SFC 218 SER_RCV. 
 

Protocol FIFO Buffer

1024Byte

1024Byte

1024Byte

1024Byte

IN

OUT

RS485

InterfaceProgram

SER_RCV
SFC 218

CFG

RECEIVE

SEND
SER_SND
SFC 217

SER_CFG
SFC 216

RS485 PtP communication

 
 

 

Overview 

Principle 
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Deployment of RS485 interface for PtP 
 

 

• Logical states represented by voltage differences between the two cores 
of a twisted pair cable 

• Serial bus connection in two-wire technology using half duplex mode 
• Data communications up to a max. distance of 500m 
• Data communication rate up to 115.2kbaud 
 

9polige SubD-Buchse 
Pin RS485 
1 n.c. 
2 M24V 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 P24V 
8 RxD/TxD-N (Line A) 

 

5

4

3

2

1

9

8

7

6

 9 n.c. 
 
 

RxD/TxD-P (B)

RxD/TxD-N (A)

shield

CPU - RS485 Periphery

3

8

Periphery

Periphery

RxD/TxD-P (B)

RxD/TxD-N (A)

RxD/TxD-P (B)

RxD/TxD-N (A)

RxD/TxD-P (B)

RxD/TxD-N (A)

 
 
 

Properties RS485 

Connection 
RS485 

Connection 
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Parameterization 
 

The parameterization happens during runtime deploying the SFC 216 
(SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS 
and Modbus in a DB. 
 

Name Declaration Type Comment 
Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R 
Parameter IN ANY Pointer to protocol parameters 
Baudrate IN BYTE Velocity of data transfer 
CharLen IN BYTE 0=5bit, 1=6bit, 2=7bit, 3=8bit 
Parity IN BYTE 0=None, 1=Odd, 2=Even 
StopBits IN BYTE 1=1bit, 2=1.5bit, 3=2bit 
FlowControl IN BYTE 1 (fix) 
RetVal OUT WORD Error Code ( 0 = OK ) 

 

All time settings for timeouts must be set as hexadecimal value. Find the 
Hex value by multiply the wanted time in seconds with the baudrate. 
 
Example: Wanted time 8ms at a baudrate of 19200baud 
   Calculation: 19200bit/s x 0.008s ≈ 154bit → (9Ah)  
   Hex value is 9Ah. 
 

Here you fix the protocol to be used. You may choose between: 
1: ASCII 
2: STX/ETX 
3: 3964R 
4: USS Master 
5: Modbus RTU Master 
6: Modbus ASCII Master 
 

SFC 216 
(SER_CFG) 

Parameter 
description 

Protocol 
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At ASCII protocol, this parameter is ignored. 
At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the 
communication parameters and has the following structure for the 
according protocols: 
 
Data block at STX/ETX 
DBB0: STX1 BYTE (1. Start-ID in hexadecimal)   
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)   
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)   
DBB3: ETX2 BYTE (2. End-ID in hexadecimal) 
DBW4: TIMEOUT    WORD (max. delay time between 2 telegrams)  
 

Note! 
The start res. end sign should always be a value <20, otherwise the sign is 
ignored! 
 
Data block at 3964R 
DBB0: Prio BYTE (The priority of both partners must be 
    different)   
DBB1: ConnAttmptNr BYTE (Number of connection trials)   
DBB2: SendAttmptNr BYTE (Number of telegram retries)   
DBW4: CharTimeout WORD (Character delay time) 
DBW6: ConfTimeout WORD (Acknowledgement delay time)  
 
Data block at USS 
DBW0: Timeout WORD (Delay time in)  
 
Data block at Modbus-Master 
DBW0: Timeout WORD (Respond delay time)  
 

Velocity of data transfer in bit/s (baud).  
04h: 1200baud 05h: 1800baud 06h: 2400baud 07h: 4800baud 
08h: 7200baud 09h: 9600baud 0Ah: 14400baud 0Bh: 19200baud
0Ch: 38400baud 0Dh: 57600baud 0Eh: 115200baud  
 

Number of data bits where a character is mapped to. 
0: 5bit 1: 6bit 2: 7bit 3: 8bit 
 

Parameter (as DB) 

     

Baud rate 

CharLen 
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The parity is -depending on the value- even or odd. For parity control, the 
information bits are extended with the parity bit that amends via its value 
("0" or "1") the value of all bits to a defined status. If no parity is set, the 
parity bit is set to "1", but not evaluated. 
0: NONE 1: ODD 2: EVEN 
 

The stop bits are set at the end of each transferred character and mark the 
end of a character.  
1: 1bit 2: 1.5bit 3: 2bit 
 

The parameter FlowControl is ignored. When sending RTS=1, when 
receiving RTS=0. 
 

Return values sent by the block: 
 

Error code Description 
0000h no error 
809Ah Interface is not available or  

interface is used for PROFIBUS 
8x24h Error at SFC-Parameter x, with x: 

1: Error at "Protocol" 
2: Error at "Parameter" 
3: Error at "Baudrate"  
4: Error at "CharLength"  
5: Error at "Parity"  
6: Error at "StopBits"  
7: Error at "FlowControl"  

809xh Error in SFC parameter value x, where x: 
1: Error at "Protocol" 
3: Error at "Baudrate"  
4: Error at "CharLength"  
5: Error at "Parity"  
6: Error at "StopBits"  
7: Error at "FlowControl"  

8092h Access error in parameter DB (DB too short) 
828xh Error in parameter x of DB parameter, where x: 

1: Error 1. parameter 
2: Error 2. parameter 
... 

 
 

Parity 

StopBits 

FlowControl 

RetVal SFC 216 
(Error message 
SER_CFG) 
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Communication 
 

The communication happens via the send and receive blocks SFC 217 
(SER_SND) and SFC 218 (SER_RCV).  
The SFCs are included in the consignment of the CPU. 
 

This block sends data via the serial interface. 
The repeated call of the SFC 217 SER_SND delivers a return value for 
3964R, USS and Modbus via RetVal that contains, among other things, 
recent information about the acknowledgement of the partner station. 
The protocols USS and Modbus require to evaluate the receipt telegram by 
calling the SFC 218 SER_RCV after SER_SND. 
 

 
Name Declaration Type Comment 
DataPtr IN ANY Pointer to Data Buffer for sending data 
DataLen OUT WORD Length of data sent 
RetVal OUT WORD Error Code ( 0 = OK ) 

 

Here you define a range of the type Pointer for the send buffer where the 
data that has to be sent is stored. You have to set type, start and length. 
Example: Data is stored in DB5 starting at 0.0 with a length of  
   124byte. 
   DataPtr:=P#DB5.DBX0.0 BYTE 124  
 

Word where the number of the sent bytes is stored. 
At ASCII if data were sent by means of SFC 217 faster to the serial 
interface than the interface sends, the length of data to send could differ 
from the DataLen due to a buffer overflow. This should be considered by 
the user program. 
With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr 
is stored or 0. 
 

Overview 

SFC 217 
(SER_SND)  

Parameter 

DataPtr  

DataLen  
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Return values of the block: 
 

Error code Description 
0000h Send data - ready 
1000h Nothing sent (data length 0) 
20xxh Protocol executed error free with xx bit pattern for 

diagnosis 
7001h Data is stored in internal buffer - active (busy) 
7002h Transfer - active 
80xxh Protocol executed with errors with xx bit pattern for 

diagnosis (no acknowledgement by partner) 
90xxh Protocol not executed with xx bit pattern for diagnosis (no 

acknowledgement by partner) 
8x24h Error in SFC parameter x, where x: 

1: Error in "DataPtr" 
2: Error in "DataLen"  

8122h Error in parameter "DataPtr" (e.g. DB too short) 
807Fh Internal error 
809Ah Interface not found or interface is used for PROFIBUS 
809Bh Interface not configured 

 
 
ASCII 

Value Description 
9000h Buffer overflow (no data send) 
9002h Data too short (0byte) 

 
STX/ETX 

Value Description 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024byte) 
9002h Data too short (0byte) 
9004h Character not allowed 

 
3964R 

Value Description 
2000h Send ready without error 
80FFh NAK received - error in communication 
80FEh Data transfer without acknowledgement of partner or error 

at acknowledgement 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024byte) 
9002h Data too short (0byte) 

 
 

RetVal SFC 217 
(Error message 
SER_SND) 

Protocol specific 
RetVal values 
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USS 
Error code Description 

2000h Send ready without error 
8080h Receive buffer overflow (no space for receipt) 
8090h Acknowledgement delay time exceeded 
80F0h Wrong checksum in respond 
80FEh Wrong start sign in respond 
80FFh Wrong slave address in respond 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024byte) 
9002h Data too short (<2byte) 

 
Modbus RTU/ASCII Master 

Error code Description 
2000h Send ready without error 
2001h Send ready with error 
8080h Receive buffer overflow (no space for receipt) 
8090h Acknowledgement delay time exceeded 
80F0h Wrong checksum in respond 
80FDh Length of respond too long 
80FEh Wrong function code in respond 
80FFh Wrong slave address in respond 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024byte) 
9002h Data too short (<2byte) 

 
 

... Continue  
RetVal SFC 217 
SER_SND 
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The following text shortly illustrates the structure of programming a send 
command for the different protocols. 
 
 

3964R       USS / Modbus 
 

SFC 217
SER_SND

Busy ?

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

N

Error evaluation

End

J

J

J

Data evaluation

End

N

J

SFC 217
SER_SND

Busy ?

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

N

SFC 218
SER_RCV

Error evaluation

End

J

J

J

SFC 218 
SER_RCV

Data evaluation

End

N

J

 
 
ASCII / STX/ETX 
 

SFC 217
SER_SND

RetVal 900xh

Error evaluation

End

J

N

 
 

Principles of 
programming 
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This block receives data via the serial interface.  
Using the SFC 218 SER_RCV after SER_SND with the protocols USS and 
Modbus the acknowledgement telegram can be read. 
 

 
Name Declaration Type Comment 
DataPtr IN ANY Pointer to Data Buffer for received data 
DataLen OUT WORD Length of received data 
Error OUT WORD Error Number 
RetVal OUT WORD Error Code ( 0 = OK ) 

 
Here you set a range of the type Pointer for the receive buffer where the 
reception data is stored. You have to set type, start and length. 
Example: Data is stored in DB5 starting at 0.0 with a length of 124byte. 
  DataPtr:=P#DB5.DBX0.0 BYTE 124  
 
Word where the number of received Bytes is stored. 
At STX/ETX and 3964R, the length of the received user data or 0 is 
entered. 
At ASCII, the number of read characters is entered. This value may be 
different from the read telegram length.  
 
This word gets an entry in case of an error. The following error messages 
may be created depending on the protocol: 
ASCII  
Bit Error Description 
0 overrun Overflow, a sign couldn’t be read fast enough from the 

interface 
1 framing error Error that shows that a defined bit frame is not 

coincident, exceeds the allowed length or contains an 
additional Bit sequence (Stopbit error) 

2 parity Parity error 
3 overflow Buffer is full 

 
STX/ETX  
Bit Error Description 
0 overflow The received telegram exceeds the size of the receive 

buffer. 
1 char A sign outside the range 20h...7Fh has been received.
3 overflow Buffer is full 

 
3964R / Modbus RTU/ASCII Master 

SFC 218 
(SER_RCV)  

Parameter 

DataPtr  

DataLen  

Error 

Bit Error Description 
0 overflow The received telegram exceeds the size of the receive 

buffer. 
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Return values of the block: 
 

Error code Description 
0000h no error 
1000h Receive buffer too small (data loss) 
8x24h Error at SFC-Parameter x, with x: 

1: Error at "DataPtr" 
2: Error at "DataLen"  
3: Error at "Error" 

8122h Error in parameter "DataPtr" (e.g. DB too short) 
809Ah Serial interface not found res. interface is used by 

PROFIBUS 
809Bh Serial interface not configured 

 

The following picture shows the basic structure for programming a receive 
command. This structure can be used for all protocols. 
 

SFC 218
SER_RCV

RetVal 0000h ?

RetVal 8xxxh ?

N Data evaluation

End

J

Error evaluation

End

N

J

 
 
 
 

RetVal SFC 218 
(Error message 
SER_RCV) 

Principles of 
programming 



Chapter 5   Deployment PtP communication Manual VIPA System 300S SPEED7 

5-14  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

Protocols and procedures  
 

The CPU supports the following protocols and procedures: 
• ASCII communication 
• STX/ETX 
• 3964R 
• USS 
• Modbus 
 

ASCII data communication is one of the simple forms of data exchange.  
Incoming characters are transferred 1 to 1. 
At ASCII, with every cycle the read-SFC is used to store the data that is in 
the buffer at request time in a parameterized receive data block. If a 
telegram is spread over various cycles, the data is overwritten. There is no 
reception acknowledgement. The communication procedure has to be 
controlled by the concerning user application. An according Receive_ASCII 
FB may be found within the VIPA library in the service area of www.vipa.com. 
 

STX/ETX is a simple protocol with start and end ID, where STX stands for 
Start of Text and ETX for End of Text.   
The STX/ETX procedure is suitable for the transfer of ASCII characters. It 
does not use block checks (BCC). Any data transferred from the periphery 
must be preceded by a Start followed by the data characters and the end 
character.  
Depending of the byte width the following ASCII characters can be 
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh. 
The effective data, which includes all the characters between Start and End 
are transferred to the PLC when the End has been received. 
When data is send from the PLC to a peripheral device, any user data is 
handed to the SFC 217 (SER_SND) and is transferred with added Start- 
and End-ID to the communication partner. 
Message structure: 

STX2 Z1 Z2 Zn ETX1 ETX2

ZVZ

STX1

 
You may define up to 2 Start- and End-IDs.  
You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start- 
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters 
above 1Fh are ignored. In the user data, characters below 20h are not 
allowed and may cause errors. The number of Start- and End-IDs may be 
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not 
used start and end characters you have to enter FFh in the hardware 
configuration. If no End-ID is defined, all read characters are transferred to 
the PLC after a parameterizable character delay time (Timeout).  

Overview 

ASCII 

STX/ETX 
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The 3964R procedure controls the data transfer of a point-to-point link 
between the CPU and a communication partner. The procedure adds 
control characters to the message data during data transfer. These control 
characters may be used by the communication partner to verify the 
complete and error free receipt. 
The procedure employs the following control characters: 
 
• STX Start of Text 
• DLE  Data Link Escape 
• ETX End of Text 
• BCC  Block Check Character  
• NAK  Negative Acknowledge  
 
 

STX

DLE
Message-data

DLE

ETX

BCC

Monitor delayed acknowledgment
DLE

 Monitor delayed acknowledgment

Active partner Passive partner

 
 
You may transfer a maximum of 255byte per message. 
 

Note! 
When a DLE is transferred as part of the information it is repeated to 
distinguish between data characters and DLE control characters that are 
used to establish and to terminate the connection (DLE duplication). The 
DLE duplication is reversed in the receiving station. 
The 3964R procedure requires that a lower priority is assigned to the 
communication partner. When communication partners issue simultaneous 
send commands, the station with the lower priority will delay its send 
command. 

3964R 

Procedure 
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The USS protocol (Universelle serielle Schnittstelle = universal serial 
interface) is a serial transfer protocol defined by Siemens for the drive and 
system components. This allows to build-up a serial bus connection 
between a superordinated master and several slave systems. 
The USS protocol enables a time cyclic telegram traffic by presetting a fix 
telegram length. 
 
The following features characterize the USS protocol: 
 
• Multi point connection 
• Master-Slave access procedure 
• Single-Master-System 
• Max. 32 participants 
• Simple and secure telegram frame 
 
You may connect 1 master and max. 31 slaves at the bus where the single 
slaves are addressed by the master via an address sign in the telegram. 
The communication happens exclusively in half-duplex operation. 
After a send command, the acknowledgement telegram must be read by a 
call of the SFC 218 SER_RCV. 
 
The telegrams for send and receive have the following structure: 
 
Master-Slave telegram 
STX LGE ADR PKE IND PWE STW HSW BCC
02h   H L H L H L H L H L  
  
Slave-Master telegram 
STX LGE ADR PKE IND PWE ZSW HIW BCC
02h   H L H L H L H L H L  
  
where STX:  Start sign   STW: Control word 
 LGE: Telegram length  ZSW: State word 
 ADR: Address   HSW: Main set value 
 PKE: Parameter ID   HIW: Main effective value 
 IND: Index    BCC: Block Check Character 
 PWE: Parameter value 
 

Broadcast with set bit 5 
in ADR-Byte 

01234567

Broadcast

1

 
 

A request can be directed to a certain slave ore be send to all slaves as 
broadcast message. For the identification of a broadcast message you 
have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit 0 ... 4) is 
ignored. In opposite to a "normal" send command, the broadcast does not 
require a telegram evaluation via SFC 218 SER_RCV. Only write 
commands may be sent as broadcast. 
 
 
 

USS 
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The Modbus protocol is a communication protocol that fixes a hierarchic 
structure with one master and several slaves. 
Physically, Modbus works with a serial half-duplex connection. 
There are no bus conflicts occurring, because the master can only 
communicate with one slave at a time. After a request from the master, this 
waits for a preset delay time for an answer of the slave. During the delay 
time, communication with other slaves is not possible. 
After a send command, the acknowledgement telegram must be read by a 
call of the SFC 218 SER_RCV. 
 
The request telegrams send by the master and the respond telegrams of a 
slave have the following structure: 
 
Start 
sign 

Slave 
address 

Function 
Code 

Data Flow 
control 

End 
sign 

 

A request can be directed to a special slave or at all slaves as broadcast 
message. To mark a broadcast message, the slave address 0 is used. 
In opposite to a "normal" send command, the broadcast does not require a 
telegram evaluation via SFC 218 SER_RCV. 
Only write commands may be sent as broadcast. 
 
Modbus offers 2 different transfer modes: 
• ASCII mode: Every byte is transferred in the 2 sign ASCII code. The 

data are marked with a start and an end sign. This causes a transparent 
but slow transfer. 

• RTU mode: Every byte is transferred as one character. This enables a 
higher data pass through as the ASCII mode. Instead of start and end 
sign, a time control is used. 

 
The mode selection happens during runtime by using the SFC 216 SER_CFG. 
 
The following Modbus Protocols are supported by the RS485 interface 
• Modbus RTU Master 
• Modbus ASCII Master 
 
 
 

Modbus 

Broadcast with 
slave address = 0 

ASCII, RTU mode 

Supported Modbus 
protocols  
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Modbus - Function codes 
 

Modbus has some naming conventions:  
 

Word =
Register

IN: "Input Register"
OUT: "Holding Register"

Bit =
Coil

IN: "Input Status"
OUT: "Coil Status"

 
 
• Modbus differentiates between bit and word access;  

Bits = "Coils" and Words = "Register". 
• Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-

Status". 
• Word inputs are referred to as "Input-Register" and Word outputs as 

"Holding-Register".  
 

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x 
and 4x.  
0x and 1x gives you access to digital Bit areas and 3x and 4x to analog 
word areas.  
For the CPs from VIPA is not differentiating digital and analog data, the 
following assignment is valid: 
 
0x: Bit area for master output data  
  Access via function code 01h, 05h, 0Fh 
1x: Bit area for master input data 
  Access via function code 02h 
3x: Word area for master input data 
  Access via function code 04h 
4x: Word area for master output data 
  Access via function code 03h, 06h, 10h 
 

3x0001 3x0002 3x0003

1x0001
1x0002
1x0003

IN

1x0022

4x0001 4x0002 4x0003

0x0001
0x0002
0x0003

OUT

0x0022

 
 
A description of the function codes follows below.  

Naming 
convention 

Range definitions 
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With the following Modbus function codes a Modbus master can access a 
Modbus slave: With the following Modbus function codes a Modbus master 
can access a Modbus slave. The description always takes place from the 
point of view of the master: 
 

Code Command Description 
01h Read n Bits  Read n Bits of master output area 0x 
02h Read n Bits  Read n Bits of master input area 1x 
03h Read n Words Read n Words of master output area 4x 
04h Read n Words Read n Words master input area 3x 
05h Write 1 Bit Write 1 Bit to master output area 0x 
06h Write 1 Word Write 1 Word to master output area 4x 
0Fh Write n Bits Write n Bits to master output area 0x 
10h Write n Words Write n Words to master output area 4x 

 

The description always takes place from the point of view of the master. 
Here data, which were sent from master to slave, up to their target are 
designated as "output" data (OUT) and contrary slave data received by the 
master were designated as "input" data (IN). 
 

System 300S - Master
CPU PtP

System 200V - Slave
PtP

read (01h:bit, 03h:word)

CPU

SEND FC0

RECEIVE FC1

OUT

read (02h:bit, 04h:word)

write (05h,0F:bit, 06h10h:word) OUT OUT

Periphery

ININ

OUT

IN

IN

0x(bit)
4x(word)

1x(bit)
3x(wort)

 
 

If the slave announces an error, the function code is send back with an 
"ORed" 80h. Without an error, the function code is sent back.  
 

Slave answer:    Function code OR 80h  → Error 
      Function code  → OK 
 

For the Byte sequence in a Word is always valid:      1 Word 
      High   Low 
      Byte   Byte 
   

The shown check sums CRC at RTU and LRC at ASCII mode are 
automatically added to every telegram. They are not shown in the data 
block. 

Overview 

Point of View of 
"Input" and  
"Output" data 

Respond of the 
slave 

Byte sequence  
in a Word 

Check sum CRC, 
RTU, LRC 
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Code 01h: Read n Bits of master output area 0x 
Code 02h: Read n Bits of master input area 1x 
 

Command telegram 
Slave address Function code Address 

1. Bit 
Number of 

Bits 
Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Number of 

read Bytes 
Data  

1. Byte 
Data 

2. Byte 
 

... 
Check sum 
CRC/LRC 

1Byte 1Byte 1Byte 1Byte 1Byte  1Word 
   max. 250Byte  

 

03h: Read n Words of master output area 4x  
04h: Read n Words master input area 3x 
 

Command telegram 
Slave address Function code Address  

1. Bit 
Number of 

Words 
Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Number of 

read Bytes 
Data 

1. Word 
Data 

2. Word 
 

... 
Check sum 
CRC/LRC 

1Byte 1Byte 1Byte 1Word 1Word  1Word 
   max. 125 Words  

 

Code 05h: Write 1 Bit to master output area 0x 
A status change is via "Status Bit" with following values: 
 

"Status Bit" = 0000h → Bit = 0 
"Status Bit" = FF00h → Bit = 1 

 
Command telegram 

Slave address Function  
code 

Address  
Bit 

Status 
Bit 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 

Slave address Function  
code 

Address 
Bit 

Status 
Bit 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Read n Bits 
01h, 02h 

Read n Words 
03h, 04h 

Write 1 Bit  
05h 
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Code 06h: Write 1 Word to master output area 4x 
  
Command telegram 

Slave address Function 
code 

Address  
word 

Value 
word 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 

Slave address Function 
code 

Address 
word 

Value 
word 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Code 0Fh: Write n Bits to master output area 0x  
Please regard that the number of Bits has additionally to be set in Byte.  
 

Command telegram 
Slave address Function 

code 
Address  

1. Bit 
Number of 

Bits 
Number of

Bytes 
Data 

1. Byte 
Data 

2. Byte 
 

... 
Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word 
     max. 250 Byte  

 
Respond telegram 
Slave address Function 

code 
Address 

1. Bit 
Number of 

Bits 
Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Code 10h: Write n Words to master output area 4x 
 

Command telegram 
Slave address Function 

code 
Address  
1. Word 

Number of 
words 

Number of
Bytes 

Data 
1. Word

Data 
2. Word 

 
... 

Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word 
     max. 125 Words  

 
Respond telegram 
Slave address Function 

code 
Address 
1. Word 

Number of 
Words 

Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
 

 
 
 

Write 1 Word  
06h 

Write n Bits 0Fh 

Write n Words 10h 
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Modbus - Example communication 
 

The example establishes a communication between a master and a slave 
via Modbus. The following combination options are shown: 
 
Modbus master (M) Modbus slave (S) 
CPU 31xS CPU 21xSER-1 
 

The following components are required for this example: 
• CPU 31xS as Modbus RTU master 
• CPU 21xSER-1 as Modbus RTU slave 
• Siemens SIMATIC Manager and possibilities for the project transfer 
• Modbus cable connection 
 

• Assemble a Modbus system consisting of a CPU 31xS as Modbus 
master and a CPU 21xSER-1 as Modbus slave and Modbus cable. 

• Execute the project engineering of the master!  
For this you create a PLC user application with the following structure: 
OB 100: Call SFC 216 (configuration as Modbus RTU master) with 

timeout setting and error evaluation. 
OB 1: Call SFC 217 (SER_SND) where the data is send with error 

evaluation. Here you have to build up the telegram according 
to the Modbus rules. 
Call SFC 218 (SER_RECV) where the data is received with 
error evaluation. 

• Execute the project engineering of the slave!  
The PLC user application at the slave has the following structure: 
OB 100: Call SFC 216 (configuration as Modbus RTU slave) with 

timeout setting and Modbus address in the DB and error 
evaluation. 

OB 1: Call SFC 217 (SER_SND) for data transport from the slave 
CPU to the output buffer. 
Call SFC 218 (SER_RECV) for the data transport from the 
input buffer to the CPU. Allow an according error evaluation 
for both directions.  

 
The following page shows the structure for the according PLC programs for 
master and slave. 

Overview 

Components 

Approach 
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      Master              Slave 
 

      

CPU 31xS
CPU Master

CPU 21xSER-1
Slave CPU

SER_SND

SER_RCV

SER_RCV

RetVal

SER_RCV

SER_SND

code/data

RetVal

SER_SND code

data

RetVal

 
 

SFC 217
SER_SND

(mit Slave-Nr., Code, 
Bereich)

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

Error evaluationJ

J

SFC 218 
SER_RCV

N

J

RetVal 0000h ?

RetVal 8xxxh ?

N

Data evaluation

J

Error evaluation

N

J

Start

SER_SND
RetVal 2001h ?

J

N

Error evaluationJ

SFC 216
SER_CFG

(DB: Timeout)

RetVal 8xxxh ?

OB100:

OB1:
N

SFC 217
SER_SND

RetVal  9001h ? Error evaluationJ

SFC 218 
SER_RCV

N

RetVal 0000h ?

RetVal 8xxxh ?

N

Data evaluation

Error evaluation

N

J

Start

Error evaluationJ

SFC 216
SER_CFG

(DB: Timeout, slave address)

RetVal 8xxxh ?

N

RetVal 0000h ?

N

J

J

N

RetVal 700xh? J
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Chapter 6  Deployment Ethernet com. - productive 
 

In this chapter the deployment of the PROFINET IO controller as Ethernet 
CP for productive connections is described. 
Please regard the chapter "Fast introduction" where you will find every 
information compressed required for the project engineering of the 
PROFINET IO controller as Ethernet CP. After the fast introduction, the 
mentioned steps are described in detail. 
 

 

Topic     Page 
Chapter 6 Deployment Ethernet com. - productive........................ 6-1 

Basics - Industrial Ethernet in automation............................................. 6-2 
Basics - ISO/OSI reference model........................................................ 6-3 
Basics - Terms ..................................................................................... 6-6 
Basics - Protocols................................................................................. 6-7 
Basics - IP address and subnet ............................................................ 6-9 
Fast introduction................................................................................. 6-11 
Commissioning and Initialization ........................................................ 6-12 
Hardware configuration - CPU............................................................ 6-13 
Configure Siemens S7 connections.................................................... 6-14 
Configure Open Communication ........................................................ 6-22 
NCM diagnostic - Help for error diagnostic ......................................... 6-25 

 

Overview 

Content 
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Basics - Industrial Ethernet in automation 
 

The flow of information in a company presents a vast spectrum of 
requirements that must be met by the communication systems. Depending 
on the area of business the bus system or LAN must support a different 
number of users, different volumes of data must be transferred and the 
intervals between transfers may vary, etc. 
It is for this reason that different bus systems are employed depending on 
the respective task. These may be subdivided into different classes. The 
following model depicts the relationship between the different bus systems 
and the hierarchical structures of a company: 
 

Plant
computer
PPS CAD

Plant-oriented
control computer

manufacturing, stock,
production data

PPS CAD

Maschine and control
computer

Peripheral systems maschines CNC, NC,
controllers (PLC), measuring systems

Peripheral components
sensor, actuator, regulator, multiplexer, operating consoles

Operational layer

Management layer

System layer

Prozess layer

Sensor / 
actuator layer

Field bus

Sensor / actuator
Bus

H1

Industrial
Ethernet

PROFINET

 
 

 
 

Industrial Ethernet is an electrical net based on shielded twisted pair 
cabling or optical net based on optical fiber. 
Industrial Ethernet is defined by the international standard IEEE 802.3. The 
net access of Industrial Ethernet corresponds to IEEE 802.3 -  CSMA/CD 
(Carrier Sense Multiple Access/Collision Detection) scheme: every station 
"listens” on the bus cable and receives communication messages that are 
addressed to it.  
Stations will only initiate a transmission when the line is unoccupied. In the 
event that two participants should start transmitting simultaneously, they 
will detect this and stop transmitting to restart after a random delay time 
has expired. 
Using switches there is the possibility for communication without collisions.  

Overview 

Industrial Ethernet 
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Basics - ISO/OSI reference model 
 

The ISO/OSI reference model is based on a proposal that was developed 
by the International Standards Organization (ISO). This represents the first 
step towards an international standard for the different protocols. It is 
referred to as the ISO-OSI layer model. OSI is the abbreviation for Open 
System Interconnection, the communication between open systems. The 
ISO/OSI reference model does not represent a network architecture as it 
does not define the services and protocols used by the different layers. The 
model simply specifies the tasks that the different layers must perform. 
All current communication systems are based on the ISO/OSI reference 
model, which is defined by the ISO 7498 standard. The reference model 
structures communication systems into 7 layers that cover different 
communication tasks. In this manner the complexity of the communication 
between different systems is divided amongst different layers to simplify the 
task. 
The following layers have been defined: 
 

Layer Function 
Layer 7 Application Layer 
Layer 6 Presentation Layer 
Layer 5 Session Layer 
Layer 4 Transport Layer 
Layer 3 Network Layer 
Layer 2 Data Link Layer 
Layer 1 Physical Layer 

 

Depending on the complexity and the requirements of the communication 
mechanisms a communication system may use a subset of these layers.  

Overview 
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Layer 1 Bit communication layer (physical layer) 
The bit communication layer (physical layer) is concerned with the transfer 
of data bits via the communication channel. This layer is therefore 
responsible for the mechanical, electrical and the procedural interfaces and 
the physical communication medium located below the bit communication 
layer: 
• Which voltage represents a logical 0 or a 1? 
• The minimum time the voltage is present to be recognized as a bit. 
• The pin assignment of the respective interface. 
 

Layer 2  Security layer (data link layer) 
This layer performs error-checking functions for bit strings transferred 
between two communicating partners. This includes the recognition and 
correction or flagging of communication errors and flow control functions.  
The security layer (data link layer) converts raw communication data into a 
sequence of frames. This is where frame limits are inserted on the 
transmitting side and where the receiving side detects them. These limits 
consist of special bit patterns that are inserted at the beginning and at the 
end of every frame. The security layer often also incorporates flow control 
and error detection functions.  
The data security layer is divided into two sub-levels, the LLC and the MAC 
level. 
The MAC (Media Access Control) is the lower level and controls how 
senders are sharing a single transmit channel. 
The LLC (Logical Link Control) is the upper level that establishes the 
connection for transferring the data frames from one device into the other. 
 
Layer 3 Network layer 
The network layer is an agency layer. 
Business of this layer is to control the exchange of binary data between 
stations that are not directly connected. It is responsible for the logical 
connections of layer 2 communications. Layer 3 supports the identification 
of the single network addresses and the establishing and disconnecting of 
logical communication channels.  
Additionally, layer 3 manages the prior transfer of data and the error 
processing of data packets. IP (Internet Protocol) is based on Layer 3. 
 
Layer 4 Transport layer 
Layer 4 connects the network structures with the structures of the higher 
levels by dividing the messages of higher layers into segments and passes 
them on to the network layer. Hereby, the transport layer converts the 
transport addresses into network addresses. 
Common transport protocols are: TCP, SPX, NWLink and NetBEUI. 
 

Layers 
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Layer 5 Session layer  
The session layer is also called the communication control layer. It relieves 
the communication between service deliverer and the requestor by 
establishing and holding the connection if the transport system has a short 
time fail out. 
At this layer, logical users may communicate via several connections at the 
same time. If the transport system fails, a new connection is established if 
needed.  
Additionally this layer provides methods for control and synchronization 
tasks.  
 
Layer 6 Presentation layer  
This layer manages the presentation of the messages, when different 
network systems are using different representations of data.  
Layer 6 converts the data into a format that is acceptable for both 
communication partners. 
Here compression/decompression and encrypting/decrypting tasks are 
processed. 
This layer is also called interpreter. A typical use of this layer is the terminal 
emulation.  
 
Layer 7 Application layer  
The application layer is the link between the user application and the 
network. The tasks of the application layer include the network services like 
file, print, message, data base and application services as well as the 
according rules.  
This layer is composed from a series of protocols that are permanently 
expanded following the increasing needs of the user. 
 

Layers 
continued... 
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Basics - Terms 
 

A network res. LAN (Local Area Network) provides a link between different 
stations that enables them to communicate with each other. 
Network stations consist of PCs, IPCs, TCP/IP adapters, etc. 
Network stations are separated by a minimum distance and connected by 
means of a network cable. The combination of network stations and the 
network cable represent a complete segment. 
All the segments of a network form the Ethernet (physics of a network). 
 

In the early days of networking the Triaxial- (yellow cable) or thin Ethernet 
cable (Cheapernet) was used as communication medium. This has been 
superseded by the twisted-pair network cable due to its immunity to 
interference. The CPU has a twisted-pair connector. 
The twisted-pair cable consists of 8 cores that are twisted together in pairs. 
Due to these twists this system is provides an increased level of immunity 
to electrical interference. For linking please use twisted pair cable which at 
least corresponds to the category 5. 
Where the coaxial Ethernet networks are based on a bus topology the 
twisted-pair network is based on a point-to-point scheme. 
The network that may be established by means of this cable has a star 
topology. Every station is connected to the star coupler (hub/switch) by 
means of a separate cable. The hub/switch provides the interface to the 
Ethernet. 
 

The hub is the central element that is required to implement a twisted-pair 
Ethernet network.   
It is the job of the hub to regenerate and to amplify the signals in both 
directions. At the same time it must have the facility to detect and process 
segment wide collisions and to relay this information. The hub is not 
accessible by means of a separate network address since it is not visible to 
the stations on the network. 
A hub has provisions to interface to Ethernet or to another hub res. switch. 
 

A switch also is a central element for realizing Ethernet on Twisted Pair. 
Several stations res. hubs are connected via a switch. Afterwards they are 
able to communicate with each other via the switch without interfering the 
network. An intelligent hardware analyzes the incoming telegrams of every 
port of the switch and passes them collision free on to the destination 
stations of the switch. A switch optimizes the bandwidth in every connected 
segment of a network. Switches enable exclusive connections between the 
segments of a network changing at request. 
 

Network (LAN) 

Twisted Pair 

Hub (repeater) 

Switch 
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Basics - Protocols 
 

Protocols define a set of instructions or standards that enable computer to 
establish communication connections and exchange information as error 
free as possible. A commonly established protocol for the standardization 
of the complete computer communication is the so called ISO/OSI layer 
model, a model based upon seven layers with rules for the usage of 
hardware and software (see ISO/OSI reference model above). 
 
The PROFINET IO controller uses the following protocols:  
• Siemens S7 connections 
• Open communication 

- TCP native according to RFC 793 
- ISO on TCP according to RFC 1006 
- UDP according to RFC 768 

 
The protocols are described in the following: 
 

With the Siemens S7 connection large data sets may be transferred 
between PLC systems based on Siemens STEP®7. Here the stations are 
connected via Ethernet. 
Precondition for the Siemens S7 communication is a configured connection 
table, which contains the defined connections for communication. 
Here NetPro from Siemens may be used. 
 

• A communication connection is specified by a connection ID for each 
connection partner. 

• The acknowledgement of the data transfer is established from the 
partner station at level 7 of the ISO/OSI reference model. 

• At the PLC side FB/SFB VIPA handling blocks are necessary for data 
transfer for the Siemens S7 connections.  

 

Note! 
More about the usage of the handling blocks may be found in the manual 
Operation list HB00_OPL_SP7 in chapter "VIPA specific blocks". 
 
 

Overview 

Siemens S7 
connections 

Properties 
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In the open communication the communication takes place via the user 
program by means of handling blocks. These blocks are part of the 
Siemens SIMATIC Manager. You will find these in the "Standard Library" at 
"Communication Blocks".  
 

Connection-oriented protocols establish a (logical) connection to the 
communication partner before data transmission is started. And if 
necessary they terminate the connection after the data transfer was 
finished. 
Connection-oriented protocols are used for data transmission when 
reliable, guaranteed delivery is of particular importance. In general, many 
logical connections can exist on one physical line. 
The following connection-oriented protocols are supported with FBs for 
open communication via Industrial Ethernet: 
 
During data transmission, no information about the length or about the start 
and end of a message is transmitted. However, the receiver has no means 
of detecting where one message ends in the data stream and the next one 
begins. The transfer is stream-oriented. 
For this reason, it is recommended that the data length of the FBs is 
identical for the sending and receiving station. If the number of received 
data does not fit to the preset length you either will get not the whole data, 
or you will get data of the following job. 
 
During data transmission, information on the length and the end of the 
message is also transmitted. 
If you have specified the length of the data to be received greater than the 
length of the data to be sent, the receive block will copy the received data 
completely into the receive range. 
 

There is thus no establishment and termination of a connection with a 
remote partner. Connection-less protocols transmit data with no 
acknowledge and with no reliable guaranteed delivery to the remote 
partner. 
 
In this case, when calling the sending block you have to specify the address 
parameters of the receiver (IP address and port number). During data 
transmission, information on the length and the end of the message is also 
transmitted. 
In order to be able to use the sending and receiving blocks first you have to 
configure the local communications access point at both sides. 
With each new call of the sending block, you re-reference the remote 
partner by specifying its IP address and its port number. 
 

Open 
communication 

Connection-
oriented protocols 

TCP native accord. 
to RFC 793 
 

ISO on TCP accord. 
to RFC 1006 

Connection-less 
protocol 

UDP accord. to 
RFC 768  
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Basics - IP address and subnet 
 

PROFINET exclusively supports IPv4. At IPv4 the IP address is a 32Bit 
address that must be unique within the network and consists of 4 numbers 
that are separated by a dot.  
Every IP address is a combination of a Net-ID and a Host-ID and its 
structure is as follows:  xxx.xxx.xxx.xxx 
Range: 000.000.000.000 to 255.255.255.255  
The network administrator also defines IP addresses.  
 

The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using a bit for bit AND assignment with the Subnet mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet mask 
becomes the Subnet-ID, the rest is the new Host-ID. 

 
Subnet mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet mask and  IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The subnet mask allows you to sort the resources following your needs. 
This means e.g. that every department gets an own subnet and thus does 
not interfere another department. 
 

At the first start-up of the CPU, the Ethernet PG/OP channel and the 
PROFINET IO controller of the CPU do not have an IP address.  
Information about the assignment of IP address data to the Ethernet 
PG/OP channel may be found in chapter "Deployment CPU ..." at 
"Initialization Ethernet PG/OP channel". 
Information about the assignment of IP address data to the PROFINET IO 
controller may be found in this chapter below. 
 
 

IP address 
structure 

Net-ID 
Host-ID 

Subnet mask 

Subnet 

Address at first 
start-up  
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For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4byte = 32bit.  
 
Class A 0 Network-ID 

(1+7bit) 
Host-ID (24bit) 

Class B 10 Network-ID (2+14bit) Host-ID (16bit) 
Class C 110 Network-ID (3+21bit) Host-ID (8bit) 
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the 3 classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
To build up private IP-Networks within the Internet, RFC1597/1918 
reserves the following address areas: 

 
Network 
class 

Start IP End IP Standard subnet mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 
(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
Internet nor are routed in the Internet. 
 

Some Host-IDs are reserved for special purposes. 
 
Host-ID = "0"  Identifier of this network, reserved! 
Host-ID = maximum (binary complete "1") Broadcast address of this network 
 

Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 
 
 

Address classes 

Private IP networks 

Reserved 
Host-Ids 
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Fast introduction 
 

At the first start-up respectively at an over all reset with an PowerON again, 
the Ethernet PG/OP channel and PROFINET IO controller of the CPU do 
not have any IP address. These may only be reached via its MAC address. 
IP address parameters may be assigned to the corresponding component 
by means of the MAC addresses, which may be found on labels beneath 
the front flap with the sequence 1. address PG/OP channel and beneath 
address of the PROFINET IO controller. The assignment takes place 
directly via the hardware configuration of the Siemens SIMATIC manager. 
 

For the configuration of the PROFINET IO controller for productive 
connections please follow the following approach: 
  
• Commissioning and initialization 

(Assignment of IP address data) 
• Hardware configuration - CPU  
• Configure connections 

- Siemens S7 connections 
 (Configuration via Siemens NetPro, communication via VIPA handling 
  blocks) 
- Open communication 
 (Configuration and communication happens by standard handling 
  blocks)  

• Transfer of the complete project to CPU 
Information about transferring a project may be found at chapter 
"Deployment CPU ..." at "Project transfer". 

 
 

To be compatible to the Siemens SIMATIC manager, the CPU 315-4PN33 from VIPA is 
to be configured as  

CPU 315-2PN/DP (6ES7 315-2EH13-0AB0 V2.6) 

 
The PROFINET IO controller is to be configured via the sub module X2 (PN-IO). 
The Ethernet PG/OP channel of the CPU 315-4PN33 is always to be configured as 1. 
module after the really plugged modules at the standard bus as CP343-1 (343-1EX11) 
from Siemens.  
 

 

Overview 

Steps of 
configuration 

Note 
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Commissioning and Initialization 
 

• Install your System 300S with your CPU.  
• Wire the system by connecting cables for voltage supply and signals 
• Connect your PROFINET IO controller with Ethernet. 
• Switch on the power supply.  

→ After a short boot time, the CP is in idle.  
At the first commissioning res. after an overall reset of the CPU, the 
PROFINET IO controller has no IP address.  

 
This function is supported only if the PROFINET IO controller is not yet 
configured.  
You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens SIMATIC 
manager starting with version V 5.3 & SP3 with the following proceeding: 
 
• Start the Siemens SIMATIC manager. 
• Switch to "TCP/IP -> Network card .... " using Options > Set PG/PC 

interface. 
• The dialog for initialization of a station opens by PLC > Edit Ethernet 

Node. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address may be found at the 2. label 
beneath the front flap of the CPU. 

• Choose if necessary the known MAC address of the list of found 
stations. To check this with [Blink] you may cause the MT LED to blink. 

• Either type in the IP configuration like IP address, subnet mask and 
gateway. Or your station is automatically provided with IP parameters by 
means of a DHCP server. Depending of the chosen option the DHCP 
server is to be supplied with MAC address, equipment name or client ID. 
The client ID is a numerical order of max. 63 characters. The following 
characters are allowed: "hyphen", 0-9, a-z, A-Z 

• Confirm with [Assign IP configuration]. 
Directly after the assignment the PROFINET IO controller is online 
reachable using the set IP address data. 
 

Note! 
Since the IP address data, which were assigned here, are deleted at 
PowerOFF, you have to take them to a project by means of the hardware 
configuration, which is described on the next page.   
Information about the initialization of the Ethernet-PG/OP channel may be 
found in chapter "Deployment CPU..." at "Initialization Ethernet PG/OP 
channel". 

Assembly and 
commissioning 

Assign IP address 
parameters 
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Hardware configuration - CPU 
 

The hardware configuration of the VIPA CPU takes place at the Siemens 
hardware configurator. 
The hardware configurator is a part of the Siemens SIMATIC Manager. It 
serves the project engineering. The modules, which may be configured 
here are listed in the hardware catalog. If necessary you have to update the 
hardware catalog with Options > Update Catalog. 
For project engineering a thorough knowledge of the Siemens SIMATIC 
manager and the Siemens hardware configurator are required! 
 

Note! 
Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic 
operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of 
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. 
This may cause conflicts in applications that presume an unmodified 
ACCU2. 
For more information may be found in the manual "VIPA Operation list 
SPEED7" at "Differences between SPEED7 and 300V programming". 
 

To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

Slot
1
2

X1
X2

X2 P1
3

Module

CPU 315-2 PN
MPI/DP
PN-IO
Port 1

 

• Start the Siemens hardware configurator with a new project. 
• Insert a profile rail from the hardware catalog. 
• Place at slot 2 the following CPU from Siemens:  

CPU 315-2EH13 (6ES7 315-2EH13-0AB0 V2.6). 
• The PROFINET-IO Controller is to be configured via the sub module 

X2 (PN-IO). 
 

 

 

Open the property window of the internal PROFINET IO controller via 
double-click on the component PN-IO. 
• At general enter a device name. The device name on the Ethernet 

subnet must be unique. 
• For the PROFINET IO controller enter the IP address, subnet mask and 

gateway and select the wanted subnet. 

Requirements 

     

Proceeding 

Parameterization 
of the IP address 
data for the 
PROFINET IO 
controller 



Chapter 6   Deployment Ethernet com. - productive Manual VIPA System 300S SPEED7 

6-14  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

Configure Siemens S7 connections 
 

The project engineering of connections i.e. the "link-up" between stations 
happens in NetPro from Siemens. NetPro is a graphical user interface for 
the link-up of stations. 
A communication connection enables the program controlled communi-
cation between two participants at the Industrial Ethernet. The communi-
cation partners may here be part of the same project or - at multi projects - 
separated within related part projects. 
Communication connections to partners outside of a project are configured 
via the object "In unknown project" or via deputy objects like "Other 
stations" or Siemens "SIMATIC S5 Station".  
The communication is controlled by the user program with VIPA handling 
blocks. To use this blocks, configured communication connections are 
always necessary in the active station. 
 

The following properties are characterizing a communication connection: 
• One station always executes an active connection establishment. 
• Bi-directional data transfer (Send and receive on one connection) 
• Both participant have equal rights, i.e. every participant may initialize the 

send res. receive process event controlled. 
• Except of the UDP connection, at a communication connection the 

address of the communication partner is set via the project engineering. 
Here the connection is active established by one station. 

 
CP

send

receive

Communication
link

Ethernet partner

receive

send

send

receive

Communication
link

Ethernet partner

receive

send

.

.

.

.

.

.

.

.

.

 
 

• Siemens SIMATIC manager V.5.4 (SP 2) or higher and SIMATIC NET 
are installed. 

• With the hardware configuration the CP was assigned with IP address 
data by the properties of PN-IO. 

 

Overview 

Properties 
communication 
connection 

Requirements 
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Note! 
Every station outside of the recent project must be configured as 
replacement objects like e.g. Siemens "SIMATIC S5" or "other station" or 
with the object  "In unknown project". 
When creating a connection you may also choose the partner type 
"unspecified" and set the required remote parameter directly in the 
connection dialog. 
 

For the project engineering of connections, a thorough knowledge with 
NetPro from Siemens is required! The following passage only describes the 
basic usage of NetPro. More detailed information about NetPro is to be 
found in the according online manual res. documentation. 
Start NetPro by clicking on a "net" in the Siemens SIMATIC manager or on 
"connections" within the CPU. 
 
The environment of NetPro has the following structure: 

1 Graphic net view 
All stations and networks are displayed in a graphic view. By clicking 
on the according component you may access and alter the 
concerning properties.  

2 Net objects 
This area displays all available net objects in a directory view. By 
dragging a wanted object to the net view you may include further net 
objects and open them in the hardware configurator. 

3 Connection table 
The connection table lists all connections in a table. This list is only 
shown when you highlighted a connectable module like e.g. a CPU. 
You may insert new connections into this table with the according 
command. 

 

 

Stations

Subnet

+

+

Profibus-PA

Profibus-DP+

21

MPI

Ethernet

3

CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1
CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1

PROFINET IO

 

     

Work environment 
of NetPro 
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You receive the following graphical display for every PLC station and their 
component. By selecting the single components, the context menu offers 
you several functions: 
 

1 Station 
This includes a PLC station with rack, CPU and communication 
components. Via the context menu you may configure a station 
added from the net objects and its concerning components in 
the hardware configurator. After returning to NetPro, the new 
configured components are shown.  

2 CPU 
A click onto the CPU shows the connection table. The 
connection table shows all connections that are configured for 
the CPU. 

3 Internal communication components 
This displays the communication components that are available 
in your CPU. The PROFINET IO controller is to be configured 
by the PN-IO component. 

CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1

1 2 3 4

1

 

4 Ethernet PG/OP channel 
The internal Ethernet PG/OP channel must always be 
configured as external CP in the hardware configuration. This 
CP only serves the PG/OP communication. You may not 
configure connections. 

 

 

NetPro offers you the option to link-up the communicating stations. You 
may link-up the stations via the properties in the hardware configuration or 
graphically via NetPro. For this you point the mouse on the colored net 
mark of the according CP and drag and drop it to the net you want to link. 
Now the CP is linked up to the wanted net by means of a line. 
 

CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1

Industrial Ethernet

CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1

Industrial Ethernet

 
 

PLC stations 

Link up stations 
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For the project engineering of connections, open the connection list by 
selecting the according CPU. Choose Insert new connection in the context 
menu: 
 

CPU3
PN/DP

MPI/DPPN-IOCP
343-1

Station 1

insert new connection

 
 

A dialog window opens where you may choose the connection partner and 
the connection type.  
 
Each station configured in the Siemens SIMATIC manager is listed in the 
table of connection partner. These stations are unique specified by an IP 
address and a subnet mask. 
 
Here the connection partner may exist in the current project or in an 
unknown project. Connection jobs to an unknown project must be defined 
by an unique connection name, which is to be used in the projects of both 
stations. Due to this allocation the connection remains unspecified. 
 

Note! 
All broadcast stations and All multicast stations are not supported by this 
CPU. 
 

For the PROFINET IO controller exclusively Siemens S7 connection may 
be configured with NetPro. 
 
 

Projecting 
connections 

Connection partner 
(partner station)  

Specified 
connection partner 

Unspecified 
connection partner 

     

Connection types 
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Choose the connection partner and the type of connection and confirm with 
[OK]. 
If activated, a properties dialog for the according connection opens as link 
to your PLC user program. 
At the following pages the relevant parameters of the different connection 
types are shortly described. More information about this may be found in 
the online help of Siemens NetPro. 
 

Insert new connection

In Project

Connections

SIMATIC 300

CPU ...

OK Apply Cancel

Connection partner

Project:        Connections
Sation:         SIMATIC 300
Module:        CPU ... 

Connection

Type:              S7 connection

 
 

After every connection was configured by this way, you may save and 
compile your project and exit NetPro. 

Open the 
properties dialog 

Save and compile 
connections 
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For data transfer with Siemens S7 connections the FB/SFB VIPA handling 
blocks are necessary; the deployment is described in the manual 
"Operation list" of your CPU. 
At Siemens S7 connections the communication connections are specified 
by a connection ID for each communication partner. 
A connection is specified by the local and partner connection end point. A 
link. At Siemens S7 connections the TSAPs must be congruent crosswise. 
The following parameters define a connection end point: 
 

Station A    Station B 
remote TSAP → Siemens → local TSAP 
local TSAP ← S7 connection ← remote TSAP 

ID A    ID B 
 
 
The following table shows the combination options with Siemens S7 
connections with deployment of the FB/SFB VIPA handling blocks. 
The handling blocks are more described in the manual "Operation list" of 
the CPU. 
 
  

Connection partner Connection establishing Connection 
specified in NetPro 

(in the current project) 
active/passive specified 

active specified 
unspecified in NetPro  
(in the current project) passive unspecified 

unspecified in NetPro  
(in the unknown project) 

active/passive specified (connection name in an 
other project) 

 
In the following every relevant parameter of a Siemens S7 connection is 
described: 
 

Here you may define how the connection is to be established. Since the 
Siemens SIMATIC manager can identify the communication options by 
means of the end points, some options are already preset and may not be 
changed. 
 
An established connection is precondition for data transfer. By activating 
the option Establish an active connection the local station establishes the 
connection. 
Please regard not every station is able to establish a connection. Here the 
job is to be made by the partner station.  
 
If activated only one-way communication blocks like PUT and GET may be 
used for communication in the user program. Here the partner station acts 
as server, which neither may send active nor receive active 
 

Siemens S7 
connection 

Possibilities of 
combination 

Local connection 
end point 

Establish an active 
connection 

One-way 
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The ID is the link to your PLC program. The ID must be identical to the ID 
of the call interface of the FB/SFB VIPA handling block. 
 
As soon as you click at [Default], the ID is reset to system generated ID. 
 

In this part of the dialog window the connection path between the local and 
the partner station may be set. Depending on the linking of the modules the 
possible interfaces for communication are listed in a selection field.  
 
With this button a dialog window is opened, which shows address 
information about the local and partner station. The parameters may also 
be changed. 
 
With Siemens S7 connections a TSAP is automatically generated of the 
connection resource (one-way/two-way) and state of place (rack/slot 
respectively system internal ID at PC stations). 
 
The connection resource is part of the TSAP of the local station 
respectively of the partner. Not every connection resource may be used for 
every connection type. Depending on the connection partner and the 
connection type the range of values is limited respectively the connection 
resource is fix specified. 
 

With the SPEED7 CPUs of VIPA there are two possibilities for the 
deployment of the communication functions: 
• Siemens S7-300 communication functions 

By integration of the function blocks FB 8 ... FB 15 from VIPA you may 
access the Siemens S7-300 communication functions.  

• Siemens S7-400 communication functions 
For the Siemens S7-400 communication functions the SFB 8 ... SFB 15 
are to be used, which were integrated to the operating system of the 
CPU. Here copy the interface description of the SFBs from the standard 
library at system function block to the directory container, generate an 
instance data block for each call and call the SFB with the associated 
instance data block. 

 

 
 

Block parameters 

Local ID 

[Default] 

Connection path 

[Address details] 

TSAP 

Connection 
resource 

Communication 
functions 



Manual VIPA System 300S SPEED7 Chapter 6   Deployment Ethernet com. - productive 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  6-21 

The following function blocks may be used for Siemens S7 commu-
nications.  
More about the usage of the handling blocks may be found in the manual 
Operation list HB00_OPL_SP7 in chapter "VIPA specific blocks". 
 

FB/SFB Label Description 
FB/SFB 8 USEND Uncoordinated data transmission 

FB/SFB 8 USEND may be used to transmit data to a remote partner 
FB/SFB of the type URCV (FB/SFB 9). You must ensure that 
parameter R_ID of both FB/SFBs is identical. The transmission is 
started by a positive edge at control input REQ and proceeds without 
coordination with the partner FB/SFB.  

FB/SFB 9 URCV Uncoordinated data reception 
FB/SFB 9 URCV can be used to receive data asynchronously from a 
remote partner FB/SFB of the type USEND (FB/SFB 8). You must 
ensure that parameter R_ID of both FB/SFBs is identical. 
The block is ready to receive then there is a logical 1 at the EN_R 
input. An active job can be cancelled with EN_R=0. 

FB/SFB 12 BSEND Sending data in blocks 
FB/SFB 12 BSEND sends data to a remote partner FB/SFB of the 
type BRCV (FB/SFB 13). The data area to be transmitted is 
segmented. Each segment is sent individually to the partner. The last 
segment is acknowledged by the partner as it is received, 
independently of the calling up of the corresponding FB/SFB/FB 
BRCV. With this type of data transfer, more data can be transported 
between the communications partners than is possible with all other 
communication FBs/SFBs for configured S7 connections, namely 
65534bytes.  

FB/SFB 13 BRCV Receiving data in blocks 
The FB/SFB 13 BRCV can receive data from a remote partner 
FB/SFB of the type BSEND (FB/SFB 12). The parameter R_ID of both 
FB/SFBs must be identical.  
After each received data segment an acknowledgement is sent to the 
partner FB/SFB and the LEN parameter is updated. 

FB/SFB 14 GET Remote CPU read 
The FB/SFB 14 GET can be used to read data from a remote CPU. 
The respective CPU must be in RUN mode or in STOP mode. 

FB/SFB 15 PUT Remote CPU write 
The FB/SFB 15 PUT can be used to write data to a remote CPU. The 
respective CPU may be in RUN mode or in STOP mode. 

 

 

Function blocks 
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Configure Open Communication 
 

Connection-oriented protocols establish a (logical) connection to the 
communication partner before data transmission is started. And if 
necessary they terminate the connection after the data transfer was 
finished. 
Connection-oriented protocols are used for data transmission when 
reliable, guaranteed delivery is of particular importance. In general, many 
logical connections can exist on one physical line. 
 
The following connection-oriented protocols are supported with FBs for 
open communication via Industrial Ethernet: 
 
• TCP/IP native according to RFC 793 (connection types 01h and 11h) 
• ISO on TCP according to RFC 1006 (connection type 12h) 
 

During data transmission, no information about the length or about the start 
and end of a message is transmitted. However, the receiver has no means 
of detecting where one message ends in the data stream and the next one 
begins. The transfer is stream-oriented. 
For this reason, it is recommended that the data length of the FBs is 
identical for the sending and receiving station. If the number of received 
data does not fit to the preset length you either will get not the whole data, 
or you will get data of the following job. 
The receive block copies as many bytes into the receive area as you have 
specified as length. After this, it will set NDR to TRUE and write 
RCVD_LEN with the value of LEN. With each additional call, you will thus 
receive another block of sent data. 
 

During data transmission, information on the length and the end of the 
message is also transmitted. 
If you have specified the length of the data to be received greater than the 
length of the data to be sent, the receive block will copy the received data 
completely into the receive range. After this, it will set NDR to TRUE and 
write RCVD_LEN with the length of the sent data. 
If you have specified the length of the data to be received less than the 
length of the sent data, the receive block will not copy any data into the 
receive range but instead will supply the following error information: 
ERROR = 1, STATUS = 8088h. 
 

Connection-
oriented 
protocols 

TCP native 
according to  
RFC 793  

ISO on TCP 
according to   
RFC 1006  
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There is thus no establishment and termination of a connection with a 
remote partner. Connection-less protocols transmit data with no 
acknowledge and with no reliable guaranteed delivery to the remote 
partner. 
The following connection-oriented protocol is supported with FBs for open 
communication via Industrial Ethernet:  
 
• UDP according to RFC 768 (with connection type 13h) 
 

In this case, when calling the sending block you have to specify the address 
parameters of the receiver (IP address and port number). During data 
transmission, information on the length and the end of the message is also 
transmitted. 
In order to be able to use the sending and receiving blocks first you have to 
configure the local communications access point at both sides. 
With each new call of the sending block, you re-reference the remote 
partner by specifying its IP address and its port number. 
If you have specified the length of the data to be received greater than the 
length of the data to be sent, the receive block will copy the received data 
completely into the receive range. After this, it will set NDR to TRUE and 
write RCVD_LEN with the length of the sent data. 
If you have specified the length of the data to be received less than the 
length of the sent data, the receive block will not copy any data into the 
receive range but instead will supply the following error information: 
ERROR = 1, STATUS = 8088h. 
 

Connection-less 
protocol 

UDP according to  
RFC 768 
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Those in the following listed UTDs and FBs serve for "open communication" 
with other Ethernet capable communication partners via your user program. 
These blocks are part of the Siemens SIMATIC Manager. You will find 
these in the "Standard Library" at "Communication Blocks".  
Please consider when using the blocks for open communication that the 
partner station does not have to be configured with these blocks. 
This can be configured with AG_SEND / AG_RECEIVE or IP_CONFIG. 
 

 
 

FB Label Connection-oriented protocols: 
TCP native as per RFC 793, 
ISO on TCP as per RFC 1006 

Connectionless protocol: 
UDP as per RFC 768 

UDT 65 TCON_PAR Data structure for assigning 
connection parameters 
 

Data structure for assigning 
parameters for the local 
communications access point 

UDT 66 TCON_ADR  Data structure for assigning 
addressing parameters for the 
remote partner 

 

 
 

FB Label Connection-oriented protocols: 
TCP native as per RFC 793, 
ISO on TCP as per RFC 1006 

Connectionless protocol: 
UDP as per RFC 768 

FB 63 TSEND Sending data  
FB 64 TRCV Receiving data  
FB 65 TCON Establishing a connection Configuring the local 

communications access point 
FB 66 TDISCON Terminating a connection Closing the local communications 

access point 
FB 67 TUSEND  Sending data 
FB 68 TURCV  Receiving data 

 
 
 
 

Handling blocks 

UDTs 

FBs 



Manual VIPA System 300S SPEED7 Chapter 6   Deployment Ethernet com. - productive 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  6-25 

NCM diagnostic - Help for error diagnostic 
 

The VIPA PROFINET IO controller supports the Siemens NCM diagnostic 
tool. The NCM diagnostic tool is part of the Siemens SIMATIC manager. 
This tool delivers information about the operating state of the commu-
nication functions of the online CPs dynamically.  
The following diagnostic functions are available: 
• Check operating state at Ethernet  
• Read the diagnostic buffer of the IO controller 
• Diagnostic of connections 
 

Note! 
Please always enter as destination parameter 0 as module rack and 125 as 
slot. 
 

The following pages contain a short description of the NCM diagnostic. 
More details about the function range and for the deployment of the 
Siemens NCM diagnostic tool is to be found in the according online help 
res. the manual from Siemens.  
 
 
The diagnostic tool is started by Windows-START menu > SIMATIC ... 
NCM S7 > Diagnostic. 
 

The working surface of the diagnostic tool has the following structure: 
The navigation area at the left side contains the hierarchical listed 
diagnostic objects. Depending on CP type and configured connections 
there is an adjusted object structure in the navigation area.  
The information area at the right side always shows the result of the 
navigation function you chose in the navigation area. 
 

Navigation area

Module
Industrial Ethernet
Time of day
Operating mode
Diagnostic buffer
Connections

NCM-Diagnostics

Information area

...........

...........

...........

 
 

Siemens NCM  
S7 diagnostic 

     

Start NCM 
diagnostic 

Structure 
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A diagnostic always requires an online connection to the CP you want to 

control. For this click at  at the symbol bar. The following dialog window 
appears: 
 

NCM S7-Diagnostics: Online Path

OK Cancel

Gateway

...

Destination station

Attachment ... :

Ind. Ethernet TCP/IP

Node address:                           172 . 16 . 129 . 200

Rack/Slot:                                   0         /   125

Set PG/PC Interface

 
 

Set the following parameters at destination station: 
Attachment...: Ind. Ethernet TCP/IP 
Node addr.: Enter the IP address of the CP 
Rack/slot:  
For the VIPA PROFINET IO controller please enter 0 for module rack and 
125 as slot. 
Set your PG/PC interface to "TCP/IP -> Network card .... ". Via [OK] you 
start the online diagnostic. 
 

The PROFINET IO controller has a diagnostic buffer. This has the 
architecture of a ring memory and may store up to 100 diagnostic 
messages. The NCM diagnostic allows you to monitor and evaluate the 
diagnostic messages via the diagnostic object Diagnostic buffer. 
Via a double click on a diagnostic message the NCM diagnostic shows 
further information. 
 

No diagnostic 
without 
connection  

Read diagnostic 
buffer 
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You execute a diagnostic by clicking on a diagnostic object in the 
navigation area. More functions are available via the menu and the symbol 
bar. 
 
For the aimed diagnostic deployment the following approach is convenient: 
 
• Start diagnostic. 

• Open the dialog for the online connection with , enter connection 
parameters and establish the online connection with [OK]. 

• Identify the IO controller and check the recent state of the IO controller 
via module status. 

• Check the connections for particularities like: 
- Connection status 
- Receive status 
- Send status 

• Control and evaluate the diagnostic buffer of the IO controller via 
diagnostic buffer. 

• As needed, alter project engineering res. programming and restart 
diagnostic. 

 
 
 

Approach for 
diagnostic 
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Chapter 7  Deployment Ethernet com. - PROFINET 
 

Here the deployment of the PROFINET IO controller with PROFIBUS is 
described. 
Please regard the chapter "Fast introduction" where you will find every 
information compressed required for the project engineering of the 
PROFINET IO controller for PROFINET. After the fast introduction, the 
mentioned steps are described in detail. 
 

 

Topic     Page 
Chapter 7 Deployment Ethernet com. - PROFINET........................ 7-1 

Basics PROFINET................................................................................ 7-2 
PROFINET installation guidelines ........................................................ 7-4 
Basics - IP address and subnet ............................................................ 7-6 
Fast introduction................................................................................... 7-8 
Commissioning and Initialization .......................................................... 7-9 
Hardware configuration - CPU............................................................ 7-10 
Parameter - PROFINET IO controller ................................................. 7-11 
Configuration PROFINET IO device ................................................... 7-13 
Configuration PROFINET-I-Device / Shared-Device........................... 7-14 
Commissioning and Start-up behavior................................................ 7-15 
PROFINET Diagnostics...................................................................... 7-17 
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Content 
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Basics PROFINET 
 

PROFINET is an open Industrial Ethernet Standard from PROFIBUS & 
PROFINET International (PI) for automation. PROFINET is standardized in 
the IEC 61158. 
PROFINET uses TCP/IP and IT standards and supplements the 
PROFIBUS technology for applications, where fast data communication 
with industrial IT functions is demanded. 
 

With PROFINET IO an I/O data sight to the distributed periphery is 
described. PROFINET IO describes the whole data transfer between I/O 
controller and I/O device. PROFINET is configured like PROFIBUS.  
PROFINET IO always contains the real time concept. 
Contrary to the master-slave procedure of PROFIBUS, PROFINET uses 
the provider-consumer model. This supports the communication relations 
(AR = Application Relation) between equal participants in the Ethernet. 
Here the provider sends its data without a request of the communication 
partner. Apart from the user data exchange also functions for 
parameterization and diagnostics are supported. 
 
There are performance steps: 
• TCP/IP communication 
• RT communication 
 

This is the communication via Ethernet TCP/IP without any demand on 
real-time. 
 

RT means Real-Time. The RT communication represents the basics for 
data transfer at PROFINET IO. Here RT data are handled with higher 
priority. 
 

PROFINET of IEC 61158 has the following properties: 
• Full-duplex transfer with 100MBit/s via copper respectively fiber optics. 
• Switched Ethernet 
• Auto negotiation (negotiates the transfer parameters) 
• Auto crossover (transmission and receipt lines are crossed automatically 

if necessary) 
• Wireless communication via Bluetooth respectively WLAN 
• UDP/IP is used as overlaid protocol. UDP means User Datagram 

Protocol und contains the unprotected connectionless broadcast 
communication within IP. 

General 

PROFINET IO 

TCP/IP 
Communication 

RT 
Communication 

Properties of  
PROFINET 
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Like PROFIBUS DP also with PROFINET IO the following devices are 
classified according to their tasks: 
• IO controller 
• IO device 
• IO supervisor 
 
The IO controller is equivalent to the master of PROFIBUS. This is the PLC 
with PROFINET connection, in which the PLC program runs. 
 
The IO device is a distributed I/O field device, which is connected to 
PROFINET. The IO device is equal to the slave of PROFIBUS. 
From VIPA there is a GSDML files for your IO device available. This file 
may either be found on the supplied storage media or at the service area of 
www.vipa.com. Please install the GSDML file in your configuration tool. 
Details on the installation of the GSDML file are available from the manual 
supplied with your configuration tool. 
For configuration in your configuration tool every module of the IO device 
may the found in the GSDML file as XML data. 
 
The IO supervisor is an engineering station as e.g. programming unit, PC 
or HMI interface for commissioning and diagnostics. 
 

In contrast to the PROFIBUS address in PROFINET each device may be 
identified with its PROFINET interface: 
• IP address or MAC address 
• Device name 
 

PROFINET is compatible to Ethernet in accordance with the IEEE 
standards. The connection of the PROFINET IO field devices is exclusively 
established via switches as network components. This is made either as 
star via multi-port switches or as line by means of switches, integrated to 
the field devices. 

PROFINET devices 

IO controller 

IO device 

IO supervisor 

Addressing 

Transfer medium 
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PROFINET installation guidelines 
 

The topic of data security and access protection have become increasingly 
important in the industrial environment. The increased networking of entire 
industrial systems to the network levels within the company together with 
the functions of remote maintenance have all served to increase 
vulnerability. 
Threats can arise from internal manipulation like technical errors, operator 
and program errors respectively from external manipulation like software 
viruses and worms, Trojans and password phishing. 
 

The most important precautions to prevent manipulation and loss of data 
security in the industrial environment are: 
• Encrypting the data traffic by means of certificates. 
• Filtering and inspection of the traffic by means of VPN - "Virtual Private 

Networks". 
• Identification of the nodes by "Authentication" via save channels. 
• Segmenting in protected automation cells, so that only devices in the 

same group can exchange data. 
 

With the "VDI/VDE 2182 sheet 1", Information Security in the Industrial 
Automation - General procedural model, VDI guidelines, the VDI/VDE 
society for measuring and automation engineering has published a guide 
for implementing a security architecture in the industrial environment. 
The guideline can be found at www.vdi.de 
PROFIBUS & PROFINET International (PI) can support you in setting up 
security standards by means of the "PROFINET Security Guideline". More 
concerning this can be found at the corresponding web site e.g. 
www.profibus.com 
 

Due to the open standard of PROFINET standard Ethernet components 
may be used. For industrial environment and due to the high transfer rate of 
100MBit/s you PROFINET system should consist of Industrial Ethernet 
components. 
All the devices interconnected by switches are located in one and the same 
network. All the devices in a network can communicate directly with each 
other. 
A network is physically limited by a router. If devices need to communicate 
beyond the limits of a network, you have to configure the router so that it 
allows this communication to take place. 
 

Generals to  
data security 

Precautions 

Guidelines for 
information 
security 

Industrial Ethernet 
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With the linear structure all the communication devices are connected via a 
linear bus topology. Here the linear bus topology is realized with switches 
that are already integrated into the PROFINET device. 
If a communication member fails, communication across the failed member 
is no longer possible. 
 
If you connect communication devices to a switch with more tan 2 
PROFINET ports, you automatically create a star network topology. 
If an individual PROFINET device fails, this does not automatically lead to 
failure of the entire network, in contrast to other structures. It is only if a 
switch fails that part of the communication network will fail as well. 
 
In order to increase the availability of a network the both open ends of a 
linear bus topology may be connected by a switch. 
By configuring the switch as redundancy manager on a break in the 
network it ensures that the data is redirected over an intact network 
connection. 
 
If you interconnect several star structures, you obtain a tree network 
topology. 

Topology 

Linear 

Star 

Ring 

Tree 
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Basics - IP address and subnet 
 

PROFINET exclusively supports IPv4. At IPv4 the IP address is a 32Bit 
address that must be unique within the network and consists of 4 numbers 
that are separated by a dot.  
Every IP address is a combination of a Net-ID and a Host-ID and its 
structure is as follows:  xxx.xxx.xxx.xxx 
Range: 000.000.000.000 to 255.255.255.255  
The network administrator also defines IP addresses.  
 

The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using a bit for bit AND assignment with the Subnet mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet mask 
becomes the Subnet-ID, the rest is the new Host-ID. 

 
Subnet mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet mask and  IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The subnet mask allows you to sort the resources following your needs. 
This means e.g. that every department gets an own subnet and thus does 
not interfere another department. 
 

At the first start-up of the CPU, the Ethernet PG/OP channel and the 
PROFINET connector of the CPU do not have an IP address.  
Information about the assignment of IP address data to the Ethernet 
PG/OP channel may be found in chapter "Deployment CPU ..." at 
"Initialization Ethernet PG/OP channel". 
Information about the assignment of IP address data to the PROFINET 
connector may be found in this chapter below. 

IP address 
structure 

Net-ID 
Host-ID 

Subnet mask 

Subnet 

Address at first 
start-up  
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For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4byte = 32bit.  
 
Class A 0 Network-ID 

(1+7bit) 
Host-ID (24bit) 

Class B 10 Network-ID (2+14bit) Host-ID (16bit) 
Class C 110 Network-ID (3+21bit) Host-ID (8bit) 
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the 3 classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
To build up private IP-Networks within the Internet, RFC1597/1918 
reserves the following address areas: 

 
Network 
class 

Start IP End IP Standard subnet mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 
(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
Internet nor are routed in the Internet. 
 

Some Host-IDs are reserved for special purposes. 
 
Host-ID = "0"  Identifier of this network, reserved! 
Host-ID = maximum (binary complete "1") Broadcast address of this network 
 

Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 
 

Address classes 

Private IP networks 

Reserved 
Host-Ids 
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Fast introduction 
 

At the first start-up respectively at an over all reset with an PowerON again, 
the Ethernet PG/OP channel and PROFINET IO controller of the CPU do 
not have any IP address. These may only be reached via its MAC address. 
IP address parameters may be assigned to the corresponding component 
by means of the MAC addresses, which may be found on labels beneath 
the front flap with the sequence 1. address PG/OP channel and beneath 
address of the PROFINET IO controller. The assignment takes place 
directly via the hardware configuration of the Siemens SIMATIC manager. 
 

For the configuration of the PROFINET IO controller for PROFINET 
communication please follow the following approach: 
 
• Commissioning and initialization 

(Assignment of IP address data) 
• Hardware configuration - CPU  
• Configuration PROFINET IO controller 
• Configuration PROFINET IO device 
• Transfer of the complete project to CPU 

Information about transferring a project may be found at chapter 
"Deployment CPU ..." at "Project transfer". 

 

 

To be compatible to the Siemens SIMATIC manager, the CPU 315-4PN33 from VIPA is 
to be configured as  

CPU 315-2PN/DP (6ES7 315-2EH13-0AB0 V2.6) 

 
The PROFINET IO controller is to be configured via the sub module X2 (PN-IO). 
The Ethernet PG/OP channel of the CPU 315-4PN33 is always to be configured as 1. 
module after the really plugged modules at the standard bus as CP343-1 (343-1EX11) 
from Siemens.  
 

 

 
 

Overview 

Steps of 
configuration 

Note 
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Commissioning and Initialization 
 

• Install your System 300S with your CPU.  
• Wire the system by connecting cables for voltage supply and signals 
• Connect your PROFINET IO controller with Ethernet. 
• Switch on the power supply.  

→ After a short boot time, the CP is in idle.  
At the first commissioning res. after an overall reset of the CPU, the 
PROFINET IO controller has no IP address.  

 
This function is supported only if the PROFINET IO controller is not yet 
configured.  
You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens SIMATIC 
manager starting with version V 5.3 & SP3 with the following proceeding: 
 
• Start the Siemens SIMATIC manager. 
• Switch to "TCP/IP -> Network card .... " using Options > Set PG/PC 

interface. 
• The dialog for initialization of a station opens by PLC > Edit Ethernet 

Node. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address may be found at the 2. label 
beneath the front flap of the CPU. 

• Choose if necessary the known MAC address of the list of found 
stations. To check this with [Blink] you may cause the MT LED to blink. 

• Either type in the IP configuration like IP address, subnet mask and 
gateway. Or your station is automatically provided with IP parameters by 
means of a DHCP server. Depending of the chosen option the DHCP 
server is to be supplied with MAC address, equipment name or client ID. 
The client ID is a numerical order of max. 63 characters. The following 
characters are allowed: "hyphen", 0-9, a-z, A-Z 

• Confirm with [Assign IP configuration]. 
Directly after the assignment the PROFINET IO controller is online 
reachable using the set IP address data. 
 

Note! 
Since the IP address data, which were assigned here, are deleted at 
PowerOFF, you have to take them to a project by means of the hardware 
configuration, which is described on the next page.   
Information about the initialization of the Ethernet-PG/OP channel may be 
found in chapter "Deployment CPU..." at "Initialization Ethernet PG/OP 
channel". 

Assembly and 
commissioning 

Assign IP address 
parameters 
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Hardware configuration - CPU 
 

The hardware configuration of the VIPA CPU takes place at the Siemens 
hardware configurator. 
The hardware configurator is a part of the Siemens SIMATIC Manager. It 
serves the project engineering. The modules, which may be configured 
here are listed in the hardware catalog. If necessary you have to update the 
hardware catalog with Options > Update Catalog. 
For project engineering a thorough knowledge of the Siemens SIMATIC 
manager and the Siemens hardware configurator are required! 
 

Note! 
Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic 
operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of 
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2. 
This may cause conflicts in applications that presume an unmodified 
ACCU2. 
For more information may be found in the manual "VIPA Operation list 
SPEED7" at "Differences between SPEED7 and 300V programming". 
 

To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

Slot
1
2

X1
X2

X2 P1
3

Module

CPU 315-2 PN
MPI/DP
PN-IO
Port 1

 

• Start the Siemens hardware configurator with a new project. 
• Insert a profile rail from the hardware catalog. 
• Place at slot 2 the following CPU from Siemens:  

CPU 315-2EH13 (6ES7 315-2EH13-0AB0 V2.6). 
• The PROFINET-IO Controller is to be configured via the sub module 

X2 (PN-IO). 
 

 

 

Open the property window of the internal PROFINET IO controller via 
double-click on the component PN-IO. 
• At general enter a device name. The device name on the Ethernet 

subnet must be unique. 
• For the PROFINET IO controller enter the IP address, subnet mask and 

gateway and select the wanted subnet. 
 

Requirements 

     

Proceeding 

Parameterization 
of the IP address 
data for the 
PROFINET IO 
controller 



Manual VIPA System 300S SPEED7 Chapter 7   Deployment Ethernet com. - PROFINET 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  7-11 

Parameter - PROFINET IO controller 
 

To parameterize the PROFINET IO controller of the CPU, the following 
conditions must be fulfilled: 
• The PROFINET IO controller is online reachable, this means an 

initialization was established. 
• The hardware configuration described before was established and the 

PROFINET IO controller is networked. 
 
• Open the properties dialog of the PROFINET IO controller by a double 

click at PN-IO. 
 

Slot
1
2

X1
X2

X2 P1
3

Module

CPU ...
MPI/DP
PN-IO
Port 1

PROFINET IO system

 
 
The PROFINET interface of the PROFINET IO controller is parameterized 
with PN-IO, the port with Port 1. 
In the following these parameters are described. 
 

 
 
 
 
 
Designation of the IO controller. The IO controller from VIPA always has 
the short description "PN-IO". 
 
The device name on the Ethernet subnet must be unique. For an integrated 
Profinet interface the device name is derived from the short description. 
 
Here the purpose may be entered for which the IO controller is being used. 
 
With properties you can enter the IP address, subnet mask and gateway 
and select the subnet to be connected. 
 
The CPU reports errors of the IO controller via the interface address, as 
soon as e.g. an error during synchronization of the IO controller occurs. 
With the PROFINET IO system address the CPU reports e.g. failure/return 
of the PROFINET IO system. This address is also used to identify the IO 
system to which the device belongs, if an IO device fails. 

Precondition 

Proceeding 

PN-IO 

General 

Short description  

Device name 

Comment 

Properties 

Addresses 
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With the operation field "OB82 / I/O fault task..." you can cause the CPU to 
call the OB 82 at an error event of the PROFINET interface. An entry to the 
diagnostics buffer is always done. 
The other parameters in this tab are not relevant for the use of the VIPA 
PROFINET CPU. 
 
This tab shows the synchronization properties of the IO controller. Here 
nothing can be changed 
 
Here you can configure time-of-day master for time-of-day synchronization 
in the network. 
NTP (Network Time Protocol) is used to implement a TCP/IP protocol for 
time-of-day synchronization in networks. In the NTP mode the module 
sends out time-of-day queries at regular intervals to all configured NTP 
servers. 
Based on the response from the servers, the most reliable and most exact 
time-of-day is determined and used to synchronize the time-of-day of the 
module. 
Configure with [Add] a NTP server and enter the update interval. The time-
of-day of the module is synchronized once within this interval. 
 

 
 
Shown is the short name "Port...". In the field Name another designation 
may be selected, which is also shown in the configuration table. At 
comment you may describe your entry near more. The comment also 
appears in the configuration table. 
 
Via the port address the diagnostics information of the IO controller may be 
accessed. 
 
These parameters serve for the handling of the ports and should not be 
changed. 
 
 
These parameters serve for the port settings and should not be changed. 
 
 

PROFINET 

Synchronization 

Time-of-day 
synchronization 

Port 1 

General 

Addresses 

Topology 

Options 
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Configuration PROFINET IO device 
 

The modules, which may be configured here, are listed in the hardware 
catalog.  
For the deployment of the PROFINET IO devices from VIPA you have to 
include the modules into the hardware catalog by means of the GSDML file 
from VIPA. 
After the installation of the GSDML file the PROFINET IO devices from 
VIPA may be found in the hardware catalog at PROFINET IO > Additional 
field devices > I/O > VIPA ... 
 

Now the project engineering of the PROFINET IO controller is finished. 
Please link up now your IO devices with periphery to your IO controller. 
• For the project engineering of PROFINET IO devices you search the 

concerning PROFINET IO device in the hardware catalog and 
drag&drop it in the Subnet of the IO controller. 

• Assign a name and valid IP address parameters to the IO device. Valid 
IP address parameters may be received from your system administrator.  

• Link up the modules of your IO device system in the plugged sequence 
and add the addresses that should be used by the modules. 

• If needed, parameterize the modules. 
• Save, compile and transfer your project. More detailed information about 

project transfer may be found at chapter "Deployment CPU ...". 
 

Slot
1
2

X1
X2

X2 P1
3

Modules

CPU ...
MPI/DP
PN-IO
Port 1

PROFINET IO system

Module
IO device
...
Modules
...

Order numberSlot
0
1
2
3
4
...  

Install 
GSDML  

Configure  
IO devices 
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Configuration PROFINET-I-Device / Shared-Device 
 

I-Device (intelligent device) offers PROFINET I/O communication of a CPU 
with I/O periphery as "intelligent device" to a higher-lever CPU. Here the 
communication happens by means of an I/O area, which was defined in the 
I-Device, before. 
Thus the higher-lever CPU can communicate with the I/O area VIPA 
specific settings are necessary in the I-Device. 
In addition an I/O area for the communication is to be defined in the  
I-Device and the hardware configuration is to be imported as GSD file in the 
higher-lever VIPA CPU. 
With Shared-Device different IO controllers can independently access one 
IO device by means of Shared-Devices. Here during configuration of an IO 
device the corresponding I/O component can be assigned to a specified 
controller. For example, standard CPU and failsafe CPU use the same 
peripheral system. 
 
After you have defined the I/O area for data transfer of the I-Device the 
following functions are to be activated in the properties of the 
corresponding I-Device: 
• I-Device > I-Device mode: Parameter assignment for the PN interface 

and its ports on the higher-lever IO-controller. 
• General > Interface: [Properties] > Use different method to obtain IP 

address 
 

Slot
1
2

X1
X1 P1
X2 P2

3

Module

IM ...
PN-IO
Port 1
Port 2

Properties PN-IO

Interface

General ...
Properties PN-IO

I-Device mode
Param...assign ... IO-Controller

I-Device...

Properties Ethernet Interface PN-IO

Use different method to obtain ...

...General
Properties

...

 
Create an I-Device GSD file and install it at your hardware catalog with 
Options > Create GSD file for I-Device. Open the hardware configuration of 
your higher-lever VIPA CPU and connect your I-Device from "Preconfigured 
Stations". 
 
 

The PROFINET CPU from VIPA also supports I- and Shared-Devices. For 
this to configure the PROFINET CPU from VIPA you have to use the 
Siemens CPU 315-2 PN/DP (6ES7 315-2EH14-0AB0) from the hardware 
catalog. 
For this the Siemens SIMATIC manager starting with V. 5.5, SP2 is 
necessary. 
 
Besides the configuration, by means of the Siemens CPU 315-2 PN/DP 
(6ES7 315-2EH14-0AB0), no further VIPA specific adjustments are required 
for Shared-Devices. 

General 

Setting for   
I-Devices 

IO-controller 
which supports  
I- and Shared-
Devices 

Setting for  
Shared-Devices 



Manual VIPA System 300S SPEED7 Chapter 7   Deployment Ethernet com. - PROFINET 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  7-15 

Commissioning and Start-up behavior 
 

In delivery the CPU is overall reset. The PROFINET part is deactivated and 
its LEDs are off after PowerON. 
 

For the communication between IO controller and IO device the ways for 
the communication are to be defined before.  
For the clear specification of the communication ways, these are 
established during the start-up by the IO controller, based on the project 
data. 
Here the configuration takes place by a hardware configuration. As soon as 
the project data were transmitted, the IO controller switches to system start-
up. 
In this state the IO controller may be accessed and its CPU may be 
configured via Ethernet by the IO controller by means of the IP address. 
  

The PROFINET IO controller is configured by a hardware configuration. 
After the transmission of the project into the IO controller with connected IO 
devices, the IO controller has the whole information for the addressing of 
and the data exchange with the IO devices. 
During the system start-up of the IO controller the IO devices are supplied 
with their configured IP address by means of the DCP protocol. 
After PowerON due to the project data the system start-up of the IO 
controller is initialized and it runs off independently. During the system 
start-up the IO controller establishes a clear communication relation (CR) 
and an application relation (AR) to an IO-Device. 
Here the cyclic IO data, the acyclic R/W services and the expected 
modules/sub modules are specified. 
If the IO controller has received valid project engineering data, a system 
start-up with the IO devices is initialized and this is indicated by flashing BF 
LED. 
If all IO devices are in cyclic data exchange, the BF LED gets off. This state 
does not depend on the state of the operating switch of the CPU. After a 
successful system start-up the system is ready for communication. 
 

Start-up on 
delivery 

Online with bus 
parameters 
without project 

IO device 
configuration 
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After PowerON respectively a receipt of a new hardware configuration the 
configuration data are automatically transferred to the IO controller. 
Dependent on the CPU state the following behavior is shown by the IO 
controller: 
 
• In the STOP state of the CPU an output telegram is further cyclically 

sent but this is designated as "not valid" and the output data are set to 0. 
• The IO controller further receives the input data of the IO devices and 

transfers them cyclically to the input area of the CPU. 
 
• The IO controller cyclically reads the output data from the CPU and 

transfers these as telegram to the connected IO devices. 
• The IO controller receives the input data of the IO devices and transfers 

them cyclically to the input area of the CPU. 
 

CPU state 
influences the  
IO process data 

Behavior at  
CPU STOP 

Behavior at  
CPU RUN 
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PROFINET Diagnostics 
 

There are the following possibilities to get diagnostics information about 
your system: 
• Diagnostics with the configuration and engineering tool 
• Diagnostics during run-time in the user program (OB 1, SFB 52) 
• Diagnostics interrupt (start information) 
• Diagnostics via LEDs 
  

If you are connected from your configuration and engineering tool via 
Ethernet with the PROFINET IO controller, online diagnostics information 
may be accessed. 
E.g. with Station > Open online you get information about the state of your 
system. Here missing or faulty  components are shown by symbols. 
In the following figure e.g. there is shown that the configured device 3 is 
missing and device 4 reports an error. 
 

(1) VIPA .

Slot
1
2

X1
X2

X2 P1
3

Module

CPU ...
MPI/DP
PN-IO
Port 1

(2) VIPA .

(3) VIPA . (4) VIPA .

x

Diagnostics Online

x

Slot
0
1
2
3
4
5

Module
IM 053PN
021-1BB00
022-1BB00
050-1BA00
...

I Addr.

20

24

Q Addr.

30
32

Diag.
8187

x

 
 

Overview 

Diagnostics with 
the configuration 
and engineering 
tool 
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With the SFB 52 RDREC (read record) the diagnostics data may be 
accessed by the user program e.g. from the OB 1. 
The SFB 52 works asynchronous, this means the operation is extended 
over several SFB calls. 
 
Note! 
More information concerning the usage of the SFB 52 may be found in the 
online help of your configuration tool and in the manual "SPEED7 operation 
list" from VIPA. 
 

For the cyclic access to the diagnostics data of the system SLIO module 
050-1BA00 the following example may be used in the OB 1. 
 

AN M10.3 'If the reading terminated (BUSY=0) and  
AN M10.1 'there is no job triggered (REQ=0) then 
S M10.1 'start transfer of record (REQ:=1) 
L W#16#0001 'Number of record set (here 01)  
T MW12 
CALL SFB 52, DB52 'Call SFB 52 with Instance DB 
  REQ :=M10.1   'Trigger flag 
  ID :=DW#16#0018 'Smaller addr. of the mixed module 
  INDEX :=MW12   'Record set (here record set 01)  
  MLEN :=20   'Length of record set (here 20 byte) 
  VALID :=M10.2   'Validity of the record set 
  BUSY :=M10.3   'Flag job just running  
  ERROR :=M10.4   'Error bit during read access  
  STATUS :=MD14   'Error codes 
  LEN :=MW16   'Length of the read record set 
  RECORD :=P#M 100.0 Byte 40 'Target area (MB100, 40Byte) 
A M10.1    
R M10.1   'Reset REQ 
 

The system SLIO module 050-1BA00 serves for 20 byte diagnostics data. 
The diagnostics data of the system SLIO module 050-1BA00 have the 
following structure: 
 

Name Bytes Function Default 
ERR_A 1 Diagnostic 00h 

MODTYP 1 Module information 18h 
ERR_C 1 reserved 00h 
ERR_D 1 Diagnostic 00h 
CHTYP 1 Channel type 76h 
NUMBIT 1 Number diagnostic bits per channel 08h 
NUMCH 1 Number channels of the module 01h 
CHERR 1 Channel error 00h 

CH0ERR 1 Channel-specific error 00h 
CH1ERR…CH7ERR 7 reserved 00h 

DIAG_US 4 µs ticker 00h 
 
Note! 
More information about the diagnostics data may be found in the system 
SLIO manual HB300_FM_050-1BA00. 

Diagnostics 
during run-time in 
the user program 

     

Example  
OB1 

Diagnostics data 
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If an error occurs the faulty system reports a diagnostics message to the 
CPU. This indicates that the CPU calls the corresponding diagnostics OB. 
Here the operating system of the CPU transfers a start information to the 
temporary local data of the OB. 
By evaluating the start information of the OB you get information about 
location and cause of error. 
These start information may be accessed during run-time with the system 
function SFC 6 RD_SINFO. 
Please regard that the start information may only be read inside its OB, 
because these are temporary data.  
 
Dependent on the type of error the following OBs are called in case of 
diagnostics: 
• OB 82 on error on a module at an IO device (diagnostics interrupt) 
• OB 83 on inserting respectively removing a module on a IO device 
• OB 86 on failure respectively return of a IO device 
  

Note! 
More information about the OBs and their start information may be found in 
the online help of your programming tool and in the manual "SPEED7 
operation list" from VIPA. 
 

 

For the PROFINET IO controller the CPU has got LEDs on its front side. In 
the following the usage and the according colors of the LEDs is described. 
 
 

 
 

MT 
yellow 

BF 
red 

Meaning 

x ● 
- Bus error, no connection to subnet/switch 
- wrong transfer speed 
- full-duplex transfer is not activated 

x ☼ 
- Failure of a connected IO device 
- at least 1 IO device may not be accessed 
- faulty configuration 

● x Maintenance event is pending. 

☼* ☼* * The alternate blinking with 4Hz indicates that a firmware update of the PROFINET IO 
controller is executed. 

● ● Firmware update of the PROFINET IO controller finished without error. 

☼ x As long as the PROFINET IO controller is not yet configured, for identification you may 
cause the LED to blink by means of the "Network search of your configuration tool.  

on: ●         off: ○         blinking (2Hz): ☼         not relevant: x 
 
The green L/A-LED (Link/Activity) indicates the physical connection of the 
PROFINET IO controller to Ethernet. Irregular flashing of the L/A-LED 
indicates communication of the PROFINET IO controller via Ethernet. 
If the green S-LED (Speed) is on, the PROFINET IO controller has a 
communication speed of 100MBit/s otherwise with 10MBit/s. 

Diagnostics  
via OB start 
information 

     

Diagnostics via  
status LEDs 

LEDs PROFINET 
IO controller X8 

LEDs  
L/A, S 
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Chapter 8  Configuration with TIA Portal 
 

In this chapter the project engineering of the VIPA CPU in the Siemens TIA 
Portal is shown. The chapter only describes the basic usage of the 
Siemens TIA Portal together with a VIPA CPU . 
More detailed information about the Siemens TIA Portal is to be found in 
the according online manual respectively documentation. 
 

 

Topic     Page 
Chapter 8 Configuration with TIA Portal......................................... 8-1 

TIA Portal - Work environment ............................................................. 8-2 
TIA Portal - Hardware configuration - CPU........................................... 8-4 
TIA Portal - Hardware configuration - I/O modules ............................... 8-5 
TIA Portal - Hardware configuration - Ethernet PG/OP channel ........... 8-6 
TIA Portal - Setting VIPA specific CPU parameters.............................. 8-9 
TIA Portal - Include VIPA library......................................................... 8-12 
TIA Portal - Project transfer................................................................ 8-13 

 

Overview 

Content 



Chapter 8   Configuration with TIA Portal Manual VIPA System 300S SPEED7 

8-2  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

TIA Portal - Work environment  
 

TIA is the abbreviation for Totally integrated Automation from Siemens. 
Here your VIPA PLCs may be configured and linked. For diagnostics online 
tools are available. 
 

Note! 
Information about the Siemens TIA Portal may be found in the online help 
respectively in the according online documentation. 
 

To start the Siemens TIA Portals with Windows select Start > Programs > 
Siemens Automation > TIA ...  
Then the TIA Portal opens with the last settings used. 
 

TIA

Open existing project

Create new project

...

Start

Online &
Diagnostics

Existing Projects:

Project 1
Project 2
Project 3
...

> Project view  
 

With the menu Project > Exit in the Project view you may exit the TIA 
Portal. 
Here there is the possibility to save changes of your project before. 
 

General 

     

Starting the  
TIA Portal 

Exiting the  
TIA Portal 
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Basically, the TIA Portal has the following 2 views. With the button on the 
left below you can switch between these views: 
 
 
The Portal view provides a "task oriented" view of the tools for processing 
your project. Here you have direct access to the tools for a task. If 
necessary, a change to the Project view takes place automatically for the 
selected task. 
 
The Project view is a "structured" view to all constituent parts of your 
project.  
 
The Project view is divided into the following areas: 
 

TIA

Menu ...

2

3

5

6

8

4

7
1

 
 
 

[1] Menu bar with toolbars  
[2] Project tree with Details view 
[3] Project area 
[4] Device overview of the project respectively area for block 

programming 
[5] Properties dialog of a device (Parameter) respectively  area for 

information 
[6] Hardware catalog and tools 
[7] "Task-Cards" to select hardware catalog, tasks and libraries 
[8] Jump to Portal or Project view 

 
 
 

Work environment 
of the TIA Portal 

Portal view 

Project view 

Areas of the  
Project view 



Chapter 8   Configuration with TIA Portal Manual VIPA System 300S SPEED7 

8-4  HB140E - CPU - RE_315-4PN33 - Rev. 13/17 

TIA Portal - Hardware configuration - CPU  
 

To be compatible with the Siemens TIA Portal the VIPA CPU is to be 
configured as CPU 315-2PN/DP (6ES7 315-2EH13-0AB0 V2.6) from 
Siemens. 
 

• Start the Siemens TIA Portal. 
• Create a new project in the Portal view with Create new project. 
• Change to the Project view. 
• Click in the Project tree at Add new device. 
• Select the following CPU in the input dialog: 

SIMATIC S7-300 > CPU 315-2PN/DP > 6ES7 315-2EH13-0AB0 V2.6 
Then the CPU is inserted with a profile rail.  

 
Project area: 

1 2 4 5 6

 
 
Device overview: 
Module ... Slot ... Type ... 
PLC...  2  CPU 315-2DP  
 MPI/DP interface...  2 X1  MPI/DP interface..  
 PROFINET interfa...  2 X2  PROFINET inter...  
...      
 

Since the CPU from VIPA is configured as Siemens CPU, so the 
parameterization takes place via the Siemens CPU. 
For parameterization click in the Project area respectively in the Device 
overview at the CPU part. Then the parameters of the CPU part are shown 
in the Properties dialog. Here you can make your parameter settings. 
 
Note! 
The parameters are described in chapter "Deployment CPU..." at "CPU 
parameterization". 

General 

Proceeding 

Parameterization 
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TIA Portal - Hardware configuration - I/O modules 
 

After the hardware configuration of the CPU place the System 300 
modules at the bus in the plugged sequence. For this drag&drop the 
according module from the Hardware catalog to the according position of 
the profile rail in the Project area or in the Device overview.   
 
Project area: 

1

DI

DI DO DIO AI AO

CPU

DO DIO AI

2 4 5 6 7 8

AOCPU

 
 
Device overview: 
Module ... Slot ... Type ... 
PLC...  2  CPU ...  
 ... 
 

 ...  ...  

  3    
DI...  4  DI...  
DO...  5  DO...  
DIO...  6  DIO...  
AI...  7  AI...  
AO...  8  AO...  
      
      
 

For parameterization click in the Project area respectively in the Device 
overview on the module you want to parameterize. The parameters of the 
module appear in the Properties dialog. Here you can make your 
parameter settings. 
 

Hardware 
configuration of 
the modules  

Parameterization  
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TIA Portal - Hardware configuration - Ethernet PG/OP channel 
 

The CPU has an integrated Ethernet PG/OP channel. This channel allows 
you to program and remote control your CPU. 
The PG/OP channel also gives you access to the internal web page that 
contains information about firmware version, connected I/O devices, 
current cycle times etc. 
With the first start-up respectively after an overall reset the Ethernet 
PG/OP channel does not have any IP address. 
For online access to the CPU via Ethernet PG/OP channel valid IP address 
parameters have to be assigned to this for example by means of the 
Siemens TIA Portal. This is called "initialization". 
 

• Install your System 300S with your CPU.  
• Wire the system by connecting cables for voltage supply and signals. 
• Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet 
• Switch on the power supply.   

→ After a short boot time the CP is ready for communication. 
 He possibly has no IP address data and requires an initialization. 

 

The initialization via the Online functions takes place with the following 
proceeding: 
• Determine the current Ethernet (MAC) address of your Ethernet PG/OP 

channel. This always may be found as 1. address under the front flap of 
the CPU on a sticker on the left side. 

 

 
 

Overview 

Assembly and 
commissioning 

"Initialization" via 
Online functions 
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You get valid IP address parameters from your system administrator. The  
assignment of the IP address data happens online in the Siemens TIA 
Portal with the following proceeding: 
 
• Start the Siemens TIA Portal. 
• Switch to the Project view. 
• Click in the Project tree at Online access and choose here by a double-

click your network card which is connected to the Ethernet PG/OP 
channel. 

• To get the stations and their MAC address, use the [Accessible device] 
button. The MAC address may be found at the 1. label beneath the front 
flap of the CPU. 

• Choose from the list the module with the known MAC address (Onboard 
PG/OP [MAC address]) and open with "Online & Diagnostics" the 
diagnostics dialog in the Project area. 

• Navigate to Functions > Assign IP address. 
• Type in the IP configuration like IP address, subnet mask and gateway.  
• Confirm with [Assign IP configuration]. 
 

TIA

Menu ...

Project tree Online access

Online access
   Net adapter
      accessible devices...
      Onboard PG/OP [00-2... 
         Online & Diagnostics

...

Diagnostics
   General

Functions
   Assign IP address
   Assign name
   Reset to factory set...

...

IP address:  

Subnet mask:

Router address:

Assign IP address

0   . 0   . 0   . 0  

0   . 0   . 0   . 0  

0   . 0   . 0   . 0  

Assign IP address

 
 

Note! 
Due to the system you get a message indicating that the IP address could 
not be assigned. Please ignore this message. 
 
Direct after the assignment the Ethernet PG/OP channel may be reached 
online by these address data. The value remains as long as it is 
reassigned, it is overwritten by a hardware configuration or an factory reset 
is executed. 
 
 

Assign IP address 
parameters 
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• Start the Siemens TIA Portal. 
• Configure in the Device configuration the according Siemens CPU. 
• Configure the system 300 modules. 
• For the Ethernet PG/OP channel you have to configure a Siemens 

CP 343-1 (6GK7 343-1EX11 0XE0) always as last module after the 
really plugged modules. 

• Open the "Property" dialog by clicking on the CP 343-1EX11 and enter 
for the CP at "Properties" the IP address data, which you have assigned 
before.  

• Transfer your project. 
 

Project area: 

1

DI

DI DO DIO AI AO

CPU

DO DIO AI

2 4 5 6 7 8 9 10

AO CP 343-1EX11

Ethernet PG/OP channel

E
th

er
ne

t P
G

/O
P

CPU

 
 
Device overview: 
Module ... Slot ... Type ... 
PLC...  2  CPU ...  
 ... 
 

 ...  ...  

  3    
DI...  4  DI...  
DO...  5  DO...  
DIO...  6  DIO...  
AI...  7  AI...  
AO...  8  AO...  
CP 343-1  9  CP 343-1  
      
 
 
 
 

Take IP address 
parameters in 
project 
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TIA Portal - Setting VIPA specific CPU parameters 
 

Since the VIPA specific CPU parameters may be set, the installation of the 
SPEEDBUS.GSD from VIPA in the hardware catalog is necessary. 
The CPU may be configured in a PROFIBUS master system and the 
appropriate parameters may be set after installation. 
 
 

The GSD (Geräte-Stamm-Datei) is online available in the following 
language versions. Further language versions are available on inquires. 
Name Language 
SPEEDBUS.GSD german (default) 
SPEEDBUS.GSG german 
SPEEDBUS.GSE english 
  
The GSD files may be found at www.vipa.com at the "Service" part. 
 
The integration of the SPEEDBUS.GSD takes place with the following 
proceeding: 
• Browse to www.vipa.com. 
• Click to Service > Download > GSD- and EDS-Files > PROFIBUS. 
• Download the file Cx000023_Vxxx. 
• Extract the file to your work directory. The SPEEDBUS.GSD is stored in 

the directory VIPA_System_300S.   
• Start the Siemens TIA Portal. 
• Close every project. 
• Switch to the Project view. 
• Select Options > Install general station description file (GSD). 
• Navigate to the directory VIPA_System_300S, select the according 

SPEEDBUS.GSx and click at [Install]. 
The hardware catalog is refreshed and the Siemens TIA Portal is finished. 
After restarting the Siemens TIA Portal all the SPEED7 CPUs and modules 
of the System 300S from VIPA can now be found in the hardware catalog 
at:  
Other field devices > PROFIBUS DP > I/O > VIPA GmbH > 
VIPA_SPEEDbus 
 

Note! 
Thus, the VIPA components can be displayed, you have to deactivate the 
"Filter" of the hardware catalog. 
 

Requirements 

Installation of the  
SPEEDBUS.GSD 
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The embedding of the CPU 315-4PN33 happens by means of a virtual 
PROFIBUS master system with the following approach: 
 
• Start the Siemens TIA Portal. 
• Configure in the Device configuration the according Siemens CPU. 
• Configure your System 300 modules. 
• Configure your Ethernet PG/OP channel always as last module after the 

really plugged modules. 
• Configure always as last module a Siemens DP master CP 342-5 (342-

5DA02 V5.0). Connect and parameterize it at operation mode "DP-
Master". 

 
Project area: 

DI DO DIO AI

2 4 5 6 7 8 9 10

AO CP 343-1EX11CPU CP 342-5

1

DI DO DIO AI AO

CPU

Et
he

rn
et

 P
G

/O
P

 
 
Device overview: 
Module ... Slot ... Type ... 
PLC...  2  CPU ...  
 ... 
 

 ...  ...  

  3    
DI...  4  DI...  
DO...  5  DO...  
DIO...  6  DIO...  
AI...  7  AI...  
AO...  8  AO...  
CP 343-1  9  CP 343-1  
CP 342-5  10  CP 342-5  
 
 

Proceeding 
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Note! 
Thus, the VIPA components can be displayed, you have to deactivate the 
"Filter" of the hardware catalog. 
 

• Switch in the Project area to "Network view". 
• Connect the slave system "VIPA_SPEEDbus". After installing the 

SPEEDBUS.GSD this may be found in the hardware catalog at:  
Other field devices > PROFIBUS DP > I/O > VIPA GmbH > 
VIPA_SPEEDbus. 

• For the slave system set the PROFIBUS address 100. 
 

T I A

M e n u  . . .

Catalog

FilterPLC
CPU 315-2PN

Slave
VIPA_SPEEDbus

SPEEDbus

PROFIBUS

1
Other field devices
  PROFIBUS DP
    ... 
    I/O
      VIPA GmbH
        VIPA_SPEEDbus
          VIPA SPEEDbus
              VIPA SPEEDbus
              Universal module
              ...

2

Network view

General
PROFIBUS- address
General DP param...
...

PROFIBUS address

interface networked with

Subnet: PROFIBUS...

Parameters

Address: 100

PropertiesSlave

3

 
 

• Click at the slave system and open the "Device overview" in the Project 
area. 

• Configure at slot 1 the VIPA CPU 315-4PN33 of the hardware catalog 
from VIPA_SPEEDbus. 

• By double clicking the placed CPU 315-4PN33 the properties dialog of 
the CPU is showed.  

 
Device overview: 
Module ... Slot ... Type ... 
Slave ...  0  VIPA SPEEDbus  
315-4PN33  1  315-4PN33 ...  
  2    
 
As soon as the project is transferred together with the PLC user program to 
the CPU, the parameters will be taken after start-up. 
 
 

     

Connect 
VIPA_SPEEDbus 
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TIA Portal - Include VIPA library 
 

The VIPA specific blocks may be found at www.vipa.com as downloadable 
library at the "service" area with Downloads > VIPA LIB.  
The library is available as packed zip-file Fx000020_V... . 
If you want to use VIPA specific blocks, you have to import the library into 
your project. 
Execute the following steps: 
• Extract FX000020_V... .zip  
• Open library and transfer blocks into the project 
 

Start your un-zip application with a double click on the file 
FX000020_V... .zip and copy all the files and folders in a work directory for 
the Siemens TIA Portal. 
 

• Start the Siemens TIA Portal with your project. 
• Select the Project view. 
• Choose "Libraries" from the Task cards on the right side. 
• Click at "Global libraries". 
• Click at "Open global library". 
• Navigate to your directory and load the file VIPA_TIA.al11. 
 

TIA

Menu ...

Projekt tree

Project library

Global library

VIPA_TIA
   Types
   Master copies
      AI_OSZI
      CP341S
      ...

Parts (Global lib...  

LibrariesProject

Tasks          Libraries 

PLC...

   Device configuration...
   Program blocks
   ...

   Online & diag..

... 

1
2

3

  
• Copy the necessary blocks from the library into the "Program blocks" of 

the Project tree of your project. Now you have access to the VIPA 
specific blocks via your user application.  

 

Overview 

Unzip  FX000020_V... 
.zip 

Open library and 
transfer blocks to 
project 



Manual VIPA System 300S SPEED7 Chapter 8   Configuration with TIA Portal 

HB140E - CPU - RE_315-4PN33 - Rev. 13/17  8-13 

TIA Portal - Project transfer 
 

There are the following possibilities for project transfer into the CPU: 
• Transfer via MPI 
• Transfer via Ethernet 
• Transfer via MMC 
 

 

Currently the VIPA programming cables for transfer via MPI are not 
supported. This is only possible with the programming cable from Siemens.  
Information may be found in the corresponding documentation. 
 

 

For transfer via Ethernet the CPU has the following interface: 
• X5: Ethernet PG/OP channel 
 

So that you may access the Ethernet PG/OP channel you have to assign 
IP address parameters by means of the "initialization" (see "TIA Portal - 
Hardware configuration - Ethernet PG/OP channel"). 
Please consider to use the same IP address data in your project for the CP 
343-1. 
 

• For the transfer, connect, if not already done, the appropriate Ethernet 
port to your Ethernet. 

• Open your project with the Siemens TIA Portal. 
• In the Project tree click at Online access and select your network card, 

which is connected to the Ethernet PG/OP interface, by double-click. 
• Select in the Project tree your CPU and click at [Go online]. 
• Set the access path by selecting "PN/IE" as type of interface, your 

network card and the according subnet. Then a net scan is established 
and the corresponding station is listed. 

• With [Connect] a connection is established. 
• Click to Online > Download to device → the according block is compiled 

and by a request transferred to the device. Provided that no new 
hardware configuration is transferred to the CPU, the entered Ethernet 
connection is permanently stored in the project as transfer channel. 

 

Overview 

Transfer via MPI 

Transfer via 
Ethernet 

Initialization 

Transfer 
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The MMC (Memory Card) serves as external transfer and storage medium. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project is stored in the root 
directory and has one of the following file names: 
• S7PROG.WLD 
• AUTOLOAD.WLD 
With Project > Memory card file > New a WLD file may be created in the 
Siemens TIA Portal. Then the wld file is shown in the project tree at 
"SIMATIC Card Reader" as "Memory card file". 
Copy the blocks from the Programm blocks to the wld file. Here the 
hardware configuration data are automatically copied to the wld file as 
"System data". 
 

The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after an overall reset or PowerON. 
• S7PROG.WLD is read from the MMC after overall reset. 
• AUTOLOAD.WLD is read after PowerON from the MMC. 
The blinking of the LED "MCC" of the CPU marks the active transfer. 
Please regard that your user memory serves for enough space, otherwise 
your user program is not completely loaded and the SF LED gets on.   
 

When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD on the MMC.  
The write command is to be found in the Siemens TIA Portal in the Task 
card "Online tools" in the command area at "Memory" as button [Copy RAM 
to ROM]. Only if this function is supported by the CPU, this button is 
shown. 
During the write process the "MCC"-LED of the CPU is blinking. When the 
LED expires the write process is finished. 
If this project is to be loaded automatically from the MMC with PowerON, 
you have to rename this on the MMC to AUTOLOAD.WLD. 
 
After a MMC access, an ID is written into the diagnostic buffer of the CPU. 
To monitor the diagnosis entries, you select Online & Diagnostics in the 
Siemens TIA Portal. Via the register "Diagnostic Buffer" you reach the 
diagnosis window.  
When accessing a MMC, the following events may occur: 

Event-ID Meaning 
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC-error with storing 
0xE200 MMC writing finished successful 
0xE210 MMC reading finished (reload after overall reset) 
0xE21F Error during reload, read error, out of memory 

 

 

Transfer via 
MMC 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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